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Printer Parts and Control Panel Functions

Printer Parts

edge guides

paper support 
extension

top printer cover

output tray 
extension

output tray

front printer 
cover

roll paper support

paper support

roll paper knob

roll paper holder

rear edge guide

rear manual feed slot

USB interface 
cable connector

IEEE 1394 interface cable connector
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cartridge cover

control panel

print head
ink out light

front edge guide front manual 
feed slot
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   Control Panel

Buttons

Button Function

P

power

Turns the printer on and off.

)

paper

Loads or ejects paper.

Resumes printing if pressed after a paper out error or 
double feed error.

Cancels the printing of a print job if pressed while 
printing.

H

ink

Moves the print head to the ink cartridge replacement 
position.

Move the print head to the ink check position when an 
empty ink cartridge is detected.

Returns the print head to its home position after ink 
cartridge replacement.

Performs print head cleaning if held down for three 
seconds when the H ink out light is off.

z

roll paper

Prints a cutting guideline and feeds roll paper to a 
position where it can be easily removed from the sheet 
feeder if pressed after printing.

Feeds roll paper to the printing position if pressed after 
cutting the paper.

Feeds roll paper in reverse to a position where it can be 
easily removed from the roll paper feeder if pressed for 
3 seconds.
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Lights

Light Description

P

power

On when the printer is on.

Flashing when the printer is receiving data, printing, 
having an ink cartridge replaced, charging ink, or 
cleaning the print head.

m

paper out

On when the printer is out of paper.

Flashing when the paper tray is jammed, or when the 
output tray is in an incorrect position.

Flashing when paper is not fed straight into the rear 
manual feed slot.

H

ink error

On when an ink cartridge is empty or not installed.

Flashing when an ink cartridge is nearly empty, or when 
the wrong color ink cartridge is installed.

ink out On when an ink cartridge is empty or not installed.

Flashing when an ink cartridge is nearly empty.
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Safety Instructions

Important Safety Instructions

Read all of the instructions in this section before using your 
printer. Also, be sure to follow all warnings and instructions 
marked on the printer.

When setting up your printer

Observe the following when setting up the printer:

❏ Do not block or cover the vents and openings in the printer.

❏ Use only the type of power source indicated on the printer’s 
label.

❏ Use only the power cord that comes with this product. Use of 
another cord may result in fire or electric shock.

❏ This product’s power cord is for use with this product only. 
Use with other equipment may result in fire or electric shock.

❏ Be sure your AC power cord meets the relevant local safety 
standard.

❏ Avoid using outlets on the same circuit as photocopiers or air 
control systems that regularly switch on and off.

❏ Avoid electrical outlets controlled by wall switches or 
automatic timers.
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❏ Keep the entire computer system away from potential sources 
of electromagnetic interference, such as loudspeakers or the 
base units of cordless telephones.

❏ Do not use a damaged or frayed power cord.

❏ If you use an extension cord with the printer, make sure that 
the total ampere rating of the devices plugged into the 
extension cord does not exceed the cord’s ampere rating. Also, 
make sure that the total ampere rating of all devices plugged 
into the wall outlet does not exceed the wall outlet’s ampere 
rating.

❏ Do not attempt to service the printer yourself.

❏ Unplug the printer and refer servicing to qualified service 
personnel under the following conditions:

The power cord or plug is damaged; liquid has entered the 
printer; the printer has been dropped or the casing damaged; 
the printer does not operate normally or exhibits a distinct 
change in performance.

❏ If you plan to use the printer in Germany, the building 
installation must be protected by a10 or 16 amp circuit breaker 
to provide adequate short-circuit protection and over-current 
protection for this printer.

❏ When connecting this product to a computer or other device 
with a cable, ensure the correct orientation of the connectors. 
Each connector has only one correct orientation. Inserting a 
connector in the wrong orientation may damage both devices 
connected by the cable.
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When choosing a place for the printer

Observe the following when choosing a place for the printer:

❏ Place the printer on a flat, stable surface that extends beyond 
the base of the printer in all directions. If you place the printer 
by the wall, leave more than 40 cm between the back of the 
printer and the wall. The printer will not operate properly if 
it is tilted at an angle.

❏ When storing or transporting the printer, do not tilt it, stand 
it on its side, or turn it upside down. Otherwise, ink may leak 
from the cartridges.

❏ Leave enough space in front of the printer for the paper to be 
fully ejected.

❏ Avoid places subject to rapid changes in temperature and 
humidity. Also, keep the printer away from direct sunlight, 
strong light, or heat sources.

❏ Avoid places subject to dust, shocks, or vibrations.

❏ Leave enough room around the printer to allow for sufficient 
ventilation.

❏ Place the printer near a wall outlet where the plug can be 
easily unplugged.

When using the printer

Observe the following when using the printer:

❏ Do not insert objects through the slots in the printer.

❏ Take care not to spill liquid on the printer.
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❏ Do not put your hand inside the printer or touch the ink 
cartridges during printing.

❏ Do not move the print head by hand; otherwise, you may 
damage the printer.

❏ Always turn the printer off using the P power button. When 
this button is pressed, the P power light flashes. Do not 
unplug the printer or turn off the power to the outlet until the 
P power light stops flashing.

❏ Before transporting the printer, make sure that the print head 
is in the home (far right) position and the ink cartridges are 
in place.

❏ Leave the ink cartridges installed. Removing the cartridges 
can dehydrate the print head and may prevent the printer 
from printing.

When handling the ink cartridges

Observe the following when handling the ink cartridges:

❏ Keep ink cartridges out of the reach of children. Do not allow 
children to drink from or otherwise handle the cartridges.

❏ Shake the new ink cartridges four or five times before opening 
the packages.

❏ Do not shake the ink cartridges after opening the packages; 
this can cause leakage.

❏ Be careful when you handle used ink cartridges, as there may 
be some ink remaining around the ink supply port. If ink gets 
on your skin, wash the area thoroughly with soap and water. 
If ink gets into your eyes, flush them immediately with water. 
If discomfort or vision problems remain after a thorough 
flushing, see a doctor immediately.
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❏ Do not remove or tear the label on the cartridge; this can cause 
leakage.

❏ Install the ink cartridge immediately after you remove it from 
its package. If you leave a cartridge unpacked for a long time 
before using it, normal printing may not be possible. 

❏ Do not use an ink cartridge beyond the date printed on the 
cartridge carton: otherwise, it may result in reduced print 
quality. For best results, use up the ink cartridges within six 
months of first installing them.

❏ Do not dismantle the ink cartridges or try to refill them. This 
could damage the print head.

❏ After bringing an ink cartridge inside from a cold storage site, 
allow it to warm up at room temperature for at least three 
hours before using it.

❏ Store ink cartridges in a cool, dark place.

❏ Do not touch the green IC chip on the side of the cartridge. 
Doing so may prevent normal operation and printing.

❏ The IC chip on this ink cartridge retains a variety of cartridge 
related-information such as the amount of ink remaining, so 
that the cartridge may be removed and reinserted freely. 
However, each time the cartridge is inserted, some ink is 
consumed because the printer automatically performs a 
reliability check.

❏ If you remove an ink cartridge for later use, protect the ink 
supply area from dirt and dust and store it in the same 
environment as the printer. A valve in the ink supply port 
makes covers or plugs unnecessary, but the ink may stain 
items that come into contact with this area of the cartridge. 
Do not touch the ink supply port or the surrounding area.

❏ Store ink cartridge with its label facing upward. Do not store 
cartridge upside down.
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ENERGY STAR® Compliance

As an ENERGY STAR® Partner, Epson has 
determined that this product meets the ENERGY 
STAR® guidelines for energy efficiency.

The International ENERGY STAR® Office Equipment Program is 
a voluntary partnership with the computer and office equipment 
industry to promote the introduction of energy-efficient personal 
computers, monitors, printers, fax machines, copiers, scanners, 
and multifunction devices in an effort to reduce air pollution 
caused by power generation. Their standards and logos are 
uniform among participating nations.

Warnings, Cautions, and Notes

w
Warnings
must be followed carefully to avoid bodily injury.

c
Cautions
must be observed to avoid damage to your equipment.

Notes
contain important information and useful tips on the operation of your 
printer.
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Chapter 1

How to Print

Introduction

This section guides you through the procedures for different 
kinds of printing.

“Printing Photos” on page 23

Explains how to print color or black-and-white photos on various 
sizes or kinds of single-sheet paper. 
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“Printing on Roll Paper” on page 29

Explains how to use the main function of the roll paper setting, 
printing banners. This allows you to print panoramic photos or 
continuous documents on roll paper.

“Printing on Thick Paper” on page 38

Explains how to print documents and images on thick paper.
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“Printing Text” on page 43

Explains how to print documents and images on various sizes or 
kinds of single-sheet paper.

“Printing Web Pages” on page 49

Explains how to print web pages on various sizes or kinds of 
single-sheet paper.
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Printing Photos

Handling single sheets of paper

Refer to the section below for details on loading single sheets of 
paper.

“Loading single sheets of paper” on page 346

Some types of special media, such as Velvet Fine Art Paper, 
Watercolor Paper-Radiant White and UltraSmooth Fine Art 
Paper, should be loaded into the rear manual feed slot. Refer to 
the section below for details on loading single sheets of paper into 
the rear manual feed slot.

“Loading Single Sheets of Paper into the Rear Manual Feed 
Slot” on page 349

When using special media, refer to the section below.

“Using special media” on page 354
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Using software such as EPSON Easy Photo Print or EPSON 
Darkroom Print, which are included on the CD-ROM, is the 
easiest way to make printouts on this printer. For details, see the 
following section.

“EPSON Creativity Suite” on page 198

Driver settings for Windows

Note:
If you want to print high quality black-and-white photos, use Advanced 
B&W Photo. For more details, see the following section.
& See “B&W Photo Printing” on page 60

1. Open the file you want to print.

2. Access the printer driver.

“Accessing the printer software for Windows” on page 366

3. Click the Main tab, then make the Quality Option setting. See 
the following section for details on the Quality Option 
settings.
& See “Quality Option” on page 126

4. Select Sheet as the Source setting when feeding paper into 
the sheet feeder. Select Manual - Roll as the Source setting 
when feeding paper into the rear manual feed slot.

5. Make the appropriate Type setting.

“Media type settings” on page 369

6. Make the appropriate Size setting. You can also define a 
custom paper size. For details, see the following section.

“Making User Defined paper sizes for Windows” on page 372
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7. Select Portrait (tall) or Landscape (wide) to change the 
orientation of your printout.

8. Click OK to close the printer driver settings dialog box.

9. Print your data.

Driver settings for Mac OS X

1. Open the file you want to print.

2. Access the Page Setup dialog box.

“Accessing the printer software for Mac OS X” on page 367

3. Select Stylus Photo R2400 as the Format for setting.

4. Make the appropriate Paper Size and Orientation settings.
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5. Click OK to close the Page Setup dialog box.

6. Access the Print dialog box.

“Accessing the printer software for Mac OS X” on page 367

7. Select Stylus Photo R2400 as the Printer setting, then make 
the Copies & Pages settings.

Note:
The Copies & Pages settings available are a standard feature of Mac 
OS X. See your operating system’s documentation for details.

8. Select Print Settings from the pop-up menu.

9. Make the appropriate Media Type, Color, and Mode settings.
& See “Print Settings” on page 161

“Media type settings” on page 369
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Note:
If you want to print high quality black-and-white photos, use 
Advanced B&W Photo. For more details, see the following section.
& See “B&W Photo Printing” on page 60

10. Click Print to start printing.

Driver settings for Mac OS 9

1. Open the file you want to print.

2. Access the Page Setup dialog box.

“Accessing the printer software for Mac OS 9” on page 368

3. Make the appropriate Paper Size setting. You can also define 
a custom paper size. For details, see the following section.

“Making User Defined paper sizes for Mac OS 9” on page 376
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4. Select Auto Sheet Feeder as the Paper Source when feeding 
paper into the sheet feeder. Select Manual - Roll as the Paper 
Source when feeding paper into the rear manual feed slot.

5. Select Portrait (tall) or Landscape (wide) to change the 
orientation of your printout.

6. Click OK to save the settings and close the Page Setup dialog 
box.

7. Access the Print dialog box.

“Accessing the printer software for Mac OS 9” on page 368

8. Make the appropriate Media Type setting.

“Media type settings” on page 369

Note:
If you want to print high quality black-and-white photos, use 
Advanced B&W Photo. For more details, see the following section.
& See “B&W Photo Printing” on page 60
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9. Click Print to start printing.

Printing on Roll Paper

Printing on roll paper allows you to perform high quality banner 
printing. This means you can print panoramic photos, or a 
continuous document, rather than individual pages.

Handling roll paper

Refer to the section below for loading roll paper.

“Loading the roll paper” on page 359
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Driver settings for Windows

Note:
❏ You can change the margins for roll paper with the printer driver 

settings. Refer to the section below to print without margins on 
either side of your printout.
& See “Borderless Printing” on page 66

❏ In this section you will learn how to print a banner on roll paper 
with margins on both sides of your printout.

1. Open the file you want to print.

2. Access the printer driver.

“Accessing the printer software for Windows” on page 366

3. Click the Main tab, then make the Quality Option setting. See 
the following section for details on the Quality Option 
settings.
& See “Quality Option” on page 126

4. Select Roll as the Source setting.

5. Make appropriate Options settings in the Roll Paper Options 
dialog box.

Selecting Banner Mode means you can print data as a 
banner. This allows you to print long documents as a 
continuous sheet rather than as individual sheets.

Selecting Cut Sheet Mode means you can print 
standard-sized data. This allows you to print documents as 
individual sheets rather than as a continuous sheet.

6. Click OK to return to the Main menu.

7. Select the appropriate Type setting.

“Media type settings” on page 369
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8. Select the appropriate Size setting.

9. Select Portrait (tall) or Landscape (wide) to change the 
orientation of your printout.

Note:
Do not select Sheet as the Source setting when roll paper is loaded 
in the rear manual feed slot. Doing so causes unnecessary paper to 
feed after each document. If you have already started printing, cancel 
printing from the printer software.
& See “Canceling Printing” on page 296
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10. Click OK to close the driver setting dialog box.

11. Print your data.

12. Cut the roll paper.

“Cutting the roll paper” on page 364

Note:
Wait until the printer stops printing and feeding paper. Cut off the 
paper at the back of the printer, and then turn off the printer. The 
remaining paper is ejected.

Driver settings for Mac OS X

Note:
❏ You can change the margins for roll paper with the printer driver 

settings. Refer to the section below to print without margins on 
either side of your printout.
& See “Borderless Printing” on page 66

❏ In this section you will learn how to print a banner on roll paper 
with margins on both sides of your printout.

1. Open the file you want to print.

2. Access the Page Setup dialog box.

“Accessing the printer software for Mac OS X” on page 367

3. Select Stylus Photo R2400 as the Format for setting.

4. Make the appropriate Paper Size setting according to the type 
of roll paper printing you want to perform.

5. Make the appropriate Orientation setting.
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6. Click OK to close the Page Setup dialog box.

7. Access the Print dialog box.

“Accessing the printer software for Mac OS X” on page 367

8. Select Stylus Photo R2400 as the Printer setting, then make 
the Copies & Pages settings.

Note:
The Copies & Pages settings available are a standard feature of Mac 
OS X. See your operating system’s documentation for details.

9. Select Print Settings from the pop-up menu.

10. Make the appropriate Media Type, Color, and Mode settings.
& See “Print Settings” on page 161
How to Print 33



“Media type settings” on page 369

11. Select Roll Paper Option from the pop-up menu.

12. Make the appropriate Roll Paper Option setting.

13. Click Print to start printing.
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Note:
This screen shot appears when A4 (roll paper) is selected as the paper 
size.

14. Cut the roll paper.

“Cutting the roll paper” on page 364

Note:
Wait until the printer stops printing and feeding paper. Cut off the 
paper at the back of the printer, and then turn off the printer. The 
remaining paper is ejected.

Driver settings for Mac OS 9

Note:
❏ You can change the margins for roll paper with the printer driver 

settings. Refer to the section below to print without margins on 
either side of your printout.
& See “Borderless Printing” on page 66

❏ In this section you will learn how to print a banner on roll paper 
with margins on both sides of your printout.

1. Open the file you want to print.

2. Access the Page Setup dialog box.

“Accessing the printer software for Mac OS 9” on page 368

3. Select the appropriate Paper Size setting.

4. Select Roll Paper as the Paper Source setting.

5. Select Portrait (tall) or Landscape (wide) to change the 
orientation of your printout.

6. Make appropriate Roll Paper Option settings.
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Selecting Banner means you can print data as a banner. This 
allows you to print long documents as a continuous sheet 
rather than as individual sheets.

Selecting Cut sheet means you can print standard-sized data. 
This allows you to print documents as individual sheets 
rather than as a continuous sheet.

7. Click OK to save your settings and close the Page Setup dialog 
box.

Note:
Do not select Auto Sheet Feeder as the Paper Source setting 
when roll paper is loaded in the rear manual feed slot. Doing so 
causes unnecessary paper to feed after each document. If you have 
already started printing, cancel printing from the printer software.
& See “Canceling Printing” on page 296

8. Access the Print dialog box.

“Accessing the printer software for Mac OS 9” on page 368

9. Select the appropriate Media Type setting.

“Media type settings” on page 369
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Note:
Do not select PhotoEnhance as the Mode setting, because it may 
cause gaps in your printout.

10. Click Print to start printing.

11. Cut the roll paper.

“Cutting the roll paper” on page 364

Note:
Wait until the printer stops printing and feeding paper. Cut off the 
paper at the back of the printer, and then turn off the printer. The 
remaining paper is ejected.
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Printing on Thick Paper

You can print high quality images and documents on thick paper.

Refer to the section below for loading thick paper.

“Loading Thick Paper” on page 347

Driver settings for Windows

1. Open the file you want to print.

2. Access the printer driver.

“Accessing the printer software for Windows” on page 366

3. Click the Main tab, then make the Quality Option setting. See 
the following section for details on the Quality Option 
settings.
& See “Quality Option” on page 126

4. Select Manual - Front as the Source setting.

Note:
Borderless printing is not available when Manual - Front is 
selected.
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5. Make the appropriate Type setting.

“Media type settings” on page 369

6. Make the appropriate Size setting.

7. Select Portrait (tall) or Landscape (wide) to change the 
orientation of your printout.

8. Click OK to close the driver setting dialog box.

9. Print your data.
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Driver settings for Mac OS X

1. Open the file you want to print.

2. Access the Page Setup dialog box.

“Accessing the printer software for Mac OS X” on page 367

3. Select Stylus Photo R2400 as the Format for setting.

4. Make the appropriate Paper Size setting, make sure the paper 
size you select is followed by Manual - Front, for example A4 
(Manual - Front).

Note:
Borderless printing is not available when Manual - Front is 
selected.

5. Make the appropriate Orientation setting.

6. Click OK to close the Page Setup dialog box.

7. Access the Print dialog box.

“Accessing the printer software for Mac OS X” on page 367

8. Select Stylus Photo R2400 as the Printer setting, then make 
the Copies & Pages settings.
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Note:
The Copies & Pages settings available are a standard feature of Mac 
OS X. See your operating system’s documentation for details.

9. Select Print Settings from the pop-up menu.

10. Make the appropriate Media Type, Color, and Mode settings.
& See “Print Settings” on page 161

“Media type settings” on page 369

11. Click Print to start printing.
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Driver settings for Mac OS 9

1. Open the file you want to print.

2. Access the Page Setup dialog box.

“Accessing the printer software for Mac OS 9” on page 368

3. Make the appropriate Paper Size setting.

4. Select Manual - Front as the Paper Source setting.

Note:
Borderless printing is not available when Manual - Front is 
selected.

5. Select Portrait (tall) or Landscape (wide) to change the 
orientation of your printout.

6. Click OK to save the settings and close the Page Setup dialog 
box.

7. Access the Print dialog box.

“Accessing the printer software for Mac OS 9” on page 368

8. Select the appropriate Media Type setting.

“Media type settings” on page 369
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9. Click Print to start printing.

Printing Text

Handling single sheets of paper

Refer to the section below for details on loading single sheets of 
paper.

“Loading single sheets of paper” on page 346

When using special media, refer to the section below.

“Using special media” on page 354
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Driver settings for Windows

1. Open the file you want to print.

2. Access the printer driver.

“Accessing the printer software for Windows” on page 366

3. Click the Main tab, then make the Quality Option setting. See 
the following section for details on the Quality Option 
settings.
& See “Quality Option” on page 126

4. Select Sheet as the Source setting.

5. Make the appropriate Type setting.

“Media type settings” on page 369

6. Make the appropriate Size setting. You can also define a 
custom paper size. For details, see the following section.

“Making User Defined paper sizes for Windows” on page 372
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7. Select Portrait (tall) or Landscape (wide) to change the 
orientation of your printout.

8. Click OK to close the printer driver settings dialog box.

9. Print your data.

Driver settings for Mac OS X

1. Open the file you want to print.

2. Access the Page Setup dialog box.

“Accessing the printer software for Mac OS X” on page 367

3. Select Stylus Photo R2400 as the Format for setting.

4. Make the appropriate Paper Size and Orientation settings.
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5. Click OK to close the Page Setup dialog box.

6. Access the Print dialog box.

“Accessing the printer software for Mac OS X” on page 367

7. Select Stylus Photo R2400 as the Printer setting, then make 
the Copies & Pages settings.

Note:
The Copies & Pages settings available are a standard feature of Mac 
OS X. See your operating system’s documentation for details.

8. Select Print Settings from the pop-up menu.

9. Make the appropriate Media Type, Color, and Mode settings.
& See Print Settings

“Media type settings” on page 369
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10. Click Print to start printing.

Driver settings for Mac OS 9

1. Open the file you want to print.

2. Access the Page Setup dialog box.

“Accessing the printer software for Mac OS 9” on page 368

3. Make the appropriate Paper Size setting. You can also define 
a custom paper size. For details, see the following section.

“Making User Defined paper sizes for Mac OS 9” on page 376

4. Select Auto Sheet Feeder as the Paper Source.

5. Select Portrait (tall) or Landscape (wide) to change the 
orientation of your printout.
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6. Click OK to save the settings and close the Page Setup dialog 
box.

7. Access the Print dialog box.

“Accessing the printer software for Mac OS 9” on page 368

8. Make the appropriate Media Type setting.

“Media type settings” on page 369

9. Click Print to start printing.
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Printing Web Pages

Handling single sheets of paper

Refer to the section below for details on loading single sheets of 
paper.

“Loading single sheets of paper” on page 346

When using special media, refer to the section below.

“Using special media” on page 354

Using EPSON Web-To-Page for Windows

Using the EPSON Web-To-Page application enables you to print 
web pages easily and fit the pages to print within the width of 
your selected paper.

1. Open the file you want to print. If you have installed EPSON 
Web-To-Page, the EPSON Web-To-Page toolbar appears on 
the Internet Explorer window.
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2. Click the Print button on the toolbar. The Print dialog box 
appears.

Note:
If you want to preview the layout of your printout, click the Preview 
button on the toolbar. For more information on EPSON 
Web-To-Page, choose User’s Guide from the Web-To-Page 
pulldown menu on the toolbar.

3. Right-click on the icon of your printer, and choose Printing 
Preferences in Windows XP and 2000, or Properties in 
Windows Me and 98.

4. Click the Main tab, then make the Quality Option setting. See 
the following section for details on the Quality Option 
settings.

“Quality Option” on page 126

5. Select Sheet as the Source setting.

6. Make the appropriate Type setting.

“Media type settings” on page 369

7. Make the appropriate Size setting. You can also define a 
custom paper size. For details, see the following section.

“Making User Defined paper sizes for Windows” on page 372
50 How to Print



1

1

1

1

1

1

1

1

1

1

1

1

8. Select Portrait (tall) or Landscape (wide) to change the 
orientation of your printout.

9. Click OK to close the printer driver settings dialog box.

10. Print your data.

Using the Printer Driver for Mac OS X

Note:
EPSON Web-To-Page is an application only available to Windows 
users. Macintosh users can print web pages using the printer driver in 
Mac OS X.

1. Open the file you want to print.

2. Access the Page Setup dialog box.

“Accessing the printer software for Mac OS X” on page 367
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3. Select Stylus Photo R2400 as the Format for setting.

4. Make the appropriate Paper Size and Orientation settings.

5. Click OK to close the Page Setup dialog box.

6. Access the Print dialog box.

“Accessing the printer software for Mac OS X” on page 367

7. Select Stylus Photo R2400 as the Printer setting, then make 
the Copies & Pages settings.

Note:
The Copies & Pages settings available are a standard feature of Mac 
OS X. See your operating system’s documentation for details.
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8. Select Print Settings from the pop-up menu.

9. Make the appropriate Media Type, Color, and Mode settings.

“Print Settings” on page 161

“Media type settings” on page 369

10. Click Print to start printing.

Using the Printer Driver for Mac OS 9

Note:
EPSON Web-To-Page is an application only available to Windows 
users. Macintosh users can print web pages using the printer driver in 
Mac OS 9.

1. Open the file you want to print.

2. Access the Page Setup dialog box.

“Accessing the printer software for Mac OS 9” on page 368
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3. Make the appropriate Paper Size setting. You can also define 
a custom paper size. For details, see the following section.

“Making User Defined paper sizes for Mac OS 9” on page 376

4. Select Auto Sheet Feeder as the Paper Source.

5. Select Portrait (tall) or Landscape (wide) to change the 
orientation of your printout.

6. Click OK to save the settings and close the Page Setup dialog 
box.

7. Access the Print dialog box.

“Accessing the printer software for Mac OS 9” on page 368

8. Make the appropriate Media Type setting.

“Media type settings” on page 369
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9. Click Print to start printing.
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Chapter 2

Various Printing Options

Introduction to Various Printing Options

This printer provides you with a variety of different printing 
options. You can print in various formats, and you can print using 
many different types of paper.

The sections that follow the introduction explain procedures for 
each type of printing. Click the title of each printing option to see 
more details.

“B&W Photo Printing” on page 60

Lets you print black-and-white photos using the Advanced B&W 
Photo mode.
56 Various Printing Options



2

2

2

2

2

2

2

2

2

2

2

2

“Borderless Printing” on page 66

Lets you print without margins on all four sides of the paper.

“Double-Sided Printing” on page 75

Lets you print on both sides of the paper.

Note:
This feature is not available with Mac OS X.

“Fit to Page Printing” on page 91

Lets you automatically enlarge or reduce the size of your 
document to fit the paper size selected in the printer software.
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Note:
This feature is not available with Mac OS X.

“Pages Per Sheet Printing” on page 96

Lets you print two or four pages on a single sheet of paper.

“Poster Printing” on page 105

Lets you enlarge material on a single document page to cover 4, 
9, or 16 printed sheets of paper, and then make a poster.
58 Various Printing Options



2

2

2

2

2

2

2

2

2

2

2

2

Note:
This feature is not available with Mac OS X.

“Watermark Printing” on page 114

Lets you print text or an image as a watermark on your printout.

Note:
This feature is not available with Mac OS X.

For example, you can put “Confidential” on an important 
document.
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B&W Photo Printing

Advanced B&W Photo mode allows you to print high quality 
black-and-white photos.

Compatible media

You can use the following media with this feature.

Premium Glossy Photo Paper A3+, A3, A4, 10 × 15 cm (4 × 6 in), 
210 mm × 10 m, 329 mm × 10 m 
(Roll paper)

Premium Luster Photo Paper  A3+, A3, 210 mm × 10 m, 
329 mm × 10 m (Roll paper)

Premium Semigloss Photo 
Paper

A3+, A3, A4, 100 mm × 8 m, 
210 mm × 10 m, 
329 mm × 10 m (Roll paper)

Matte Paper-Heavyweight A3+, A3, A4

Watercolor Paper-Radiant 
White

A3+

Archival Matte Paper A3+, A3, A4

Double-Sided Matte Paper A4

Velvet Fine Art Paper A3+

UltraSmooth Fine Art Paper A3+
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Driver settings for Windows

1. Open the file you want to print.

2. Access the printer driver. For details, see the following 
section.

“Accessing the printer software for Windows” on page 366

3. Click the Main tab, and then click Advanced.

4. Select Sheet as the Source setting when feeding paper into 
the sheet feeder. Select Manual - Roll as the source setting 
when feeding paper into the rear manual feed slot.

5. Make the appropriate Type setting. For details, see the 
following section.

“Media type settings” on page 369

Note:
Advanced B&W Photo is available depending on the ink cartridge 
installed (Photo Black or Matte Black), the media type setting, and 
the print quality setting. For most media types, select Best Photo 
or Photo RPM as the print quality setting.

6. Make the appropriate Size setting. You can also define a 
custom paper size. For details, see the following section.

“Making User Defined paper sizes for Windows” on page 372

7. Select Portrait (tall) or Landscape (wide) to change the 
orientation of your printout.
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8. Select Advanced B&W Photo as the Color Management 
setting. This makes the Color Toning drop-down menu 
available. Select one of the following settings.

For details on making advanced settings in this mode, see the 
following section.

“Advanced B&W Photo” on page 136

9. Click OK to close the printer driver settings dialog box.

10. Print your data.

Neutral Applies standard color correction for 
black-and-white photos.

Cool Applies a cool tone to your photos.

Warm Applies a warm tone to your photos.

Sepia Applies a sepia tone to your photos.
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Driver settings for Mac OS X

1. Open the file you want to print.

2. Access the Page Setup dialog box. For details, see the 
following section.

“Accessing the printer software for Mac OS X” on page 367

3. Select Stylus Photo R2400 as the Format for setting.

4. Make the appropriate Paper Size and Orientation settings.

5. Click OK to close the Page Setup dialog box.

6. Access the Print dialog box.

“Accessing the printer software for Mac OS X” on page 367

7. Select Stylus Photo R2400 as the Printer setting.

8. Select Print Settings from the pop-up menu.

9. Make the appropriate Media Type and Print Quality settings, 
and then select Advanced B&W Photo as the Color setting.

Note:
Advanced B&W Photo is available depending on the ink cartridge 
installed (Photo Black or Matte Black), the media type setting, and 
the print quality setting. For most media types, select Best Photo 
or Photo RPM as the print quality setting.

10. From the Color Toning pop-up menu, select one of the 
following settings.

Neutral Applies standard color correction for 
black-and-white photos.

Cool Applies a cool tone to your photos.
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For details on making advanced settings in this mode, see the 
following section.

“When Advanced B&W Photo is selected as the Color setting 
in Print Settings” on page 164

11. Click Print.

Driver Settings for Mac OS 9

1. Open the file you want to print.

2. Access the Page Setup dialog box. For details, see the 
following section.

“Accessing the printer software for Mac OS 9” on page 368

Warm Applies a warm tone to your photos.

Sepia Applies a sepia tone to your photos.
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3. Make the appropriate Paper Size setting. You can also define 
a custom paper size. For details, see the following section.

“Making User Defined paper sizes for Mac OS 9” on page 376

4. Select Auto Sheet Feeder as the Paper Source when feeding 
paper into the sheet feeder. Select Manual - Roll as the Paper 
Source when feeding paper into the rear manual feed slot.

5. Select Portrait (tall) or Landscape (wide) to change the 
orientation of your printout.

6. Click OK to save your settings and close the Page Setup dialog 
box.

7. Access the Print dialog box.

“Accessing the printer software for Mac OS 9” on page 368

8. Make the appropriate Media Type setting.

Note:
Advanced B&W Photo is available depending on the ink cartridge 
installed (Photo Black or Matte Black), the media type setting, and 
the print quality setting. For most media types, select Best Photo 
or Photo RPM as the print quality setting.

9. Select Advanced B&W Photo as the Color setting.

10. Select Automatic as the Mode setting, and then select one of 
the following settings from the pop-up menu.

Neutral Applies standard color correction for 
black-and-white photos.

Cool Applies a cool tone to your photos.

Warm Applies a warm tone to your photos.

Sepia Applies a sepia tone to your photos.
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If you select Custom as the Mode setting, the Advanced 
button is available. For more details on advanced settings, see 
the following section.

“Advanced B&W Photo:” on page 183

11. Click Print to start printing.

Borderless Printing

This printer allows you to print without margins on all four sides 
of the paper. Follow the steps described below for Borderless 
printing.

Note:
This feature is not available for all media and driver settings.
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Compatible media

You can use the following media with this feature:

Note:
❏ Printing with this feature takes longer than with normal printing.

❏ Print quality may decline in the top and bottom areas of the printout, 
or the area may be smeared when printing on media other than those 
listed above. Print a single sheet to check the quality before printing 
large jobs.

❏ Borderless printing is not available when Manual - Front is 
selected as the Source setting.

Matte Paper - Heavyweight A3+, A3, A4

Archival Matte Paper A3+, A3, A4

Premium Glossy Photo Paper A3+, A3, A4, 10 × 15 cm (4 × 6 
in.), 329 mm × 10 m, 
210 mm × 10 m (Roll paper)

Premium Luster Photo Paper A3+, A3, 210 mm × 10 m, 
329 mm × 10m (Roll paper)

Premium Semigloss Photo 
Paper

A3+, A3, A4, 329 mm × 10 m, 
210 mm × 10 m, 
100 mm × 8 m (Roll paper) 

Watercolor Paper-Radiant 
White

A3+

UltraSmooth Fine Art Paper A3+

Velvet Fine Art Paper A3+

Proofing Paper Semimatte A3+, 329 mm × 10 m (Roll paper)
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Preparing the print data

Because this option enlarges the image to a size slightly larger 
than the paper size, the portion of the image that extends beyond 
the edges of the paper is not printed.

When creating print data in an application, note the following:

Printing on roll paper

When using this feature with roll paper and Banner Mode is 
selected in the Roll Paper Options dialog box (Windows) or 
Banner is selected as the Roll Paper Option setting in the Page 
Setup dialog box (Mac OS X), you need to use your image-editing 
software to make the Image 4mm wider than the roll paper.

If your application has margin settings, make sure they are set to 
zero before printing.

Printing on single sheets

You need to adjust the data to the size of the paper. If your 
application has margin settings, make sure they are set to zero 
before printing.

Printing from EPSON Easy Photo Print

Using EPSON Easy Photo Print included on the CD-ROM is the 
easiest and quickest way to create borderless photos with this 
product. EPSON Easy Photo Print also includes a number of 
features that help you create outstanding photos.

Note:
EPSON Easy Photo Print does not support Mac OS 9.
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For Windows

1. Access EPSON Easy Photo Print.
For Windows XP, click the Start button, point to All Programs, 
point to EPSON Creativity Suite, then choose EPSON Easy 
Photo Print. 
For Windows Me, 98, and 2000, click the Start button, point 
to Programs, point to EPSON Creativity Suite, then choose 
EPSON Easy Photo Print.

2. Print images from EPSON Easy Photo Print. 

To learn how to print your photos, click the Help button to view 
instructions in the EPSON Easy Photo Print User's Guide.

For Mac OS X

1. Double-click the Applications folder in Macintosh HD, 
EPSON folder, then Creativity Suite. Double-click the Easy 
Photo Print folder, then the EPSON Easy Photo Print icon.

2. Print images from EPSON Easy Photo Print. 

To learn how to print your photos, choose User's Guide from Help 
menu to view instructions in the EPSON Easy Photo Print User's 
Guide.

Printing from the printer driver

Driver settings for Windows

After you have loaded the media, change your printer driver 
settings for Borderless printing.

1. Access the printer driver.

“Accessing the printer software for Windows” on page 366
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2. Click the Main tab, then make the Quality Option setting. See 
the following section for details on the Quality Option 
settings.
& See “Quality Option” on page 126

3. Select the Borderless check box.

4. Make the appropriate Type setting.

“Media type settings” on page 369

5. Make the appropriate Size setting.

6. Click OK to close the printer driver settings dialog box.

After finishing all steps above, start printing. Print one test copy 
and examine the results before printing an entire job.
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Note:
You can control the amount of the image that extends beyond the edges 
of the paper during borderless printing. When the Borderless check box 
is selected on the Main menu, the Borderless Expansion slider 
becomes available on the Page Layout menu.

Driver settings for Mac OS X

After you have loaded the media, change your printer driver 
settings for Borderless printing.

1. Access the Page Setup dialog box.

“Accessing the printer software for Mac OS X” on page 367

2. Select Stylus Photo R2400 as the Format for setting.

3. Make the appropriate Paper Size setting according to the type 
of borderless printing you want to perform.

4. Make the appropriate Orientation setting.

5. Click OK to close the Page Setup dialog box.

6. Access the Print dialog box.

“Accessing the printer software for Mac OS X” on page 367
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7. Select Stylus Photo R2400 as the Print setting, then make the 
Copies & Pages settings.

Note:
The Copies & Pages settings available are a standard feature of Mac 
OS X. See your operating system’s documentation for details.

8. Select Print Settings from the pop-up menu.

9. Make the appropriate Media Type, Color, and Mode settings.
& See “Print Settings” on page 161

“Media type settings” on page 369
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10. Click Print to start printing.

Note:
❏ Print one test copy and examine the results before printing an entire 

job.

❏ You can control the amount of the image that extends beyond the 
edges of the paper during borderless printing.
& See “Expansion” on page 168

Driver settings for Mac OS 9

After you have loaded the media, change your printer driver 
settings for Borderless printing.

1. Access the Page Setup dialog box.

“Accessing the printer software for Mac OS 9” on page 368

2. Make the appropriate Paper Size setting.

3. Select the Borderless check box.
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4. Click OK to save the settings and close the Page Setup dialog 
box.

5. Access the Print dialog box.

“Accessing the printer software for Mac OS 9” on page 368

6. Make the appropriate Media Type setting.

“Media type settings” on page 369

7. Click Print to start printing.

Note:
❏ Print one test copy and examine the results before printing an entire 

job.
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❏ You can control the amount of the image that extends beyond the 
edges of the paper during borderless printing. When the Borderless 
check box is selected on the Page Setup dialog box, the Borderless 
Expansion slider becomes available.

Double-Sided Printing

There are two types of double-sided printing available. Standard 
double-sided printing allows you to print the odd-numbered 
pages first. Once these pages are printed, they can be reloaded to 
print the even-numbered pages onto the opposite side of the 
paper.

Folded Booklet double-sided printing allows you to make 
single-fold booklets. To create it, the pages that appear on the 
outside (after the page is folded) are printed first. The pages that 
will appear inside the booklet can then be printed after the paper 
is reloaded into the printer as shown in the illustration below.
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✽: Binding edge

A booklet can be created by printing pages 1 and 4 on the first 
sheet of paper, pages 5 and 8 on the second sheet of paper, and 
pages 9 and 12 on the third sheet of paper. After these sheets are 
reloaded into the sheet feeder, you can then print pages 2 and 3 
on the back of the first sheet of paper, pages 6 and 7 on the back 
of the second sheet of paper, and pages 10 and 11 on the back of 
the third sheet of paper. The resulting pages can then be folded 
and bound together into a booklet.

Note:
❏ This feature is not available with Mac OS X.

❏ This feature is not available when selecting the Borderless check 
box on the Main menu (Windows) or in the Page Setup dialog box 
(Macintosh).

❏ This feature is not available when the printer is accessed over a 
network or is used as a shared printer.

Single-fold booklet

1

2 4

3 5 9

6

7

8 10

11

12

✽
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❏ Depending on the media type, stacks of up to 30 sheets can be loaded 
into the sheet feeder during double-sided printing.

❏ Only use media types that are suitable for double-sided printing. 
Otherwise, the printout quality may deteriorate.

❏ Depending on the media type and the amount of ink used to print 
text and images, ink may bleed through to the other side of the paper.

❏ The surface of the paper may be smeared during double-sided 
printing.

Standard double-sided printing for Windows

Follow the steps below to print odd- and even-numbered pages 
onto opposite sides of the sheet.

1. Access the printer driver.

“Accessing the printer software for Windows” on page 366

2. Click the Main tab, then make the Quality Option setting. See 
the following section for details on the Quality Option 
settings.
& See “Quality Option” on page 126

3. Select Sheet as the Source setting.

4. Make the appropriate Type setting.

“Media type settings” on page 369

5. Make the appropriate Size setting.
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6. Select Portrait (tall) or Landscape (wide) to change the 
orientation of your printout.

7. Click the Page Layout tab, then select the Double-Sided 
Printing check box.
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8. Click Margins to open the Margins dialog box.

9. Specify the edge of the paper where the binding will be 
placed. You can choose Left, Top, or Right.

10. Choose cm or inch as the Unit setting. Then, specify the width 
of the binding margin. You can enter any width from 0.3 cm 
to 3.0 cm, or from 0.12 inches to 1.18 inches.
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Note:
The actual binding margin may be different from the specified 
settings depending on your application. Experiment with a few 
sheets to examine actual results before printing the entire job.

11. Click OK to return to the Page Layout menu. Then, click OK 
to save your settings.

12. Load paper into the sheet feeder, then send the print job from 
your application. Instructions for generating the 
even-numbered pages will be displayed while the 
odd-numbered pages are printed.

“Loading single sheets of paper” on page 346

13. Follow the on-screen instructions to reload the paper.

Note:
❏ The paper may curl during printing due to the amount of ink 

used. Should this occur, slightly curl the sheets in the opposite 
direction before reloading them into the printer.

❏ Align the sheet stack by tapping its edges against a hard, flat 
surface before reloading the stack into the printer.

❏ Follow the instructions provided when reloading the printouts. 
Paper jams or improperly placed binding margins may occur if 
the printouts are not reloaded correctly.
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❏ If a paper jam occurs, refer to the following.
& See “The paper jams” on page 283

14. Once the paper is reloaded, click Resume to print the 
even-numbered pages.

Standard double-sided printing for Mac OS 9

Follow the steps below to print odd- and even-numbered pages 
onto opposite sides of the sheet.

1. Access the Page Setup dialog box.

“Accessing the printer software for Mac OS 9” on page 368

2. Make the appropriate Paper Size setting.

3. Select Auto Sheet Feeder as the Paper Source.

4. Select Portrait (tall) or Landscape (wide) to change the 
orientation of your printout.

5. Select the Double-Sided Printing check box.

6. Click Margins.
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7. Specify the edge of the paper where the binding will be 
placed. You can choose Left, Top, or Right.

8. Specify the width of the binding margin in the text box. You 
can enter any width from 0.12 inch to 1.18 inch or from 0.3 cm 
to 3.0 cm.

Note:
The actual binding margin may be different from the specified 
settings depending on your application. Experiment with a few 
sheets to examine actual results before printing the entire job.

9. Click OK to return to the Page Setup dialog box. Then, click 
OK to save your settings and close the dialog box.

10. Access the Print dialog box.

“Accessing the printer software for Mac OS 9” on page 368

11. Make the appropriate Media Type setting.

“Media type settings” on page 369

12. Load paper into the sheet feeder, then click Print to start 
printing. Instructions for generating the even-numbered 
pages will be displayed while the odd-numbered pages are 
printed.
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“Loading single sheets of paper” on page 346

13. Follow the on-screen instructions to reload the paper.

Note:
❏ The paper may curl during printing due to the amount of ink 

used. Should this occur, slightly curl the sheets in the opposite 
direction before reloading them into the printer.

❏ Align the sheet stack by tapping its edges against a hard, flat 
surface before reloading the stack into the printer.

❏ Follow the instructions provided when reloading the printouts. 
Paper jams or improperly placed binding margins may occur if 
the printouts are not reloaded correctly.

❏ If a paper jam occurs, refer to the following.
& See “The paper jams” on page 283

14. Once the paper is reloaded, click Resume to print the 
even-numbered pages.

Folded Booklet double-sided printing for 
Windows

Use the following steps to create a folded booklet as described in 
the beginning of this section.
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1. Access the printer driver.

“Accessing the printer software for Windows” on page 366

2. Click the Main tab, then make the Quality Option setting. See 
the following section for details on the Quality Option 
settings.
& See “Quality Option” on page 126

3. Select Sheet as the Source setting.

4. Make the appropriate Type setting.

“Media type settings” on page 369

5. Make the appropriate Size setting.

6. Select Portrait (tall) or Landscape (wide) to change the 
orientation of your printout.
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7. Click the Page Layout tab and select the Double-Sided 
Printing check box. Then, select the Folded Booklet check 
box.

8. Click Margins to open the Margins dialog box.

9. Specify the edge of the paper where the binding will be 
placed. You can choose Left, Top, or Right.

Note:
When Portrait is selected as the Orientation setting on the Main 
menu, the Left or Right binding positions are available. The Top 
binding position is available when Landscape is selected as the 
Orientation setting.
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10. Choose cm or inch as the Unit setting. Specify the width of 
the binding margin. You can enter any width from 0.3 cm to 
3.0 cm, or from 0.12 inches to 1.18 inches. The specified margin 
width will be used on both sides of the fold. For example, if a 
10-mm margin is specified, a 20-mm margin will be inserted 
(a margin of 10 mm will be placed on each side of the fold).

✽: Folding edge

✽✽: Margin

Portrait Landscape

✽ ✽

✽
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11. Click OK to return to the Page Layout menu. Then, click OK 
to save your settings.

12. Load paper into the sheet feeder, then send the print job from 
your application. Instructions for printing the inside pages 
will be displayed while the outside pages are printed.

“Loading single sheets of paper” on page 346

13. Follow the on-screen instructions to reload the paper.

Note:
❏ The paper may curl during printing due to the amount of ink 

used. Should this occur, slightly curl the sheets in the opposite 
direction before reloading them into the printer.

❏ Align the sheet stack by tapping its edges against a hard, flat 
surface before reloading the stack into the printer.

❏ Follow the instructions provided when reloading the printouts. 
Paper jams or improperly placed binding margins may occur if 
the printouts are not reloaded correctly.

❏ If a paper jam occurs, refer to the following.
& See “The paper jams” on page 283

14. Once the paper is reloaded, click Resume to print the inside 
pages.

15. Once printing is complete, fold the sheets and bind them 
together using a stapler or other binding method.

Folded Booklet double-sided printing for Mac OS 
9

Use the following steps to create a folded booklet as described in 
the beginning of this section.
Various Printing Options 87



1. Access the Page Setup dialog box.

“Accessing the printer software for Mac OS 9” on page 368

2. Make the appropriate Paper Size setting.

3. Select Auto Sheet Feeder as the Paper Source.

4. Select the Double-Sided Printing check box. Then, select the 
Folded Booklet check box.

5. Click Margins.

6. Specify the edge of the paper where the binding will be 
placed. You can choose Left, Top, or Right.

Note:
When Portrait is selected as the Orientation setting in the Page 
Setup dialog box, the Left or Right binding positions are available. 
The Top binding position is supported when Landscape is 
selected as the Orientation setting.
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7. Specify the width of the binding margin in the text box. You 
can enter any width from 0.12 inch to 1.18 inch or from 0.3 cm 
to 3.0 cm.The specified margin width will be used on both 
sides of the fold. For example, if a 10-mm margin is specified, 
a 20-mm margin will be inserted (a margin of 10 mm will be 
placed on each side of the fold).

✽: Folding edge

✽✽: Margin

8. Click OK to return to the Page Setup dialog box. Then, click 
OK to save your settings and close the dialog box.

9. Access the Print dialog box.

“Accessing the printer software for Mac OS 9” on page 368

Portrait Landscape

✽ ✽

✽
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10. Make the appropriate Media Type setting.

“Media type settings” on page 369

11. Load paper into the sheet feeder, then click Print to start 
printing. Instructions for printing the inside pages will be 
displayed while the outside pages are printed. 

“Loading single sheets of paper” on page 346

12. Follow the on-screen instructions to reload the paper.

Note:
❏ The paper may curl during printing due to the amount of ink 

used. Should this occur, slightly curl the sheets in the opposite 
direction before reloading them into the printer.

❏ Align the sheet stack by tapping its edges against a hard, flat 
surface before reloading the stack into the printer.

❏ Follow the instructions provided when reloading the printouts. 
Paper jams or improperly placed binding margins may occur if 
the printouts are not reloaded correctly.

❏ If a paper jam occurs, refer to the following.
& See “The paper jams” on page 283

13. Once the paper is reloaded, click Resume to print the inside 
pages.
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14. Once printing is complete, fold the sheets and bind them 
together using a stapler or other binding method.

Fit to Page Printing

You can use the Fit to Page printing function when you want to 
print, for example, an A4 size document on another size paper.

Fit to Page printing automatically fits images or text you want to 
print to the paper size you select in the printer software, or it 
allows you to manually resize the image.

Note:
❏ This feature is not available with Mac OS X.

❏ This feature is not available when selecting the Borderless check 
box on the Main menu (Windows) or in the Page Setup dialog box 
(Macintosh).

Driver settings for Windows

1. Access the printer driver.

“Accessing the printer software for Windows” on page 366
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2. Click the Main tab, then make the Quality Option setting. See 
the following section for details on the Quality Option 
settings.
& See “Quality Option” on page 126

3. Select Sheet as the Source setting.

4. Make the appropriate Type setting.

“Media type settings” on page 369

5. Make the appropriate Size setting.

6. Select Portrait (tall) or Landscape (wide) to change the 
orientation of your printout.
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7. Click the Page Layout tab, then select the Reduce/Enlarge 
Document check box. You can select the following settings 
to change the size of your document.

8. Select the paper size loaded in your printer from the 
drop-down list when selecting By Output Paper Size, or use 
the arrows to choose a percentage when selecting By 
Percentage.

9. Click OK to close the printer driver settings dialog box.

After finishing all steps above, start printing.

By Output Paper 
Size

Proportionally enlarges or reduces the size of 
your document to make it fit the paper size 
selected in the By Output Paper Size list.

By Percentage Allows you to manually reduce or enlarge an 
image. Click the arrows to select a percentage 
between 10 and 400.
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Driver settings for Mac OS 9

1. Access the Page Setup dialog box.

“Accessing the printer software for Mac OS 9” on page 368

2. Make the appropriate Paper Size setting.

3. Select Auto Sheet Feeder as the Paper Source.

4. Select Portrait (tall) or Landscape (wide) to change the 
orientation of your printout.

5. Click OK to save the settings and close the Page Setup dialog 
box.

6. Access the Print dialog box.

“Accessing the printer software for Mac OS 9” on page 368

7. Make the appropriate Media Type setting.

“Media type settings” on page 369
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8. Click the  Layout icon button.

9. Select the Fit to Page check box.

10. Select the paper size loaded in your printer from the Output 
Paper Size list.

11. Click OK to save the settings and close the Layout dialog box.

12. Click Print to start printing.
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Pages Per Sheet Printing

Pages Per Sheet printing allows you to print two or four pages on 
single sheets of paper.

Note:
This feature is not available when selecting the Borderless check box 
on the Main menu (Windows) or in the Page Setup dialog box (Mac OS 
9).

Driver settings for Windows

1. Access the printer driver.

“Accessing the printer software for Windows” on page 366

2. Click the Main tab, then make the Quality Option setting. See 
the following section for details on the Quality Option 
settings.
& See “Quality Option” on page 126

3. Select Sheet as the Source setting.

4. Make the appropriate Type setting.

“Media type settings” on page 369

5. Make the appropriate Size setting.
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6. Select Portrait (tall) or Landscape (wide) to change the 
orientation of your printout.
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7. Click the Page Layout tab, select Multi-page, then select 
Pages Per Sheet.

8. Make the following settings for Pages Per Sheet printing.

9. Click OK to close the printer driver settings dialog box.

After finishing all of the steps above, start printing.

2, 4 Prints two or four pages of your document on a 
single piece of paper.

Print Page 
Borders

Prints frames around the pages printed on each 
sheet.

Page Order Allows you to specify the order in which the 
pages will be printed on the sheet of paper. 
Some settings may be unavailable, depending 
on the Orientation setting on the Main menu.
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Driver settings for Mac OS X

1. Access the Page Setup dialog box. 

“Accessing the printer software for Mac OS X” on page 367

2. Select Stylus Photo R2400 as the Format for setting.

3. Make the appropriate Paper Size and Orientation settings.

4. Click OK to close the Page Setup dialog box.

5. Open the Print dialog box.

“Accessing the printer software for Mac OS X” on page 367

6. Select Stylus Photo R2400 as the Printer setting, then make 
the Copies & Pages setting.
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Note:
The Copies & Pages settings available are a standard feature of Mac 
OS X. See your operating system’s documentation for details.

7. Select Layout from the pop-up menu.

8. Make the following settings.

Pages per 
Sheet

Prints multiple pages of your document on a single 
piece of paper. You can choose from 1, 2, 4, 6, 9, 
or 16.

Layout 
Direction

Allows you to specify the order in which the pages 
will be printed on the sheet of paper.

Border Prints a border around the pages printed on each 
sheet. You can choose from None, Single hairline, 
Single thin line, Double hairline, or Double thin line.
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Note:
The Layout settings available are a standard feature of Mac OS X. 
See your operating system’s documentation for details.

9. Select Print Settings from the pop-up menu.

10. Make the appropriate Media Type, Color, and Mode settings.
& See “Print Settings” on page 161

“Media type settings” on page 369
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11. Click Print to start printing.

Driver settings for Mac OS 9

1. Access the Page Setup dialog box. 

“Accessing the printer software for Mac OS 9” on page 368

2. Make the appropriate Paper Size setting.

3. Select Auto Sheet Feeder as the Paper Source.
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4. Click OK to save the settings and close the Page Setup dialog 
box.

5. Access the Print dialog box.

“Accessing the printer software for Mac OS 9” on page 368

6. Make the appropriate Media Type setting.

“Media type settings” on page 369

7. Click the  Layout icon button.
Various Printing Options 103



8. Select the Multi-Page check box in the Layout dialog box, 
then select Pages per Sheet.

9. Make the following settings for Pages Per Sheet printing.

10. Click OK to save the settings and close the Layout dialog box.

11. Click Print to start printing.

2 Pages, 
4 Pages

Prints two or four pages of your document on a 
single piece of paper.

Page Order Allows you to specify the order in which the 
pages will be printed on the sheet of paper. 
Some settings may be unavailable, depending 
on the Orientation setting in the Page Setup 
dialog box.

Print page 
frames

Prints frames around the pages printed on each 
sheet.
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Poster Printing

Poster printing allows you to print poster-size images by 
enlarging one page to cover several sheets of paper.

Note:
❏ This feature is not available with Mac OS X.

❏ This feature is not available when selecting the Borderless check 
box on the Main menu (Windows) or in the Page Setup dialog box 
(Macintosh).

Driver settings for Windows

1. Access the printer driver.

“Accessing the printer software for Windows” on page 366

2. Click the Main tab, then make the Quality Option setting. See 
the following section for details on the Quality Option 
settings.
& See “Quality Option” on page 126

3. Select Sheet as the Source setting.

4. Make the appropriate Type setting.

“Media type settings” on page 369
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5. Make the appropriate Size setting.

6. Select Portrait (tall) or Landscape (wide) to change the 
orientation of your printout.
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7. Click the Page Layout tab and select Multi-Page, then select 
Poster Printing. Click the up or down arrow to select 2x2, 3x3, 
or 4x4.
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8. Click Settings to adjust the way your poster will print. The 
Poster Settings dialog box opens.

9. Make the following settings.

Note:
If you want to print only a few of the panels without printing the 
entire poster, click the panels that you do not wish to print.

10. Click OK to close the Poster Settings dialog box.

After finishing all of the steps above, start printing.

Print Cutting 
Guides

Select this check box to turn the cutting guide 
options on.

Overlapping 
Alignment Marks

Slightly overlaps the panels and prints alignment 
markers so that the panels can be aligned more 
precisely.

Trim Lines Prints border lines on the panels to guide you 
when trimming the pages.
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Driver settings for Mac OS 9

1. Access the Page Setup dialog box. 

“Accessing the printer software for Mac OS 9” on page 368

2. Make the appropriate Paper Size setting.

3. Select Auto Sheet Feeder as the Paper Source.

4. Select Portrait (tall) or Landscape (wide) to change the 
orientation of your printout.

5. Click OK to save the settings and close the Page Setup dialog 
box.

6. Access the Print dialog box.

“Accessing the printer software for Mac OS 9” on page 368

7. Make the appropriate Media Type setting.

“Media type settings” on page 369
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8. Click the  Layout icon button.

9. Select the Multi-Page check box in the Layout dialog box, 
then select Poster.

10. Make the following settings.

1 page covers xx 
sheets

Specifies how many printed sheets of 
paper the enlarged document page will 
cover. You can choose from 4, 9, or 16 
sheets.

Overlapping 
Alignment Marks

Slightly overlaps the panels and prints 
alignment markers so that the panels can 
be aligned more precisely.
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Note:
If you want to print only a few of the panels without printing the 
entire poster, click Panel Selection, click the panels that you do 
not wish to print, then click OK.

11. Click OK to save the settings and close the Layout dialog box.

12. Click Print to start printing.

How to make a poster from your printouts

Here is an example of how to make a poster with 2x2 selected 
under Poster Printing and Overlapping Alignment Marks 
selected as the print cutting guide. Refer to the accompanying 
illustrations as well.

Trim Lines Prints border lines on the panels to guide 
you when trimming the pages.

Panel Selection Click the panels you do not need to print, 
then click the OK button to print the 
remaining panels.
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1. Cut off the margin of Sheet 1 along a vertical line through the 
center of the top and bottom cross marks, as shown in the 
illustration below.

2. Place the edge of Sheet 1 on top of Sheet 2 and align the cross 
marks, then temporarily tape the two sheets together from the 
back side.

3. Cut the taped sheets in two along a vertical line through the 
alignment markers (this time, a line to the left of the cross 
marks), as shown in the illustration below.
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4. Align the edges of the paper together using the alignment 
markers and tape them from the back side of the paper.

5. Repeat the instructions from step 1 to step 4 to tape Sheets 3 
and 4 together.

6. Repeat the instructions from step 1 to step 4 to tape the top 
and bottom faces of the paper.

7. Cut off the remaining margins.

w
Warning:
Be careful when using sharp tools.
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Watermark Printing

Watermark printing allows you to print a text-based or an 
image-based watermark on your document.

Note:
❏ This feature is not available with Mac OS X.

❏ This feature is not available when selecting the Borderless check 
box on the Main menu (Windows) or in the Page Setup dialog box 
(Macintosh).

Printing the watermark for Windows

1. Access the printer driver software.

“Accessing the printer software for Windows” on page 366

2. Click the Main tab, then make the Quality Option setting. See 
the following section for details on the Quality Option 
settings.
& See “Quality Option” on page 126

3. Select Sheet as the Source setting.

4. Make the appropriate Type setting.

“Media type settings” on page 369
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5. Make the appropriate Size setting.

6. Select Portrait (tall) or Landscape (wide) to change the 
orientation of your printout.
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7. Click the Page Layout tab, choose the desired watermark 
from the Watermark list, then click Settings.
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8. Specify the necessary settings for the watermark. You can 
change the position and size of the watermark by dragging 
the image within the preview window at the left of the dialog 
box.

9. Click OK to return to the Page Layout menu.

10. Click OK to close the printer driver settings dialog box.

11. Print the data from your application.

Printing the watermark for Mac OS 9

1. Access the Page Setup dialog box.

“Accessing the printer software for Mac OS 9” on page 368

2. Make the appropriate Paper Size setting.

3. Select Auto Sheet Feeder as the Paper Source.
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4. Select Portrait (tall) or Landscape (wide) to change the 
orientation of your printout.

5. Click OK to save the settings and close the Page Setup dialog 
box.

6. Access the Print dialog box.

“Accessing the printer software for Mac OS 9” on page 368

7. Make the appropriate Media Type setting.

“Media type settings” on page 369

8. Click the  Layout icon button.
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9. Select the Watermark check box in the Layout dialog box, 
then choose the desired watermark from the Name list.

10. Specify the necessary settings for the watermark. You can 
change the position and size of the watermark by dragging 
the image within the preview window at the left of the dialog 
box.

11. Click OK to save the settings and close the Layout dialog box.
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12. Click Print to start printing.

Creating your own watermark for Windows

You can add your own text-based or image-based watermarks to 
the watermark list.

1. Click Add/Del under Watermark on the Page Layout menu. 
The following dialog box appears.

2. To use an image file as a watermark, select BMP. Click Browse 
to specify the bitmap file you want to use, then click OK. Type 
a name for your watermark in the Name text box, then click 
Save.

To create a text-based watermark, select Text. Type your text 
in the Text text box. The text that you enter will also be used 
as the watermark name. If you want to change the watermark 
name, type a new name in the Name text box, then click Save.

3. Click OK to return to the Page Layout menu.
120 Various Printing Options



2

2

2

2

2

2

2

2

2

2

2

2

4. Click Settings. The following dialog box appears.

5. Make sure that the appropriate watermark is selected in the 
Watermark list, then make Color, Position, Density, Size, 
Font, Font Style, and Angle settings. (For details, see online 
help.) Your settings are reflected in the display at the left of 
the dialog box.

6. When you finish making settings, click OK.

Creating your own watermark for Mac OS 9

You can add your own text-based or image-based watermarks to 
the watermark list.
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1. Click Add/Del beside the Name list. The following dialog box 
appears.

2. To use an image file as a watermark, click Add PICT. Specify 
the desired image file, then click Open.

To create a text-based watermark, click Add Text. Type the 
text in the Text text box, select a font and a text style, then click 
OK.
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3. The image file name or the watermark text appears in the 
Mark Name list in the Watermark dialog box. To change the 
name of an image watermark, select it from the list, then type 
a new name. When a text watermark is selected in the Name 
list, you can edit the text or change the font and text style by 
clicking Edit Text.

4. Click OK to add your watermark to the Name list in the 
Layout dialog box.
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Chapter 3

Printer Software Settings

For Windows

Printer software introduction

Printer driver menus

The printer software that comes with your printer includes a 
printer driver and printer utilities. The printer driver lets you 
choose from a wide variety of settings to get the best results from 
your printer. The printer utilities help you check the printer and 
keep it in top operating condition.

For details on each printer driver setting and utility, see the 
following.
& See “Making settings on the Main menu” on page 125
& See “Making settings on the Page Layout menu” on page 144
& See “Making settings on the Maintenance menu” on page 147

Accessing the printer driver

For information on accessing the printer software, see the 
following.

“Accessing the printer software for Windows” on page 366

Note:
The specific features available in the printer software vary depending on 
the version of Windows that you are using.
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Getting more information

Online help provides more information about the printer 
software.
& See “Getting information through online help” on page 154

Making settings on the Main menu

You can make Quality Option, Paper Options, Print Options, 
Orientation, and Advanced settings, and also check the ink levels 
on the Main menu. Refer to the appropriate section below.

Making the Basic settings
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Quality Option

You can select one of the following quality types.

Paper Options

Draft For economical, high-speed printing.

Text For medium-quality, standard text printing.

Text & Image For high-quality, standard text and graphics printing.

Photo For high-quality photographic printing.

Best Photo For top-quality photographic printing.

User Defined
(your unique 
name)

If you create custom settings and then select one of them 
on the Advanced menu, it will appear as an icon.

Source Select Sheet to print on normal paper.

Select Roll to print on roll paper.

Select Manual - Roll to print single sheets fed into the rear 
manual feed slot.

Select Manual - Front to print on Thick Paper fed into the 
front manual feed slot.

Borderless Select this check box when you want to print without 
margins. With this feature, you can print to all four edges 
of the paper.
& See “Borderless Printing” on page 66

Type Select the Type setting that matches the media loaded 
in the printer.

The Type setting determines what other settings are 
available, so you should always make this setting first.

To find out what media type you are using, find your 
media in the Media Type Settings list.

“Media type settings” on page 369
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Print Options

PhotoEnhance

This mode applies image correction settings specially designed 
for scanned or digitally captured photos.

Reverse Order

Lets you print your documents in reverse order, starting with the 
last page.

Print Preview

Lets you see a preview of your document before printing.

Size Select the paper size that you want to use. You can also 
add a custom paper size. To add your own paper size 
setting, see the following.

“Making User Defined paper sizes for Windows” on page 
372

Banner 
Mode

Select this mode when you want to print multi-page data 
continuously rather than as individual pages. When this is 
selected, the Save roll Paper check box is available.

Cut Sheet 
Mode

Select this mode when you want to print multi-page data 
as individual pages rather than continuously. When this is 
selected, the Print page frame check box is displayed.

Save Roll 
Paper

Select this check box when you want to save roll paper. 
When this is selected, the blank portion of the last page 
of your document is not fed through the printer.

Print page 
frame

Select this check box to print a line on the roll paper 
between pages in a multi-page document, to indicate 
where the paper should be cut. This feature is useful when 
it is unclear where the page breaks are.
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When you send a print job to the printer, the Print Preview 
window opens, allowing you to make changes before printing.

The Print Preview toolbar contains several icon buttons to 
perform the following functions.

Icon Button name Function

Drag ’n’ Drop Click this button to select and move 
watermarks.

Zoom Click this button to enlarge or reduce the 
size of the previewed page.

Fit To Screen Click this button to scale the previewed 
page so that it fits the size of the window. 
This is convenient when you want to see 
the entire page at one time.

Maximum 
Zoom

Click this button to display the previewed 
page at the maximum possible zoom 
ratio.
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You can also manipulate the document being previewed in the 
following ways:

❏ Select and preview individual pages.

❏ Reduce or enlarge the size of the preview window.

❏ Magnify the previewed document. Click Magnify on the 
View menu to open the Magnify window, which magnifies 
the area of the previewed document that is outlined by the 
red box. By dragging the red box, you can change which part 
of the document is magnified.

❏ View the individual pages that comprise a poster. The Poster 
window opens automatically when you send a print job while 
Poster Printing is selected under Multi-Page on the Page 
Layout menu. From this window, you can view the individual 
panels that make up a poster. You can also open this dialog 
box by clicking Poster on the View menu.

Printable Area 
On/Off

Click this button to display or hide the 
borderlines which indicate the printable 
area. The printer cannot print anything 
which is outside of this area.

Watermark Click this button to open the Watermark 
dialog box, where you can add 
watermarks to the document and 
change any of the current watermark 
settings.

Reset 
Watermark 
Settings

Click this button to return all watermark 
settings to what they were when the 
EPSON Print Preview dialog box was first 
opened.

Previous Page Click this button to display the page 
before the one currently being 
previewed.

Next Page Click this button to display the next page 
in the document.
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❏ Apply watermarks. The watermark that you select will be 
displayed on the previewed image.
& See “Watermark Printing” on page 114

❏ Specify which pages of the document you would like to print. 
To add or remove a page, click the page icon in the list at the 
left side of the preview window, and then add or remove it 
using the commands on the Print Options menu.

After you have previewed the document, click Print to print the 
document, or click Cancel to cancel printing.

Orientation

Select Portrait (tall) or Landscape (wide) to change the 
orientation of your printout.

How to Buy

The How to buy button appears when an ink cartridge is finished 
or nearly finished. Click the How to Buy button to access the 
EPSON website. Choose your country from the drop-down menu, 
and then follow the onscreen instructions.
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Show Settings

When you click Show Settings, the Current Setting window 
appears. To hide the window, click Hide Settings on the Main 
menu or Close in the Current Setting window.

Reset Defaults

Click the Reset Defaults button to return the settings to their 
factory default values.

Technical Support

Click the Technical Support button to access the EPSON website. 
Here you can find information covering a broad range of EPSON 
support.

Advanced

Shows the Advanced menu.
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Making the Advanced settings

The settings in the Advanced dialog box give you complete 
control over your printing environment. Use these settings to 
experiment with new printing ideas or to fine-tune a range of 
print settings to meet your individual needs. Once you are 
satisfied with your new settings, you can give them a name and 
add them to the Custom Settings.

Note:
❏ Advanced settings are recommended for experienced users only. 

Incorrect settings can reduce print speed or quality.

❏ The figures in this procedure are taken from Windows XP. The 
Windows Me, 98, and 2000 figures may differ slightly.

❏ Some settings may not be available, depending on the Paper Source, 
Media Type, and Print Quality settings that you make.

❏ The PhotoEnhance feature only affects images, not text or graphs. 
For example, if Sepia is chosen from the Tone list (available when 
PhotoEnhance is selected), only the images in a document will 
be printed in sepia. Any colored text or graphs in the same document 
will be printed in color.
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To open the Advanced menu, click Advanced on the Main 
menu. If the following Note dialog box appears, click Continue.
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Paper & Quality Options

Orientation

Select Portrait (tall) or Landscape (wide) to change the 
orientation of your printout.

Source Select Sheet to print on normal paper.

Select Roll to print on roll paper.

Select Manual - Roll to print single sheets fed into the 
rear manual feed slot.

Select Manual - Front to print on thick paper fed into 
the front manual feed slot.

Borderless Select this check box when you want to print without 
margins. With this feature, you can print to all four 
edges of the paper.
& See “Borderless Printing” on page 66

Type Select the Type setting that matches the media 
loaded in the printer.

To find out what media type you are using, find your 
media in the Media Type Settings list.

“Media type settings” on page 369

Note:
The availability of the Print Quality setting depends on 
the Media Type setting. Therefore, make the Media 
Type setting before you set the Print Quality.

Print Quality Select the print quality from the list.

Size Select the paper size that you want to use. You can 
also add a custom paper size. To add your own paper 
size setting, see the following.

“Making User Defined paper sizes for Windows” on 
page 372
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Print Options

Color Management

Color Controls

For use with the color matching and image enhancement methods 
provided by the printer driver. When you select Color Controls, 
additional settings appear under Color Management, allowing 
you to select a Color Mode setting and adjust the color 
enhancement sliders.

Reverse order Lets you print your documents in reverse order, starting 
with the last page.

High Speed Activates bidirectional printing so your printer prints 
both left-to-right and right-to-left. High Speed mode 
speeds up printing, but decreases print quality.

Grayscale Prints your printout in grayscale.

Edge 
Smoothing

Improves the print quality of low-resolution images by 
smoothing jagged edges and lines. This setting has no 
effect on high-resolution images or on text.

Print Preview Shows a preview of your document before printing.

Gamma To control image contrast by modifying the midtones 
and mid-level grays.

Color Mode EPSON Standard: Provides output that closely 
matches the original data.

EPSON Vivid: Based on your data, enhances color 
balance for optimum print results. This setting is 
recommended for most print jobs.

Adobe RGB: Covers the full range of CMYK colors that 
this product can print. This setting is recommended for 
printing digital photos.

Slide Bars The Color Enhancement slide bars adjust the options 
in a range of -25% to +25%. For details on each option, 
see the printer driver help.
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PhotoEnhance

This mode provides a variety of image correction settings that you 
can apply to your photos before printing. PhotoEnhance does not 
affect your original data.

Note:
Printing with PhotoEnhance selected may increase the time required 
for printing, depending on your computer system and the amount of data 
contained in your image.

Selecting PhotoEnhance also makes the Digital Camera 
Correction check box available. Selecting this check box makes 
the Smooth Skin check box available. Use this when you are 
printing photos taken with a digital camera to give your printed 
images the smooth, natural appearance of photographs taken 
with a film camera.

Advanced B&W Photo

To access the Advanced B&W Photo settings dialog box, select 
Advanced B&W Photo as the Color Management setting, and 
then click Settings. 
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Note:
Advanced B&W Photo is available depending on the ink cartridge 
installed (Photo Black or Matte Black), the media type setting, and the 
print quality setting. For most media types, select Best Photo or Photo 
RPM as the print quality setting.
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Here you can use the following tools to make detailed 
adjustments to your photos.

Color Toning

Select one of the following settings.

Neutral Applies a standard color correction to black-and-white 
photos.

Cool Applies a cool tone to your photos.

Warm Applies a warm tone to your photos.

Sepia Applies a sepia tone to your photos.

Fine 
Adjustment

This appears when you change the Tone, adjust the 
settings using the slide bars or the color circle, or select 
the Highlight Point Shift check box.
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Tone

Adjusts the tone by five levels.

Slide Bars

The tone enhancement slide bars adjust the following options. 
Drag the slide bar to the right or left to adjust the settings. You 
can also enter a value in the boxes next to the slide bars.

Highlight Point Shift

Select this check box to add a little more ink to white areas to give 
it a glossy look.

Color Circle

Click in the color circle to adjust the color tone of your 
black-and-white photo. You can also adjust the color tone by 
entering a value in the Horizontal and Vertical text boxes.

Light Applies a harder tone to your photos.

Normal Applies a hard tone to your photos.

Dark Applies a soft tone to your photos.

Darker Applies a softer tone to your photos.

Darkest Applies the softest tone to your photos.

Brightness Adjusts the overall lightness and darkness within a range 
of -25 to +25.

Contrast Adjusts the difference between the bright and dark 
parts of your image within a range of -25 to +25.

Shadow 
Tonality

Adjusts the shadow tonality within a range of -25 to +25.

Highlight 
Tonality

Adjusts the highlight tonality within a range of -25 to +25.

Max Optical 
Density

Adjusts the focus of the print. Create a soft focus print 
by setting the density to low within a range of -50 to 0.
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Default

Click the Default button to return the settings to their default 
values.

ICM

This setting uses the Windows color matching method to 
automatically adjust printout colors to match colors on your 
screen. Select this setting when printing scanned photographs or 
computer graphics.

Note:
❏ Be aware that the ambient light and the age, quality, and settings of 

the monitor can affect the quality of your color matching.
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❏ The following settings are available for Windows XP/2000 only.

Off (No Color 
Adjustment)

Only use this setting when you create a new color 
profile or if the other Mode settings do not produce 
satisfactory results.

Turning this setting off by selecting Off (No Color 
Adjustment) is generally not recommended, because 
it does not allow the printer driver to enhance or adjust 
the color.

ICM Mode Select the ICM mode from Host ICM, Driver ICM (Basic), 
or Driver ICM (Advanced).

Input Profile Select an input profile.

This setting is not available when Host ICM is selected 
as the ICM Mode setting.

Intent Select the rendering intent or color mapping 
preference.

Saturation: 
This setting is the best option for presentation graphics 
to accurately reproduce vivid colors. Use of this setting 
is not recommended when printing photo data.

Perceptual: 
This setting renders an image’s color to appear 
naturally, and is often used to render the wide color 
range of the original image. Use of this setting is 
recommended when printing photo data.

Relative Colorimetric:
This setting renders an image by maintaining a relative 
color range, and is often used when most of the color 
range before conversion is found in the image after 
conversion. Use of this setting is recommended when 
printing photo data.

Absolute Colorimetric:
This setting renders an image by maintaining an 
absolute color range so that there is a 1-to-1 ratio of 
absolute lab coordinates. This setting is not 
recommended when printing photo data and normal 
conversions.

Printer Profile Select a printer profile.

Printer Profile 
Description

Shows the description of the selected printer profile.
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Save Settings

To save your Advanced settings in the Custom Settings list, click 
Save Setting. The Custom Settings dialog box appears.

Type a unique name for your settings in the Name text box, then 
click Save. The name can contain a total of up to 16 letters and 
numerals. You can also use up to eight, double-byte characters; 
however, they may not be displayed correctly on the screen 
depending on your operating system settings. Your custom 
setting will be added to the Custom Settings list on the Advanced 
menu. You can save up to 10 custom settings.

After saving it, the latest custom setting will be selected on the 
Advanced menu as well as under Quality Option on the Basic 
menu. To change to another custom setting, simply select it from 
the Custom Settings list on the Advanced menu, or click the icon 
with the current custom setting's name under Quality Option on 
the Basic menu and select the custom setting you want from the 
list that appears.

Show all profiles Shows all profiles in the Input Profile and the Printer 
Profile pull-down menu.

This setting is not available when Host ICM is selected 
as the ICM Mode setting.
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If you change a setting while one of your custom settings is 
selected in the Custom Settings list, the selection in the list returns 
to Custom Settings and the user-defined choice under Quality 
Option on the Basic menu changes to User. The custom setting 
that was previously selected is not affected by the change and 
remains in the list. To return to your custom setting, simply 
reselect it from the Custom Settings list on the Advanced menu, 
or click the User icon under Quality Option on the Basic menu and 
select it from the list that appears.

To delete a setting from the Custom Settings list, select it in the 
Custom Settings dialog box, then click Delete. If the deleted 
custom setting was active when deleted or if it was the only 
custom setting, the Custom Settings list selection returns to 
Custom Settings and the user-defined choice under Quality 
Option on the Basic menu changes to User. To activate a 
remaining custom setting, simply select it from the Custom 
Settings list on the Advanced menu, or click the User icon under 
Quality Option on the Basic menu and select the custom setting 
you want from the list that appears.

Show this screen first

Shows the Advanced menu first when accessing the Main menu 
in the printer software.

Reset Defaults

Click the Reset Defaults button to return the settings to their 
factory default values.

Technical Support

Click the Technical Support button to access the EPSON website.

Paper Configuration

Click the Paper Config button to access the Paper Configuration 
dialog box. Here you can make the following detailed paper 
settings.
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Color Density

Use this to adjust the strength of color density when printing on 
non-EPSON media. You can adjust the density by dragging the 
scroll bar to the left or right, or by entering a value between -50 
and 50 in the text box.

Drying Time per Print Head Pass

Use this to add a waiting time when the print head reaches the 
end of every pass to allow the ink to dry. You can adjust the setting 
by dragging the scroll bar to the left or right, or by entering a value 
between 0 and 50 in the text box.

Basic

Shows the Basic menu.

Making settings on the Page Layout menu
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More Options

Adjust the printing data as follows.

Reduce/Enlarge Document

Adjust the size of your document to fit the size page you want to 
print on.
& See “Fit to Page Printing” on page 91

Copies

Select the number of copies that you want to print.

You can select from the following settings.

Multi-Page

Select this check box to make the Pages Per Sheet and Poster 
Printing settings available.

Rotate 180° Prints the pages rotated 180 degrees.

Mirror Image Prints an image as it would appear in a mirror. (Text and 
graphics appear backwards.)

Reverse Order Prints your documents in reverse order, starting with the 
last page.

Collate Print one complete document set at a time.

Pages Per Sheet Print two or four pages of your document on one sheet 
of paper.
& See “Pages Per Sheet Printing” on page 96

Poster Printing A single document page can be enlarged to cover 4, 
9, or 16 printed sheets of paper.
& See “Poster Printing” on page 105
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Borderless

When the Borderless check box is selected on the Main menu, the 
Borderless Expansion slider becomes available. Using the slider, 
you can control the amount of the image that extends beyond the 
edges of the paper during borderless printing.

For most print jobs, selecting Max is recommended in order to 
eliminate margins on all sides of the paper.

Moving the slider towards Min decreases the amount of the image 
that extends beyond the edges of the paper; however, as this 
amount decreases, margins may begin to appear on one or more 
sides of the paper.

Watermark

You can print a text or image watermark on your printout.
& See “Watermark Printing” on page 114

Double-Sided Printing

Two types of double-sided printing are available. Standard 
double-sided printing allows you to print the odd-numbered 
pages first. Once these pages are printed, they can be reloaded to 
print the even-numbered pages onto the opposite side of the 
paper. Folded Booklet double-sided printing allows you to make 
single-fold booklets. 
& See “Double-Sided Printing” on page 75
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Making settings on the Maintenance menu

Epson printer utilities allow you to check the current printer 
status and maintain certain features of your printer from your 
computer.

To use the utilities, click the Maintenance tab in the printer 
software, then click the button for the utility that you want to use. 
Refer to the section below to access the printer software.

“Accessing the printer software for Windows” on page 366

Note:
❏ The letter in parentheses after the utility name indicates the shortcut 

key for that utility. After selecting the menu, press Alt and the letter 
on the keyboard to open that utility.

❏ Do not use the Nozzle Check, Head Cleaning, or Print Head 
Alignment utilities if your printer is connected to your computer 
through a network.
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Refer to the appropriate section below.

Status Monitor 3

EPSON Status Monitor 3 provides you with printer status 
information, such as the amount of ink remaining, and checks for 
printer errors.

This utility is only available when both of the following conditions 
are met:

❏ The printer is connected directly to the host computer via the 
USB or IEEE 1394 port.

❏ Your system is configured to support bidirectional 
communication.

Auto Nozzle Check and Cleaning

Prints nozzle check pattern and automatically checks print head 
nozzles. If they are clogged, performs head cleaning.
& See “Cleaning the Print Head” on page 252

Nozzle Check

The Nozzle Check utility checks the print head nozzles for 
clogging. Check the nozzles if you notice print quality has 
declined and after cleaning to confirm that the print head nozzles 
have been cleared. If the nozzle check indicates that the print head 
needs cleaning, you can access the Head Cleaning utility directly 
from the Nozzle Check utility.
& See “Checking the Print Head Nozzles” on page 248
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Head Cleaning

The Head Cleaning utility cleans the print head. You may need 
to clean the print head if you notice that print quality has declined. 
Use the Nozzle Check utility first to confirm that the print head 
needs to be cleaned. You can access the Nozzle Check utility 
directly from the Head Cleaning utility.
& See “Checking the Print Head Nozzles” on page 248

Print Head Alignment

The Print Head Alignment utility can be used to improve the print 
quality of your documents. The print head alignment may need 
to be adjusted if vertical lines appear out of alignment or if white, 
black, dark, or light banding appears in your documents. Use this 
utility to realign the print head.
& See “Aligning the Print Head” on page 265

Printer and option information

This utility allows the printer driver to confirm printer 
configuration information. It also provides specific information 
regarding certain characteristics of the printer.
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Printer Information acquisition

Depending on the configuration of your system, the information 
displayed in the Printer and Option Information dialog box may 
be updated automatically, or may need to be entered manually.

If a message appears in the Current Settings window prompting 
you to enter settings, or if you change the printer configuration, 
follow the steps below to make the necessary settings manually.

1. Click Settings Sheet in the Printer and Option Information 
dialog box to print out information about your printer and 
options. A4 or Letter size paper must be loaded in your printer 
to use this utility. You will see a printout similar to the one 
below.

2. Make sure the settings in the utility match the information on 
the printed Settings Sheet. If they do not match, correct the 
settings on the screen to match the information on the settings 
sheet.

3. Click OK to exit this menu and save your settings.

Thick paper

Adjusts the size of the gap between the platen and print head. 
Select this check box if your printouts are rubbed while printing.
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Speed & Progress

You can make settings related to print speed and progress in this 
dialog box.

The following are the available settings:

Note:
The specific features available in the printer software vary depending on 
the printer model and version of Windows that you are using.

High Speed Copies

To print multiple copies of your document faster, select High 
Speed Copies. This speeds up printing by using your hard disk 
space as a cache when printing multiple copies of your document.

Disable EPSON Status Monitor 3

If you do not want the EPSON Status Monitor 3 to appear every 
time you print, select the Disable EPSON Status Monitor 3 check 
box.
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Show Progress Meter

To display the progress meter every time you print, select Show 
Progress Meter.

Always spool RAW datatype (for Windows XP and 2000)

Select this check box to have Windows NT based clients spool 
documents using the RAW format instead of the EMF (metafile) 
format (Windows NT based applications use the EMF format by 
default).

Try using this option if documents spooled in EMF format do not 
print correctly.

Spooling RAW datatype requires less resources than EMF, so 
some problems (“Insufficient memory/disk space to print”, 
“Slow print speed”, etc.) can be solved by selecting the Always 
spool RAW datatype check box.

Note:
When spooling RAW datatype, print progress as displayed by the 
progress meter may differ from actual print progress.

Page Rendering Mode (Windows XP and 2000)

Select this checkbox when the print speed is extremely slow or 
when the print head stops for a few minutes while printing.

Note:
When using this function, the following problems may occur:

❏ Print progress displayed in the Progress Meter window may differ 
from the actual print progress.

❏ Printing may take a longer time to start.
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Print as Bitmap (Windows XP and 2000)

Select this checkbox when the print speed is extremely slow or 
when the print head stops for a few minutes while printing. Try 
this option if Always spool RAW datatype and Page 
Rendering Mode do not solve the problem.

Monitoring Preferences

Click this button to open the Monitoring Preferences dialog box, 
where you can make settings for EPSON Status Monitor 3.

You can make the following settings.

Select 
Notification

Displays the current error notification settings.

Select the check boxes of the error types for which you 
want to receive notification.

Note:
Click the Default button to revert all Select Notification 
settings to their default settings.
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Getting information through online help

Your printer software has an extensive online help feature that 
provides you with instructions on printing, making printer driver 
settings, and using printer utilities.

Refer to the appropriate section below.

Accessing help from your application

Choose Print or Print Setup from the File menu. Then, click 
Printer, Setup, Options, or Properties. (Depending on your 
application, you may need to click any one or a combination of 
these buttons.)

You can get specific help with any item on a menu by 
right-clicking the item, then clicking the What’s This? command.

You can also view a detailed explanation of a setting or option by 
clicking the  button on the top right of the printer driver 
window, then clicking the item.

Accessing help from the Windows Start menu

1. For Windows XP, click Start, Control Panel, then 
double-click Printers and Faxes. (If the Control Panel is in 
Category View, click Printers and Other Hardware, then 
click Printers and Faxes.)

Select 
Shortcut Icon 

Select the Shortcut Icon check box and choose an icon 
type to have a shortcut icon placed in your Windows 
taskbar. You can click the shortcut icon in the taskbar to 
open EPSON Status Monitor 3 or right-click the icon to 
access some of the printer utilities.

Allow 
monitoring of 
shared 
printers

Select this check box to allow monitoring of a shared 
printer by other computers.
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For Windows Me, 98, and 2000, click Start, point to Settings, 
then click Printers.

2. For Windows XP and 2000, select your printer, then click 
Printing Preferences on the File menu.

For Windows Me and 98, select your printer, then click 
Properties on the File menu.

The printer software opens.

You can get specific help related to any item on a menu by 
right-clicking the item, then clicking the What’s This? command.

You can also view a detailed explanation of a setting or option by 
clicking the  button on the top right of the printer driver 
window, then clicking the item.
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For Mac OS X

Printer software introduction

Printer driver dialog boxes

The printer software that comes with your printer includes a 
printer driver and printer utilities. The printer driver lets you 
choose from a wide variety of settings to get the best results from 
your printer. The printer utilities help you check the printer and 
keep it in top operating condition. The following dialog boxes are 
available.
& See “Page Setup Dialog Box” on page 157
& See “Print Dialog Box” on page 159
& See “EPSON Printer Utility” on page 170

Accessing the printer software

For information on accessing the printer software, see the 
following.

“Accessing the printer software for Mac OS X” on page 367

Getting more information

You can also get information by clicking the  help button when 
Copies & Pages, Layout, Color Management, Extension 
Settings, Paper Configuration, or Summary is selected in the 
Print dialog box. For other settings, see your operating system’s 
documentation.
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Page Setup Dialog Box

Note: 
Page Setup dialog box is a standard feature of Mac OS X. See your 
operating system’s documentation for details.

Page Setup dialog box settings

Allows you to make the appropriate Settings, Format for, Paper 
Size, Orientation, and Scale settings that you want to use for 
printing.

Settings Page Attributes Displays the page setup 
settings.

Custom Paper Size Displays your custom paper 
size settings.

Summary Displays the list of current 
setting items.

Format for Stylus Photo R2400 Select your printer.
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& See “Printable area” on page 335

Note:
Always match the Format for setting in the Page Setup dialog box and 
the Printer setting in the Print dialog box. Otherwise the data may not 
be printed correctly.

Paper Size Manual - Front Select this mode to print on 
thick paper fed into the front 
manual feed slot.

Roll Paper - Borderless 
Banner

Select this mode when you 
want to print multi-page data 
continuously on roll paper 
without margins.

Roll Paper - Borderless Select this mode to print on roll 
paper without margins.

Roll Paper Select this mode to print on roll 
paper with standard margins.

Sheet Feeder - 
Borderless

Select this mode to print 
without margins.

Manual - Roll Select this mode to print single 
sheets of paper, fed into the 
rear manual feed slot, with 
standard margins.

Manual - Roll 
(Borderless)

Select this mode to print single 
sheets of paper, fed into the 
rear manual feed slot, without 
margins.

Orientation Select the printing orientation.

Scale Input the scale to reduce or enlarge the size of your data.
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Print Dialog Box

Note:
Print dialog box is the standard feature of Mac OS X. See your operating 
system’s documentation for details.

Print dialog box settings

Allows you to make the appropriate Printer and Presets settings 
that you want to use for printing.

Printer Stylus Photo R2400 Select your printer.

Presets Standard Prints with the current settings.

Custom Prints with the custom saved 
settings.

Note:
Save Custom Setting is the 
standard feature of Mac OS X. 
See your operating system’s 
documentation for details.
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& See “Printable area” on page 335

Note:
Always match the Format for setting in the Page Setup dialog box and 
the Printer setting in the Print dialog box. Otherwise the data may not 
be printed correctly.

Copies & Pages

Allows you to make the appropriate Copies, Collated, and Pages 
settings that you want to use for printing.

Note:
Copies & Pages is the standard feature of Mac OS X. See your operating 
system’s documentation for details.

Layout 

Allows you to make the appropriate Pages per Sheet, Layout 
Direction, and Border settings that you want to use for printing.

Note:
Layout is the standard feature of Mac OS X. See your operating system’s 
documentation for details.

Output Options

Clear the Save as File check box when you want to print.

Note:
Output Options is the standard feature of Mac OS X. See your operating 
system’s documentation for details.
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Print Settings

Media Type

Determines what other settings are available in the Print dialog 
box, so you should always make this setting first. Select the Media 
Type setting that matched the paper that is loaded in the printer. 
To find what media type you are using, find your media in the 
Media Type Setting list.

“Media type settings” on page 369

Note:
For the latest information on available media, visit our regional customer 
support web site.
& See “Contacting Customer Support” on page 379
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Color

Advanced B&W Photo

To access the Advanced B&W Photo settings select Advanced 
B&W Photo as the Color setting. Then, from the pop-up menu, 
select Color Management. For more details see the following 
section.

Note:
Advanced B&W Photo is available depending on the ink cartridge 
installed (Photo Black or Matte Black), the media type setting, and the 
print quality setting. For most media types, select Best Photo or Photo 
RPM as the print quality setting.

“When Advanced B&W Photo is selected as the Color setting 
in Print Settings” on page 164

Color Print in color.

Advanced B&W 
Photo

Print photos in high quality black and white.

Black Print in grayscale.
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Automatic mode

Provides the quickest and easiest way to start printing. The 
printer software takes care of all detailed settings based on the 
current Media Type and Color settings.

Note:
Depending on the media selected in the Media Type list (while 
Automatic is selected), a slider appears to the right of the Mode options, 
which lets you choose Quality or Speed level. Select Quality when print 
quality is more important than speed.

Advanced mode

Selecting Advanced as the Mode setting gives you complete 
control over your printing environment. Use these settings to 
experiment with new printing ideas or to fine-tune a range of 
print settings to meet your individual needs.

Print Quality

Select the printing quality that you want to use for printing.

High Speed

Activates bidirectional printing so your printer prints both 
left-to-right and right-to-left. High Speed mode speeds up 
printing, but decreases print quality.

Mirror Image

Prints an image as it would appear in a mirror. Text and graphics 
appear reversed.
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Finest Detail

Depending on the Print Quality setting you make, you can select 
the Finest Detail check box to print text, solid graphics, and line 
art with very sharp edges. Finest Detail takes longer to print and 
increases your memory requirements. Also, you may not be able 
to print some larger images, and some patterns may not print 
correctly. If you experience problems printing in this mode, turn 
it off or add more memory.

Note:
Some settings may not be available, depending on the Media Type, Color, 
and Print Quality settings that you make.

When Advanced B&W Photo is selected as the Color setting 
in Print Settings

If you have not done so already, select Color Management from 
the pop-up menu. Here you can use the following tools to make 
detailed adjustments to your photos.
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Color Toning

Select one of the following settings.

Tone

Adjusts the tone by five levels.

Slide bars

The tone enhancement slide bars adjust the following options. 
Drag the slide bar to the right or left to adjust the settings. You 
can also enter a value in the boxes next to the slide bars.

Neutral Applies a standard color correction to black-and-white 
photos.

Cool Applies a cool tone to your photos.

Warm Applies a warm tone to your photos.

Sepia Applies a sepia tone to your photos.

Fine 
Adjustment

This appears when you change the Tone, adjust the 
settings using the slide bars or the color circle, or select 
the Highlight Point Shift check box.

Darkest Applies the softest tone to your photos.

Darker Applies a softer tone to your photos.

Dark Applies a soft tone to your photos.

Normal Applies a hard tone to your photos.

Light Applies a harder tone to your photos.

Brightness Adjusts the overall lightness and darkness within a range 
of -25 to +25.

Contrast Adjusts the difference between the bright and dark 
parts of your image within a range of -25 to +25.

Shadow 
Tonality

Adjusts the shadow tonality within a range of -25 to +25.
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Highlight Point Shift

Select this check box to add a little more ink to white areas to give 
it a glossy look.

Color circle

Click in the color circle to adjust the color tone of your 
black-and-white photo. You can also adjust the color tone by 
entering a value in the Horizontal and Vertical text boxes.

Default

Click the Default button to return the settings to their default 
values.

Color Management

Selecting Color Management from the pop-up menu gives you 
control over the color matching and adjustment methods 
provided with the printer driver. Use these settings to experiment 
with new printing ideas or to fine-tune a range of print settings 
to meet your individual needs.

Highlight 
Tonality

Adjusts the highlight tonality within a range of -25 to +25.

Max Optical 
Density

Adjusts the focus of the print. Create a soft focus print 
by setting the density to low within a range of -50 to 0.
166



Note:
The Color Management controls shown above are available when 
Color is selected as the Color setting in Print Settings.

Color Controls

Select this setting to use the color matching and adjustment 
methods provided with the printer driver.

Mode

Gamma

To control image contrast by modifying the midtones and 
mid-level grays.

Slide bars

The color enhancement slide bars adjust the indicated options in 
a range of -25% to +25%. Drag the slide bar to the right or left with 
your mouse to adjust the settings. You can also type a value from 
-25% to +25% in the boxes next to the slide bars.

ColorSync

Automatically adjusts the printout colors to match the colors on 
your monitor.

Off (No Color Adjustment)

Prints without any color adjustment.

EPSON Vivid Based on your data, enhances color balance for 
optimum print results. This setting is recommended for 
most print jobs. 

EPSON Standard 
(sRGB)

Provides output that closely matches the original 
data.

Adobe RGB Covers the full range of CMYK colors that this product 
can print. This setting is recommended for printing 
digital photos
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Expansion

Using the slider, you can control the amount of the image that 
extends beyond the edges of the paper during borderless printing.

For most print jobs, selecting Max is recommended in order to 
eliminate margins on all sides of the paper. Moving the slider 
towards Min decreases the amount of the image that extends 
beyond the edges of the paper; however, as this amount 
decreases, margins may begin to appear on one or more sides of 
the paper.

Extension Setting

Thick paper

Adjusts the size of the gap between the platen and the print head. 
Select this check box if your printouts are rubbed while printing.

Paper Configuration

Select Paper Configuration from the pop-up menu to access the 
Color Density and Drying Time per Print Head Pass slide bars. 
These allow you to make the following detailed paper settings.

Color Density

Use this to adjust the strength of color density when printing on 
non-EPSON media. You can adjust the density by dragging the 
scroll bar to the left or right, or by entering a value between -50 
and 50 in the text box.

Drying Time per Print Head Pass

Use this to add a waiting time when the print head reaches the 
end of every pass to allow the ink to dry. You can adjust the setting 
by dragging the scroll bar to the left or right, or by entering a value 
between 0 and 50 in the text box.
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Summary

Displays the list of current setting items.

Note:
Summary is the standard feature of Mac OS X. See your operating 
system’s documentation for details.

Preview Button

Allows you to see how your document will look before actually 
printing it.

Note:
Preview button is the standard feature of Mac OS X. See your operating 
system’s documentation for details.
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EPSON Printer Utility

Epson printer utility functions

Epson printer utilities allow you to check the current printer 
status and perform certain maintenance procedures from your 
computer.

EPSON 
StatusMonitor

Monitors the printer status. If it detects a printer 
error, it will inform you with an error message.

You can also use this utility to check how much ink 
is remaining before printing.

To use the EPSON StatusMonitor, click the EPSON 
StatusMonitor button.
& See “Using EPSON StatusMonitor” on page 240

Auto Nozzle Check 
and Cleaning

Prints nozzle check pattern and automatically 
checks print head nozzles. If they are clogged, 
performs head cleaning.
& See “Cleaning the Print Head” on page 252
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Nozzle Check Checks the print head nozzles for clogging. Check 
the nozzles if you notice print quality has declined 
and after cleaning, to confirm that the print head 
nozzles have been cleared. If the nozzle check 
indicates that the print head needs cleaning, you 
can access the Head Cleaning utility directly from 
the Nozzle Check utility.
& See “Checking the Print Head Nozzles” on page 
248

Head Cleaning The Head Cleaning utility cleans the print head. 
You may need to clean the print head if you notice 
print quality has declined. Use the Nozzle Check 
utility first to confirm that the print head needs to 
be cleaned.
& See “Cleaning the Print Head” on page 252

Print Head 
Alignment

The Print Head Alignment utility can be used to 
improve the print quality of your documents. The 
print head alignment may need to be adjusted if 
vertical lines appear out of alignment or if white, 
black, dark, or light banding appears in your 
documents. Follow the on-screen instructions for 
using this utility.
& See “Aligning the Print Head” on page 265
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For Mac OS 9

Printer Software Introduction

Printer driver dialog box

The printer software that comes with your printer includes a 
printer driver and printer utilities. The printer driver lets you 
choose from a wide variety of settings to get the best results from 
your printer. The printer utilities help you check the printer and 
keep it in top operating condition.

The printer driver dialog boxes are listed below.
& See “Page Setup Dialog Box” on page 173
& See “Print Dialog Box” on page 176
& See “Layout dialog box” on page 192
& See “Printer utilities” on page 193

Accessing the printer driver

For information on accessing the printer software, see the 
following.

“Accessing the printer software for Mac OS 9” on page 368

In addition to the printer software information in this guide, you 
can get more details by clicking the help icon in any of the dialog 
boxes in the printer software.

Getting more information

Online help provides more information about the printer 
software.
& See “Getting information through online help” on page 195
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Page Setup Dialog Box

Paper Size Select the paper size that you want to use. You can 
also add a custom paper size. To add your own 
paper size setting, see the following.

“Defining a custom paper size” on page 376

Paper Source Select Auto Sheet Feeder to Print on normal paper.

Select Roll Paper to print on roll paper.

Select Manual - Front to print on thick paper fed into 
the front manual feed slot.

Select Manual - Roll to print single sheets fed into the 
rear manual feed slot.
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Borderless Check this box when you want to print without 
margins.

This feature prints to all four edges of the paper.

Expansion button:
When the Borderless check box is selected, the 
Expansion button becomes available. Click the 
Expansion button to open the Borderless Expansion 
dialog box, where you can control the amount of 
the image that extends beyond the edges of the 
paper during borderless printing.

Borderless Expansion slider:
Using the slider on the Borderless Expansion dialog 
box, you can control the amount of the image that 
extends beyond the edges of the paper during 
borderless printing.

For most print jobs, selecting Max is recommended 
in order to eliminate margins on all sides of the 
paper. Moving the slider towards Min decreases the 
amount of the image that extends beyond the 
edges of the paper; however, as this amount 
decreases, margins may begin to appear on one or 
more sides of the paper.
& See “Borderless Printing” on page 66

Orientation Select Portrait (tall) or Landscape (wide) to change 
the orientation of your printout. 

Rotate by 180 degrees: Prints the pages rotated 180 
degrees.

Double-Sided 
Printing

Select the Double-Sided Printing check box to print 
on both sides of the paper. Select the Folded Booklet 
check box to make single-fold booklets.
& See “Double-Sided Printing” on page 75

Reduce or Enlarge Use this setting to reduce or enlarge the print size of 
your document between 25% and 400%.
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Roll Paper Option The Roll Paper Option settings are only available 
when Roll Paper is selected as the Paper Source 
setting. 

The available settings are described below. 

Banner:
Select this mode when you want to print multi-page 
data continuously rather than as individual pages. 
When this is selected, the Save roll paper check box 
is available. 

Cut sheet:
Select this mode when you want to print multi-page 
data as individual pages, rather than continuously. 
When this is selected, the Print page frame check 
box is available. 

Save roll paper:
Select this check box when you want to save roll 
paper. When this is selected, the blank portion of the 
last page of your document is not fed through the 
printer. 

Print page frame:
Select this check box to print a line on the roll paper 
between pages in a multi-page document, to 
indicate where the paper should be cut. This feature 
is useful when it is unclear where the page breaks 
should be.
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Print Dialog Box

Print Dialog Box

Basic settings

Copies 

Enter the number of copies that you want to print in the Copies 
text box.

Pages

Choose All or Range. If you select Range, enter the appropriate 
range of pages in the Range text boxes.

Media Type

Determines what other settings are available, so you should 
always make this setting first.

Select the Media Type setting that matches the paper that is 
loaded in the printer. To find out what media type you are using, 
find your media in the Media Type Settings list.

“Media type settings” on page 369
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Color

Mode

The Mode settings give you three levels of control over the printer 
software, as explained below.

Automatic mode

When Automatic is selected, the printer software takes care of 
all detailed settings based on the current Media Type and Color 
settings.

Note:
Depending on the media selected in the Media Type list (while 
Automatic is selected), a slider appears to the right of the Mode options, 
which lets you choose Quality, Speed, or a level in between. Select 
Quality when print quality is more important than speed.

Custom mode

Custom Settings
You can select your personalized settings from the list.

Color Print in color.

Advanced B&W 
Photo

Print photos in high quality black and white.

Black Print in grayscale.

Automatic Provides the quickest and easiest way to start 
printing.
& See “Automatic mode” on page 177 

Custom Lets you choose from a list of your personalized 
settings suited to the kind of document that you want 
to print. When Custom is selected, the Advanced 
button is available, allowing you to access the 
Advanced dialog box.
& See “Custom mode” on page 177
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Advanced Settings
You can create and save your own custom settings.
& See “Advanced settings” on page 178

When you select a custom setting, other settings, such as Print 
Quality and Color Management, are made automatically. 
Changes to these settings are reflected in the display at the left 
side of the Print dialog box.

Follow the steps below to select a custom setting.

1. Confirm that the Media Type and Color settings in the Print 
dialog box are correct.

2. Select Custom. This makes the Custom Settings list available 
to the right of the Mode settings.

3. From the Custom Settings list, select the most appropriate 
setting for the type of document or image that you want to 
print.

Advanced settings

The settings in the Advanced dialog box give you complete 
control over your printing environment. Use these settings to 
experiment with new printing ideas or to fine-tune a range of 
print settings to meet your individual needs. Once you are 
satisfied with your new settings, you can give them a name and 
add them to the Custom Settings list in the Print dialog box.
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To open the Advanced dialog box, select Custom and click 
Advanced.

Note:
❏ The PhotoEnhance feature only affects images, not text or graphs. 

For example, if Sepia is selected from the Tone list (available when 
PhotoEnhance is selected), only the images in a document will 
be printed in sepia. Any colored text or graphs in the same document 
will be printed in color.

❏ Some settings may not be available, depending on the Media Type, 
Color, and Print Quality settings that you make.

Media Type

Determines what other settings are available, so you should 
always make this setting first.

Select the Media Type setting that matches the paper that is 
loaded in the printer. To find out what media type you are using, 
find your media in the Media Type Settings list.

“Media type settings” on page 369
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Color

Print Quality

Select the desired setting from the Print Quality list.

Note:
The availability of the Print Quality setting depends on the Media Type 
setting. Therefore, make the Media Type setting before you set the Print 
Quality.

High Speed

This setting activates bidirectional printing so your printer prints 
both left-to-right and right-to-left. High Speed mode speeds up 
printing, but decreases print quality.

Mirror Image

Prints an image as it would appear in a mirror. Text and graphics 
appear reversed.

Finest Detail

Depending on the Print Quality setting you select, you can turn 
on Finest Detail to print text, solid graphics, and line art with very 
sharp edges. Finest Quality takes longer to print and increases 
your memory requirements. Also, you may not be able to print 
some larger images, and some patterns may not print correctly. If 
you experience problems printing in this mode, turn it off or add 
more memory.

Color Print in color.

Advanced B&W 
Photo

Print photos in high quality black and white.

Black Print in grayscale.
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Edge Smoothing

Improves the print quality of low-resolution images by 
smoothing jagged edges and lines. This setting has no effect on 
high-resolution images or on text.

Thick paper

Adjusts the size of the gap between the platen and print head. 
Select this check box if your printouts are rubbed while printing.

Color Management

Color Controls

For use with the color matching and image enhancement methods 
provided by the printer driver. When you select Color Controls, 
additional settings appear under Color Management, allowing 
you to select a Mode setting and to adjust the color enhancement 
sliders.

Gamma To control image contrast by modifying the midtones 
and mid-level grays.

Note:
This option appears only when Color Controls is 
selected.

Mode EPSON Vivid: Based on your data, enhances color 
balance for optimum print results. This setting is 
recommended for most print jobs.

EPSON Standard (sRGB): Provides output that closely 
matches the original data.

Adobe RGB: Covers the full range of CMYK colors that 
this product can print. This setting is recommended for 
printing digital photos.

Slide Bars The Color Adjustment slide bars adjust the options in a 
range of -25% to +25%. For details on each option, see 
the printer driver help.
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PhotoEnhance

This mode provides a variety of image correction settings that you 
can apply to your photos before printing. PhotoEnhance does not 
affect your original data.

Note:
Printing with PhotoEnhance selected may increase the time required 
for printing, depending on your computer system and the amount of data 
contained in your image.

Tone

You can select from the following settings.

Selecting PhotoEnhance also makes the Digital Camera 
Correction check box available. Selecting this check box makes 
the Smooth Skin check box available. Use this when you are 
printing photos taken with a digital camera to give your printed 
images the smooth, natural appearance of photographs taken 
with a film camera.

ColorSync

This mode automatically adjusts the printout colors to match the 
colors on your monitor. Selecting ColorSync displays the 
following two menus.

Auto Correct Applies Epson standard tone adjustment to your 
photos.

Sepia Applies a sepia tone to your photos.

Neutral Gray Applies a standard gray to your photos.

Warm Gray Applies a softer, warmer gray to your photos.

Cool Gray Applies a harder, cooler gray to your photos.
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Profile:

Matches the printout colors to the colors displayed on your 
monitor according to the information stored in the selected 
profile. EPSON Standard is a custom-designed profile that works 
with your printer.

Rendering Intent:

You can select from the following settings.

Off (No Color Adjustment)

This setting prints without any color adjustment.

Advanced B&W Photo:

To access the Advanced B&W Photo settings, select Advanced 
B&W Photo as the Color setting. 

Perceptual The most commonly used option for reproducing 
photographs.

Saturation The best option for reproducing vivid images. Use this 
setting for presentation graphics, such as charts and 
graphics.

Colorimetric The best option when exact matching of colors is 
most important. This mode automatically adjusts the 
printout colors to match the colors on your monitor. 
Use this setting for printouts like a company logo.
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Here you can use the following tools to make detailed 
adjustments to your photos.

Note:
Advanced B&W Photo is available depending on the ink cartridge 
installed (Photo Black or Matte Black), the media type setting, and the 
print quality setting. For most media types, select Best Photo or Photo 
RPM as the print quality setting.

Color Toning

Select one of the following settings.

Neutral Applies a standard color correction to black-and-white 
photos.

Cool Applies a cool tone to your photos.

Warm Applies a warm tone to your photos.

Sepia Applies a sepia tone to your photos.

Fine 
Adjustment

This appears when you change the Tone, adjust the 
settings using the slide bars or the color circle, or select 
the Highlight Point Shift check box.
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Tone

Adjusts the tone by five levels.

Slide Bars

The tone enhancement slide bars adjust the following options. 
Drag the slide bar to the right or left to adjust the settings. You 
can also enter a value in the boxes next to the slide bars.

Highlight Point Shift

Select this check box to add a little more ink to white areas to give 
it a glossy look.

Color circle

Click in the color circle to adjust the color tone of your 
black-and-white photo. You can also adjust the color tone by 
entering a value in the Horizontal and Vertical text boxes.

Darkest Applies the softest tone to your photos.

Darker Applies a softer tone to your photos.

Dark Applies a soft tone to your photos.

Normal Applies a hard tone to your photos.

Light Applies a harder tone to your photos.

Brightness Adjusts the overall lightness and darkness within a range 
of -25 to +25.

Contrast Adjusts the difference between the bright and dark 
parts of your image within a range of -25 to +25.

Shadow 
Tonality

Adjusts the shadow tonality within a range of -25 to +25.

Highlight 
Tonality

Adjusts the highlight tonality within a range of -25 to +25.

Max Optical 
Density

Adjusts the focus of the print. Create a soft focus print 
by setting the density to low within a range of -50 to 0.
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Default button

Click the default button to return the settings to their default 
values.

Paper Config

This mode allows you to make the following detailed paper 
settings.

Color Density

Use this to adjust the strength of color density when printing on 
non-EPSON media. You can adjust the density by dragging the 
scroll bar to the left or right, or by entering a value between -50 
and 50 in the text box.

Drying Time per Print Head Pass

Use this to add a waiting time when the print head reaches the 
end of every pass to allow the ink to dry. You can adjust the setting 
by dragging the scroll bar to the left or right, or by entering a value 
between 0 and 50 in the text box.

Save Settings

To save your Advanced settings in the Custom Settings list, click 
Save Settings in the Advanced dialog box. The Custom Settings 
dialog box appears.
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Type a unique name for your settings in the Name text box, then 
click Save. The name can contain a total of up to 16 letters and 
numerals. You can also use up to eight, double-byte characters; 
however, they may not be displayed correctly on the screen 
depending on your operating system settings. Your custom 
setting will be added to the Custom Settings list, and the latest 
custom setting will be selected. You can save up to 100 custom 
settings.

To delete a setting from the Custom Settings list, select it in the 
Custom Settings dialog box and click Delete.

Using your saved settings

To use your saved settings, select Custom as the Mode setting in 
the Print dialog box, then select your setting in the Custom 
Settings list.

If you change the Media Type, Color, or other settings on the 
Advanced menu and then click OK while one of your custom 
settings is selected in the Custom Settings list on the Basic menu, 
the selection shown in the list returns to Custom Settings. The 
custom setting that was previously selected is not affected by the 
change and remains in the list. To return to your custom setting, 
simply reselect it from the Custom Settings list.

If you delete a custom setting that was active when deleted or if 
it was the only custom setting, the Custom Settings list selection 
on the Basic menu returns to Custom Settings. To activate a 
remaining custom setting, simply select it from the Custom 
Settings list.

Setting the print time

You can specify the time when you want the printer to begin 
printing your document. Follow the steps below.
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1. Click the  Background Printing icon button in the Print 
dialog box.

2. Make the appropriate Background Printing setting.

3. Select Urgent, Normal, Print at, or Hold as the Print Time 
setting.

If you select Print at, use the arrows beside the date and time 
boxes to specify the date and time when you want the 
document to be printed.

Note:
Make sure that the computer and printer are turned on at the date 
and time you specify.

4. Click OK. The Background Printing dialog box closes.

5. In the Print dialog box, make sure that your print settings are 
as you want them, then click Print.
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Note:
You can check or change the priority of print jobs using the EPSON 
MonitorIV utility.
& See “Using EPSON MonitorIV” on page 245

Previewing your printout

The Preview feature allows you to see how your document will 
look before actually printing it. Follow these steps to preview 
your document.

1. Make your printer driver settings.

2. Click the  Preview icon button in the Print dialog box. The 
Print button changes into the Preview button.

Note:
Use the  Preview icon button to cycle through the  Print, 

Preview, and Save File modes. Click the icon button to select 
the mode that you want, and click the button to the right of the icon 
to use the mode you have selected.
& See “Saving spool data as a file” on page 191
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3. Click the Preview button. The Preview dialog box opens and 
displays a preview of your document.

The Preview dialog box contains several icon buttons that you 
can use to perform the following functions.

Icon Button name Function

Edit 
Watermark

Click to select, move, and resize 
watermarks.

Zoom Click to enlarge or reduce the size of 
the previewed page.

Show/Hide 
Printable Area

Click to display or hide the borderlines 
which indicate the printable area. 
The printer cannot print anything that 
is outside of this area.

Show/Hide 
Watermark 
Settings

Click to open the Watermark Edit 
dialog box, where you can add 
watermarks to the document and 
change any of the current 
watermark settings.
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4. If you are satisfied with the previewed image, click Print.

If you are not satisfied with the appearance of the image, click 
Cancel. The Preview and Print dialog boxes close with the 
current print settings preserved. Open the Print dialog box 
again to make additional changes to the print settings.

Saving spool data as a file

You can save spool data as a file using the  Save File icon button 
in the Print dialog box. This feature lets you use the saved spool 
data to print the document at a later time simply by 
double-clicking the saved file. Follow the steps below.

Note:
Use the  Preview icon button to cycle through the  Print, 

Preview, and  Save File modes. Click the icon button to select the 
mode you want, and click the button to the right of the icon to use the 
mode you have selected.

1. Make your printer driver settings.

2. Click the  Preview icon button in the Print dialog box 
repeatedly until the Print button changes into the SaveFile 
button.

Add page Click to add or remove selected 
pages from the list of pages to be 
printed.

Remove page
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3. Click the SaveFile button. The following dialog box appears.

4. Select the location where you want to save the file, then type 
a file name in the Save As text box and click Save.

5. When you want to print the document, double-click the file 
to open EPSON MonitorIV, make sure that the correct 
document is selected, then click the  Resume button to send 
the data to the printer.

Layout dialog box

You can modify the page layout of your document using the 
printer driver settings located in the Layout dialog box. To open 
this dialog box, click Print on the File menu of your application, 
then click the  Layout icon button in the Print dialog box.
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Printer utilities

Epson printer utilities allow you to check the current printer 
status and maintain certain features of your printer from your 
computer.

Fit to Page Enlarges or reduces the size of the image to make it fit 
a selected paper size. Select the Fit to Page check 
box, and then select the paper size in the Output 
Paper Size list.
& See “Fit to Page Printing” on page 91

Watermark Prints a text or image as a watermark on your printout.
& See “Watermark Printing” on page 114

Multi-Page Allows you to choose between the Pages Per Sheet 
and Poster settings.

Pages Per Sheet

Select this setting to print two or four pages of your 
document on one sheet of paper.
& See “Pages Per Sheet Printing” on page 96

Poster

A single document page can be enlarged to cover 4, 
9, or 16 printed sheets of paper. Select Poster to print 
a poster-size image.
& See “Poster Printing” on page 105

Print order Select Collate to print one complete document set at 
a time. Select Reverse Order to print your documents 
in reverse order, starting with the last page.
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To use the utilities, click the  Utility icon button in the Print or 
Page Setup dialog box, then click the button for the utility that 
you want to use.

EPSON 
StatusMonitor

Monitors the printer status. If it detects a printer error, 
it will inform you with an error message.

You can also use this utility to check how much ink 
is remaining before printing.

To use the EPSON StatusMonitor, click the 
EPSON StatusMonitor button.
& See “Using EPSON StatusMonitor” on page 242

Auto Nozzle 
Check and 
Cleaning

Prints nozzle check pattern and automatically 
checks print head nozzles. If they are clogged, 
performs head cleaning.
& See “Cleaning the Print Head” on page 252

Nozzle Check Checks the print head nozzles for clogging. Check 
the nozzles if you notice print quality has declined 
and after cleaning to confirm that the print head 
nozzles have been cleared. If the nozzle check 
indicates that the print head needs cleaning, you 
can access the Head Cleaning utility directly from 
the Nozzle Check utility.
& See “Checking the Print Head Nozzles” on page 
248
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Getting information through online help

Your printer software has an extensive online help feature that 
provides you with instructions on printing, making printer driver 
settings, and using the printer utilities.

To access online help, choose Print or Page Setup from the File 
menu of your application. Then, click the  Help icon button.

Head Cleaning Cleans the print head. You may need to clean the 
print head if you notice print quality has declined. 
Use the Nozzle Check utility first to confirm that the 
print head needs to be cleaned.
& See “Cleaning the Print Head” on page 252

Print Head 
Alignment

The Print Head Alignment utility can be used to 
improve the print quality of your documents. The 
print head alignment may need to be adjusted if 
vertical lines appear out of alignment or if white, 
black, dark, or light banding appears in your 
documents. Follow the on-screen instructions for 
using this utility.
& See “Aligning the Print Head” on page 265

Configuration Click this button to open the Configuration dialog 
box, where you can change the method by which 
the EPSON Status Monitor utility notifies you when the 
printer status changes.
& See “Using the Configuration Settings dialog box” 
on page 243
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Chapter 4

Using Your Software

Software Information

Printer Driver (and Status Monitor 3)

User’s Guide

EPSON EasyPrintModule

EPSON EasyPrintModule works along with your software to 
provide easy access to your print settings.

The printer driver is the software that allows 
you to adjust printer settings. In the printer 
settings window, you can specify options 
such as paper type or paper size.

Your User’s Guide describes your printer 
features and provides step-by-step 
instructions for using them. It also tells you 
how to maintain your printer, solve any 
problems you may encounter, and contact 
customer support, if necessary.
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EPSON Web-To-Page (For Windows Only)

EPSON Easy Photo Print

EPSON Darkroom Print

EPSON Web-To-Page makes printing web 
pages easier by sizing them to fit your paper 
and giving you a preview of your printed 
output. You can easily select it from your 
Microsoft Internet Explorer toolbar after 
installing software.

EPSON Easy Photo Print lets you lay out and 
print digital images on various kinds of 
paper. The step-by-step instructions in the 
window let you preview the printed images 
and get the effects you want without having 
to make any difficult settings.

Using EPSON Darkroom Print is like having 
your own darkroom. This software provides 
detailed layout and color settings that let 
you create professional looking photos. 
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EPSON RAW Print (For Windows XP and 2000 Only)

EPSON Creativity Suite

Overview of EPSON Creativity Suite

The EPSON Creativity Suite is a group of programs that let you 
scan, save, manage, edit, and print your images. Using the main 
program, EPSON File Manager, you can display your images in 
an easy-use window.

From EPSON File Manager, you can select multiple images and 
print them, attach them to an e-mail message, or open them in a 
photo editing program. 

EPSON RAW Print lets you process, view, and 
print RAW data.

The EPSON Creativity Suite is a group of 
programs that let you scan, save, manage, 
edit, and print your images. Using the main 
program, EPSON File Manager, you can 
scan and save your images, and then 
display them in an easy-use window. From 
there you can print them, attach them to an 
e-mail message, or open them in an 
image-editing program.
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Note:
When you install the software from the CD that came with your printer, 
all of the applications are automatically installed on your computer. For 
more information on installing software, see the Start Here sheet that 
came with your printer.

The following sections describe the applications and how to 
access them.

EPSON File Manager

Use EPSON File Manager to:

❏ Retrieve images from a scanner, digital camera, or memory 
card and send the files directly to the application you want to 
use

❏ View supported images as thumbnails

❏ View the various applications you can use as project icons in 
the launch area

❏ Search for images on your hard disk
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❏ View images as a slideshow

❏ Retouch images 

Starting EPSON File Manager

There are three ways to start EPSON File Manager:

❏ Double-click the EPSON File Manager icon on the desktop.

❏ Drag and drop images or a folder to the EPSON File Manager 
icon on the desktop.

❏ For Windows
Click Start, point to All Programs (Windows XP) or Programs 
(Windows Me, 98, or 2000), point to EPSON Creativity Suite, 
point to File Manager, and then click EPSON File Manager.
For Mac OS X
Double-click the Applications folder in Macintosh HD, then 
double-click the EPSON folder. Next, double-click the 
Creativity Suite folder, File Manager folder, and finally 
double-click the EPSON File Manager for X icon.

Click Next when the confirmation message for Instructions is 
displayed. The Instructions appear.

If you check Do Not Show Next Time, the confirmation message 
will not be displayed the next time you start the EPSON File 
Manager.

For more information, select User’s Guide from the Help menu 
in this application.
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Printing Photos the Easy Way

EPSON Easy Photo Print lets you lay out and print digital images 
on various kinds of paper. The step-by-step instructions in the 
window let you preview the printed images and get the effects 
you want without having to make any difficult settings.

❏ Using the Custom Print function, you can perform one-click 
printing with the settings you select.

❏ Using layout or P.I.F. Frames, you can make calendars or 
greeting cards.

❏ If your photo files have DPOF (Digital Print Order Format) 
information, DPOF Print starts automatically. 

Starting EPSON Easy Photo Print

There are two ways to access EPSON Easy Photo Print:

❏ Double-click the EPSON File Manager icon on the desktop, 
select the images to use, then click the Easy Photo Print icon 
in the upper part of the EPSON File Manager window.
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❏ For Windows:
Click Start, point to All Programs (Windows XP) or Programs 
(Windows Me, 98, or 2000), point to EPSON Creativity Suite, 
then click EPSON Easy Photo Print.
For Mac OS X:
Double-click the Applications folder in Macintosh HD, then 
double-click the EPSON folder. Next, double-click the 
Creativity Suite folder, Easy Photo Print folder, and finally 
double-click the EPSON Easy Photo Print for X icon.

For more information, select User’s Guide from the Help menu 
in this application.

Creating Professional Looking Photos

Using EPSON Darkroom Print is like having your own darkroom. 
This software provides detailed layout and color settings that let 
you create professional looking photos. You can make subtle color 
adjustments by previewing and printing a sample sheet, and then 
choosing the best sample to print.
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Starting EPSON Darkroom Print

There are two ways to access EPSON Darkroom Print. 

❏ Double-click the EPSON File Manager icon on the desktop, 
select the images to use, then click the Advanced Photo Print 
icon in the upper part of the EPSON File Manager window.

❏ For Windows:
Click Start, point to All Programs (Windows XP) or Programs 
(Windows Me, 98, or 2000), point to EPSON Creativity Suite, 
then click EPSON Darkroom Print.
For Mac OS X:
Double-click the Applications folder in Macintosh HD, then 
double-click the EPSON folder. Next, double-click the 
Creativity Suite folder, Darkroom Print folder, and finally 
double-click the EPSON Darkroom Print for X icon.

For more information, select User’s Guide from the Help menu 
of this application.

Printing RAW format file images
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EPSON RAW Print lets you print photos from a supported digital 
camera in the RAW file format.

Note:
This software is for Windows XP and 2000 only.

Starting EPSON RAW Print

Make sure that EPSON Easy Photo Print software in EPSON 
Creativity Suite is already installed. You need EPSON Easy Photo 
Print to use EPSON RAW Print.

Click Start, point to All Programs (Windows XP) or Programs 
(Windows 2000), point to EPSON RAW Print, then click EPSON 
RAW Print.

For more information, select User’s Guide from the Help menu 
of this application.

Attaching Images to E-mail
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Attach To Email lets you send e-mail with images. It supports 
various e-mail systems and allows you to resize images before 
attaching them.

Starting EPSON Attach to E-mail

There are two ways to access EPSON Attach to E-mail:

❏ Double-click the EPSON File Manager icon on the desktop, 
then click the Attach to e-mail icon in the upper part of the 
EPSON File Manager window.

❏ For Windows:
Click Start, point to All Programs (Windows XP) or Programs 
(Windows Me, 98, or 2000), point to EPSON Creativity Suite, 
then point to EPSON Attach To Email, and then click EPSON 
Attach To Email.
For Mac OS X:
Double-click the Applications folder in Macintosh HD, then 
double-click the EPSON folder. Next, double-click the 
Creativity Suite folder, and then the Attach To Email folder. 
Finally double-click the EPSON Attach To Email icon.

Printing Web Pages to Fit to Your Paper Size

EPSON Web-To-Page lets you can make Web pages fit to your 
paper size when printing. You can also see a preview before 
printing.
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Note:
This software is for Windows only.

Accessing EPSON Web-To-Page

After you install EPSON Web-To-Page, the menu bar is displayed 
on the Microsoft Internet Explorer Toolbar. If it does not appear, 
select Toolbars from the View menu of Internet Explorer, and 
then select EPSON Web-To-Page.
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EPSON Easy Print Module

EPSON Easy Print Module lets you make paper settings in 
EPSON application software. This module is automatically 
installed on your computer when you install the other software.

Note:
The latest version of the module can be downloaded from the EPSON 
web site.

Uninstalling Creativity Suite Applications

You can uninstall applications you don’t need. Follow the steps 
below.

For Windows

Note:
❏ To uninstall applications in Windows XP, you must log on to a 

Computer Administrator account. You cannot uninstall 
applications if you log on as a limited user.

❏ To uninstall applications in Windows 2000, you must log on as a 
user with administrative privileges (belonging to the 
Administrator’s group).

1. In Windows XP, click Start, then select Control Panel. In 
Windows Me, 98, or 2000, click Start, point to Settings, then 
select Control Panel.

2. Double-click the Add or Remove Programs icon.

3. Choose the software you want to uninstall from the list of 
programs.
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4. Click Change/Remove in Windows XP or 2000, or 
Add/Remove in Windows Me or 98.

5. When the confirmation message appears, click Yes.

6. Follow the on-screen instructions.

For Mac OS X 

Note:
❏ To uninstall applications you must log on to a Computer 

Administrator account. You cannot uninstall applications if you log 
on as a Limited account user.

❏ Depending on the application, the Installer may be separated from 
the Uninstaller.

1. Insert the software CD into the CD-ROM drive. The EPSON 
software CD opens automatically.

2. Open the application folder to uninstall, then double-click 
your language folder if necessary. 

3. Double-click the Installer or Uninstaller icon. If the 
Authenticate dialog box appears, enter the Password or 
phrase. Then follow the on-screen instructions.
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Chapter 5

Replacing Ink Cartridges

Replacing an Empty Ink Cartridge

This printer uses ink cartridges equipped with IC chips. The IC 
chip accurately monitors the amount of ink used by each 
cartridge, so even if a cartridge is removed and later reinserted, 
all of its ink can be used. However, some ink is consumed each 
time the cartridge is inserted because the printer automatically 
checks reliability.

You can replace an ink cartridge using the printer’s control panel 
or using the EPSON Status Monitor utility. Refer to the 
appropriate section below for instructions.

w
Warning:
❏ Keep ink cartridges out of the reach of children. Do not allow 

children to drink from or otherwise handle the cartridges.

❏ Be careful when you handle the used ink cartridges, as there 
may be some ink around the ink supply port. If ink gets on 
your skin, wash the area thoroughly with soap and water. If 
ink gets into your eyes, flush them immediately with water. 
If discomfort or vision problems continue after a thorough 
flushing, see a doctor immediately.
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c
Caution:
❏ Epson recommends the use of genuine Epson ink cartridges. 

Other products not manufactured by Epson may cause 
printer damage that is not covered by Epson's warranties.

❏ Leave the old cartridge installed in the printer until you have 
obtained a replacement; otherwise, ink remaining in the print 
head nozzles may dry out.

❏ Do not refill the ink cartridges. The printer calculates the 
amount of ink remaining using an IC chip on the ink 
cartridge. Even if the cartridge is refilled, the amount of ink 
remaining will not be recalculated by the IC chip and the 
amount of ink available for use will not change.

Note:
❏ You cannot continue printing with one ink cartridge empty, even if 

the other cartridges still contains ink. Before printing, replace the 
empty cartridge.

❏ In addition to the ink used during document printing, ink is 
consumed during the print head cleaning operation, during the 
self-cleaning cycle (performed when the printer is turned on), and 
during ink charging when the ink cartridge is installed in the 
printer.

For more information about ink cartridges, see the section below.
& See “When handling the ink cartridges” on page 17

Using the printer's control panel buttons

The printer’s lights will inform you when it is time to obtain a 
replacement ink cartridge and when it is time to replace an empty 
cartridge.
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This table describes the status of the lights on your printer and 
the required actions you need to take.

O = on, F = flashing

To replace an ink cartridge using the H ink button, follow the steps 
below.

Note:
The illustrations show replacement of the light light black ink cartridge. 
Replace the ink cartridge appropriate to your situation.

1. Make sure that the printer is on. The P power light should be 
on, but not flashing.

2. Open the top printer cover.

Note:
Do not replace the black (photo black/matte black) ink cartridges 
during printing as an ink error occurs.

Lights Action

F H Obtain a replacement light light black (T0599), light 
magenta (T0596), light cyan (T0595), light black (T0597), 
photo black (T0591), matte black (T0598), cyan (T0592), 
magenta (T0593), or yellow (T0594) ink cartridge.

O H Replace the empty ink cartridge.
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3. Press the H ink button. The print head moves to the ink 
cartridge replacement position and the P power light begins 
to flash. If the ink in the cartridge is low, it is indicated by a 
flashing ink out light just above the ink cartridge. If the ink 
cartridge is empty, it is indicated by a lit ink out light just 
above the ink cartridge.

Note:
❏ If an ink cartridge is low, you may continue to use it until it is 

empty. To confirm the level of ink remaining in each cartridge, 
see the following.
& See Using EPSON Status Monitor 3 for Windows
& See “Using EPSON StatusMonitor” on page 242 for 
Macintosh

❏ Do not press the H ink button for more than three seconds. 
Otherwise the printer starts cleaning the print head.

c
Caution:
Do not move the print head by hand, as this may damage the 
printer. Always press the H ink button to move it.
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4. For best results, shake the ink cartridge four or five times 
before opening the package.

5. Remove the new ink cartridge from the package.

c
Caution:
❏ Be careful not to break the hooks on the side of the ink 

cartridge when you remove it from the package.

❏ Do not remove or tear the label on the cartridge; 
otherwise, ink will leak.

❏ Do not touch the green IC chip on the side of the 
cartridge. This can damage the ink cartridge.

Do not touch this part.
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❏ If an ink cartridge is temporarily removed from the 
printer, be sure to protect the ink supply port of the ink 
cartridge from dirt and dust; store it in the same 
environment as the printer. Store ink cartridge with its 
label facing upward. Do not store cartridge upside down. 
Note that there is a valve in the ink supply port, making 
covers or plugs unnecessary, but care is needed to 
prevent the ink from staining items that the cartridge 
touches. Do not touch the ink supply port or surrounding 
area.

❏ Be sure to always install an ink cartridge into the printer 
immediately following the removal of the current ink 
cartridge. If the ink cartridge is not installed promptly, 
the print head may dry out, rendering it unable to print.

6. Open the cartridge cover. Pinch the ends of the ink cartridge 
that you want to replace.

7. Lift the cartridge out of the printer and dispose of it properly. 
Do not take the used cartridge apart or try to refill it.

The illustration 
shows 
replacement of 
the light light black 
ink cartridge.
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8. Place the new ink cartridge vertically into the cartridge 
holder. Then, push the ink cartridge down until it clicks into 
place. When you are finished replacing the cartridge, close the 
cartridge cover and the top printer cover.

9. Press the H ink button. The printer moves the print head and 
begins charging the ink delivery system. This process takes 
about one minute to complete. When the ink charging process 
is finished, the printer returns the print head to its home 
position. The P power light stops flashing and remains on, 
and the H ink error light goes out.
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c
Caution: 
The P power light continues to flash while the printer 
performs the ink charging operation. Never turn off the 
printer while this light is flashing. Doing so can result in 
incomplete charging of ink.

Note:
If the ink end error occurs after the print head moves to its home 
position, the ink cartridge may not be installed properly. Press the 
H ink button again, and reinstall the ink cartridge until it clicks into 
place.

Using the EPSON Status Monitor

You can monitor the remaining ink levels from your computer 
and view on-screen instructions for replacing a low or empty ink 
cartridge using EPSON Status Monitor 3 (Windows) or 
EPSON StatusMonitor (Macintosh).

When an ink cartridge is low or empty, click How to in the EPSON 
Status Monitor window. Follow the on-screen instructions to 
replace the cartridge.

For more information on using EPSON Status Monitor, see the 
section below.
& See “Using EPSON Status Monitor 3” on page 238 for Windows
& See “Using EPSON StatusMonitor” on page 242 for Macintosh

Replacing an Ink Cartridge

In some circumstances, you may need to replace an ink cartridge 
before it is empty.
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If the H ink error light is flashing or is on, replace the empty ink 
cartridge as described in the section below.
& See “Replacing an Empty Ink Cartridge” on page 209

To replace an ink cartridge before the H ink error light flashes or 
the EPSON Status Monitor notifies you that the cartridge is 
empty, follow the instructions in this section.

You can replace an ink cartridge using the printer’s control panel.

w
Warning:
❏ Keep ink cartridges out of the reach of children. Do not allow 

children to drink from or otherwise handle the cartridges.

❏ Be careful when you handle the used ink cartridges, as there 
may be some ink around the ink supply port. If ink gets on 
your skin, wash the area thoroughly with soap and water. If 
ink gets into your eyes, flush them immediately with water. 
If discomfort or vision problems remain after a thorough 
flushing, see a doctor immediately.

c
Caution:
❏ Epson recommends the use of genuine Epson ink cartridges. 

Other products not manufactured by Epson may cause 
damage to your printer not covered by Epson’s warranties.

❏ Leave the old cartridge installed in the printer until you have 
obtained a replacement; otherwise, ink remaining in the print 
head nozzles may dry out.

❏ Do not refill the ink cartridges. The printer calculates the 
amount of ink remaining using an IC chip on the ink 
cartridge. Even if the cartridge is refilled, the amount of ink 
remaining will not be recalculated by the IC chip and the 
amount of ink available for use will not change.
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Note:
❏ You cannot continue printing with one ink cartridge empty, even if 

the other cartridge still contains ink. Before printing, replace the 
empty cartridge.

❏ In addition to the ink used during document printing, ink is 
consumed during the print head cleaning operation, during the 
self-cleaning cycle which is performed when the printer is turned 
on, and during ink charging when the ink cartridge is installed in 
the printer.

Using the printer’s control panel buttons

c
Caution:
Do not remove the cartridge from the printer until you are ready 
to replace it with another.

Note:
The illustrations show replacement of the light light black ink cartridge. 
Replace the ink cartridge appropriate to your situation.

1. Make sure that the printer is on. The P power light should be 
on, but not flashing.

2. For best results, shake the ink cartridge four or five times 
before opening the package.

3. Remove the new ink cartridge from the package.
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c
Caution:
❏ Be careful not to break the hooks on the side of the ink 

cartridge when you remove it from the package.

❏ Do not remove or tear the label on the cartridge; 
otherwise, ink will leak.

❏ Do not touch the green IC chip on the side of the 
cartridge. This can damage the ink cartridge.

❏ If an ink cartridge is temporarily removed from the 
printer, be sure to protect the ink supply port of the ink 
cartridge from dirt and dust; store it in the same 
environment as the printer. Store ink cartridge with its 
label facing upward. Do not store cartridge upside down. 
Note that there is a valve in the ink supply port, making 
covers or plugs unnecessary, but care is needed to 
prevent the ink from staining items that the cartridge 
touches. Do not touch the ink supply port or surrounding 
area.

❏ Be sure to always install an ink cartridge into the printer 
immediately following the removal of the current ink 
cartridge. If the ink cartridge is not installed promptly, 
the print head may dry out, rendering it unable to print.

4. Open the top printer cover.

Do not touch this part.
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5. Press the H ink button. The print head moves to the ink 
cartridge replacement position, and the P power light begins 
to flash.

Note:
Do not press the H ink button over three seconds. Otherwise the 
printer starts cleaning the print head.

c
Caution:
Do not move the print head by hand, as this may damage the 
printer. Always press the H ink button to move it.

6. Open the cartridge cover. Pinch the sides of the ink cartridge 
that you want to replace, then lift the cartridge out of the 
printer and dispose of it properly.

The illustration 
shows 
replacement of 
the light light 
black ink 
cartridge.
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w
Warning:
If ink gets on your hands, wash them thoroughly with soap 
and water. If ink gets into your eyes, flush them immediately 
with water. If discomfort or vision problems continue after a 
thorough flushing, see a doctor immediately.

7. Place the ink cartridge vertically into the cartridge holder. 
Push the ink cartridge down until it clicks into place. When 
you are finished replacing the cartridge, close the cartridge 
cover and the printer cover.

8. Press the H ink button. The print head moves, the ink delivery 
system begins to charge. The charging process takes about one 
minute to complete. When this process is finished, the print 
head returns to its home position and the P power light stops 
flashing.
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c
Caution:
The P power light continues to flash while the printer 
performs the ink charging operation. Never turn off the 
printer while this light is flashing. Doing so can result in 
incomplete charging of ink.

Note:
If the ink end error occurs after the print head moves to its home 
position, the ink cartridge may not be installed properly. Press the 
H ink button again, and reinstall the ink cartridge until it clicks into 
place.

Changing the Black Ink Cartridges to Suit the 
Paper Type

This printer uses 8 ink cartridges that are packaged with the 
printer. There is also an extra cartridge, the Matte Black ink 
cartridge, which you can use instead of the Photo Black ink 
cartridge for printing on thick paper. Change the ink cartridge 
according to your printing needs. To replace the ink cartridge, see 
the following section.
& See “Replacing Ink Cartridges” on page 209.
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Possible ink combination.

Ink Setting Position (from the left)

Recom-
mended 
paper

1 2 3 4 5 6 7 8

Plain Paper

Premium 
Glossy 
Photo 
Paper

Premium 
Luster 
Photo 
Paper

Premium 
Semigloss 
Photo 
Paper

Proofing 
Paper 
Semimatte

Light 
Light 
Black

Light 
Ma-
genta

Light 
Cyan

Light 
Black

Photo 
Black

Cyan Ma-
genta

Yel-
low
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Note:
The availability of special media varies by location.

Archival 
Matte 
Paper

Matte 
Paper - 
Heavy-
weight

Double-
Sided 
Matte 
Paper

UltraS-
mooth Fine 
Art Paper

Plain Paper

Photo 
Quality Ink 
Jet Paper

Photo 
Quality Self 
Adhesive 
Sheet

Watercolor 
Paper - 
Radiant 
White

Velvet Fine 
Art Paper

Matte 
Black
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c
Caution:
❏ Do not install the ink cartridges in a combination not listed 

above.

❏ You can only change the fourth ink cartridge from the right.

Replacing an ink cartridge

Note:
Replace the ink cartridges only when it is necessary. After replacing the 
ink cartridge, the printer consumes some ink from all the colors to clean 
the print head.

Here is how to replace the photo black ink cartridge with the matte 
black ink cartridge as an example.

1. Make sure that the printer is on. The P power light should be 
on, but not flashing.

2. Open the top printer cover.

3. Press the H ink button. The print head moves to the ink 
cartridge replacement position, and the P power light begins 
to flash.
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Note:
Do not press the H ink button over three seconds. Otherwise the 
printer starts cleaning the print head.

c
Caution:
Do not move the print head by hand, as this may damage the 
printer. Always press the H ink button to move it.

4. Open the cartridge cover. Pinch the sides of the photo black 
ink cartridge, and then lift the cartridge out of the printer.

Note:
Do not replace the black (photo black or matte black) ink cartridges 
during printing as an ink error occurs.

The illustration 
shows 
replacement of 
the black (photo 
black or matte 
black) ink 
cartridge.
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w
Warning:
If ink gets on your hands, wash them thoroughly with soap 
and water. If ink gets into your eyes, flush them immediately 
with water. If discomfort or vision problems continue after a 
thorough flushing, see a doctor immediately.

c
Caution:
❏ Be careful not to break the hooks on the side of the ink 

cartridge when you remove it from the package.

❏ Do not remove or tear the label on the cartridge; 
otherwise, ink will leak.

❏ Do not touch the green IC chip on the side of the 
cartridge. This can damage the ink cartridge.

❏ If an ink cartridge is temporarily removed from the 
printer, be sure to protect the ink supply port of the ink 
cartridge from dirt and dust; store it in the same 
environment as the printer. Store ink cartridge with its 
label facing upward. Do not store cartridge upside down. 
Note that there is a valve in the ink supply port, making 
covers or plugs unnecessary, but care is needed to 
prevent the ink from staining items that the cartridge 
touches. Do not touch the ink supply port or surrounding 
area.

❏ Be sure to always install an ink cartridge into the printer 
immediately following the removal of the current ink 
cartridge. If the ink cartridge is not installed promptly, 
the print head may dry out, rendering it unable to print.

Do not touch this part.
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5. Place the ink cartridge vertically into the cartridge holder. 
Push the ink cartridge down until it clicks into place. When 
you are finished replacing the cartridge, close the cartridge 
cover and the top printer cover.

6. Press the H ink button. The print head moves and the ink 
delivery system begins to charge. The charging process takes 
about one minute to complete. When this process is finished, 
the print head returns to its home position and the P power 
light stops flashing.

c
Caution:
The P power light continues to flash while the printer 
performs the ink charging operation. Never turn off the 
printer while this light is flashing. Doing so can result in 
incomplete charging of ink.
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Note:
❏ If the ink end error occurs after the print head moves to its home 

position, the ink cartridge may not be installed properly. Press 
the H ink button again, and reinstall the ink cartridge until it 
clicks into place.

❏ After changing the black ink cartridge, it takes about thirty 
seconds before the printer is ready to print. During this time, 
the printer performs an automatic head cleaning.

Setting the ink cartridge information

After replacing an ink cartridge, make sure the driver setting for 
the ink cartridge is correct.

For Windows users

1. For Windows Me, 2000, and 98 users, click Start, point to 
Settings, then click Printers.

For Windows XP users, click Start, then click Control Panel, 
then click Printers and Other Hardware. Then click Printers 
and Faxes.

2. For Windows Me and 98 users, select your printer, then click 
Properties on the File menu. For Windows XP and 2000 users, 
select your printer, then click Printing Preferences on the File 
menu.
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3. Click the Maintenance tab, then click the Printer and 
Option Information button.

4. Confirm if the appropriate ink cartridge is selected.
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For Macintosh users

For Mac OS X

Click the EPSON Printer Utility icon in the Applications folder in 
the Macintosh HD. Select your printer from the printer list. Then 
double-click the EPSON StatusMonitor icon. Click the Update 
button. The driver setting for the ink cartridge is updated.

For Mac OS 9

Choose Chooser from the Apple menu and click the icon for your 
printer. The driver setting for the ink cartridge is updated.

Checking the Ink Supply

For Windows

You can check the amount of ink remaining in the ink cartridges 
using EPSON Status Monitor 3 or the progress meter. Refer to the 
appropriate section below for details.

EPSON Status Monitor 3

Access EPSON Status Monitor 3 in one of the following ways.
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❏ Double-click the printer-shaped shortcut icon on your 
Windows taskbar. To add a shortcut icon to the taskbar, see 
the section below.
& See “Monitoring Preferences” on page 153

❏ Open the printer software, click the Maintenance tab, then 
click the Status Monitor 3 button.

A graphic displays the remaining amount of ink.

Note:
❏ If any of the ink cartridges installed in the printer is broken, 

incompatible with the printer model, or improperly installed, 
EPSON Status Monitor 3 will not display an accurate calculation 
for the amount of ink remaining in any of the ink cartridges. Be sure 
to replace or reinstall any ink cartridge indicated by 
EPSON Status Monitor 3.

❏ Make sure that the correct ink cartridge is displayed after replacing 
the photo black or matte black cartridges. If it is not displayed 
correctly, set the information manually. For more information see 
the following section. 

“Setting the ink cartridge information” on page 229
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Progress meter

The progress meter dialog box appears automatically when you 
send a print job to the printer. You can check the remaining 
amount of ink from this dialog box.

For Macintosh

You can check the amount of ink remaining in the ink cartridges 
using EPSON StatusMonitor. Follow the steps below.

For Mac OS X

1. Double-click Macintosh HD (the default hard disk name), 
double-click the Applications folder, then double-click the 
EPSON Printer Utility icon. The Printer List window appears.

2. Select your printer, then click OK. The EPSON Printer Utility 
dialog box appears.
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3. Click the EPSON StatusMonitor button. The 
EPSON StatusMonitor dialog box appears.

Note:
❏ The graphic displays the amount of ink that remained when 

EPSON StatusMonitor was first opened. To update the ink-level 
information, click Update.

❏ If any one of the ink cartridges that are installed in the printer is 
broken, incompatible to the printer model, or is installed improperly, 
the EPSON StatusMonitor does not display an accurate calculation 
for the amount of ink remaining in any of the ink cartridges. Be sure 
to replace or reinstall any ink cartridge when indicated by the 
EPSON StatusMonitor.

Make sure that the correct ink cartridge is displayed after 
replacing the photo black or matte black cartridges.

For Mac OS 9

1. Access the Print or Page Setup dialog box

“Accessing the printer software for Mac OS 9” on page 368
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2. Click the Utility icon button, then click the 
EPSON StatusMonitor button in the Utility dialog box.

A graphic displaying the remaining amount of ink appears.

Note:
❏ The graphic displays the amount of ink that was remaining 

when EPSON StatusMonitor was first opened. To update the 
ink-level information, click Update.

❏ If any one of the ink cartridges that are installed in the printer 
is broken, incompatible to the printer model, or is installed 
improperly, the EPSON StatusMonitor will not display an 
accurate calculation for the amount of ink remaining in any of 
the ink cartridges. Be sure to replace or reinstall any ink 
cartridge when indicated by the EPSON StatusMonitor.

Make sure that the correct ink cartridge is displayed after 
replacing the photo black or matte black cartridges. If it is not 
displayed correctly, set the information manually. For more 
information see the following section. 

“Setting the ink cartridge information” on page 229
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Chapter 6

Improving Print Quality

Checking the Printer Status

For Windows

Using the progress meter

When you send a print job to the printer, the progress meter 
appears, as shown in the illustration below.

The progress meter indicates the progress of the current print job 
and provides printer status information when bidirectional 
communication between the printer and the computer is 
established. This meter also displays error messages as well as 
helpful tips for better printing. Refer to the appropriate section 
below.
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Epson Printing Tips

Tips for getting the most out of your Epson printer software 
appear in the text box at the bottom of the progress meter window. 
A new tip appears every 30 seconds. For more details on the tip 
displayed in the window, click the Details button.

Error messages

If a problem occurs during printing, an error message appears in 
the text box at the top of the progress meter window. For more 
detailed information, click Technical Support to access the 
online User's Guide.

When the ink runs low or out, a How to button appears below 
the text box. Click How to, and EPSON Status Monitor 3 will lead 
you step-by-step through the cartridge replacement procedure.
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Using EPSON Spool Manager

EPSON Spool Manager is similar to Windows Print Manager. If 
it receives two or more print jobs at one time, it holds them in the 
order that they were received (with printers on a network, this 
may be called a print queue). When a print job reaches the top of 
the line, EPSON Spool Manager sends the job to the printer. From 
the spool manager, you can view print status information about 
the print jobs that have been sent to your printer. You can also 
cancel, pause, and resume selected print jobs.

Note:
EPSON Spool Manager is not available with Windows XP and 2000.

After you send a print job, an EPSON Stylus Photo R2400 button 
appears on the taskbar. Click this button to open 
EPSON Spool Manager.

Using EPSON Status Monitor 3

EPSON Status Monitor 3 displays detailed information on the 
printer status.

Accessing EPSON Status Monitor 3

There are two ways to access EPSON Status Monitor 3:

❏ Double-click the printer-shaped shortcut icon on the 
Windows taskbar.
& See “Monitoring Preferences” on page 153
238 Improving Print Quality



6

6

6

6

6

6

6

6

6

6

6

6

❏ Open the printer software, click the Maintenance tab, then 
click the Status Monitor 3 button.

When you access Status Monitor 3, the following window 
appears.

Viewing information in EPSON Status Monitor 3

EPSON Status Monitor 3 provides the following information:

❏ Current Status:
EPSON Status Monitor 3 provides you with detailed printer 
status information, a graphic display, and status messages. If 
the ink runs low or out, the How to button appears in the 
EPSON Status Monitor 3 window. Clicking How to displays 
ink cartridge replacement instructions and moves the print 
head to the ink cartridge replacement position.

❏ Ink Levels:
EPSON Status Monitor 3 provides a graphic display of the 
amount of ink remaining and an estimate of the number of 
pages that can be printed before ink runs out.
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❏ Ink Cartridge Information: 
You can view information about the installed ink cartridges 
by clicking Information.

❏ Technical Support
You can access the online User's Guide from 
EPSON Status Monitor 3. If you encounter a problem, click 
Technical Support in the EPSON Status Monitor 3 window.

For Mac OS X

Using EPSON StatusMonitor

EPSON StatusMonitor monitors this product. If it detects a printer 
error, it will inform you with an error message.

When the ink runs low or out, a How to button appears. Click 
How to, and EPSON StatusMonitor will lead you step by step 
through the ink cartridge replacement procedure.
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You can also use this utility to check ink levels before printing. 
EPSON StatusMonitor displays the amount of ink remaining at 
the time it was opened. To update the ink level information, click 
Update.

Accessing EPSON StatusMonitor

Follow the steps below to access EPSON StatusMonitor.

1. Access the EPSON Printer Utility dialog box.

“Accessing the printer software for Mac OS X” on page 367

2. The EPSON Printer Utility dialog box appears.

3. Click the EPSON StatusMonitor button. The EPSON 
StatusMonitor dialog box appears.
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For Mac OS 9

Using EPSON StatusMonitor

EPSON StatusMonitor monitors this product. If it detects a printer 
error, it will inform you with an error message.

When the ink runs low or out, a How to button appears. Click 
How to, and EPSON StatusMonitor will lead you step by step 
through the ink cartridge replacement procedure.

You can also use this utility to check ink levels before printing. 
EPSON StatusMonitor displays the amount of ink remaining at 
the time it was opened. To update the ink level information, click 
Update.

Accessing EPSON StatusMonitor

Follow the steps below to access EPSON StatusMonitor.

1. Access the Print dialog box.

“Accessing the printer software for Mac OS 9” on page 368
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2. Click the StatusMonitor icon button, or click the Utility 
icon button then the EPSON StatusMonitor button in the 
Utility dialog box. The EPSON StatusMonitor dialog box 
appears.

Using the Configuration Settings dialog box

To change the way that the EPSON StatusMonitor utility monitors 
this product, or to change the way that this product handles print 
jobs, follow the steps below.

1. Click Print or Page Setup on the File menu of your 
application.

2. Click the Utility icon button.
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3. Click Configuration. The Configuration Settings dialog box 
appears.

In the Configuration Settings dialog box, you can make the 
following settings.

Error notification Choose the method by which EPSON 
StatusMonitor will notify you in case of an error.

Warning Choose the method by which EPSON 
StatusMonitor will notify you if a warning 
message becomes necessary.

Temporary Spool folder Specify the folder in which print data will be 
temporarily spooled.

Temporary High Speed 
Copies folder

Specify the folder in which multiple-copy print 
data will be temporarily stored.

Data will be sent to the 
printer after being stored 
on your disk.

Select this check box to prevent horizontal 
banding in printouts that contain images, by 
temporarily storing image data on the 
computer’s hard drive. The computer will then 
send the image data to this product as a 
whole rather than as rectangular bands.

Check for errors before 
starting to print.

Select this check box to have this product 
check for errors before starting to print.

Check the ink level 
before starting to print.

Select this check box to have this product 
check the ink levels before starting to print.
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Using EPSON MonitorIV

After you send a print job to this product, you can use the EPSON 
MonitorIV utility to check, cancel, or change the priority of print 
jobs that are queued for printing. This utility also shows the status 
of the job currently being printed.

Accessing EPSON MonitorIV

To access EPSON MonitorIV, follow these steps.

1. First, turn on Background Printing in the Chooser or in the 
Background Printing dialog box.

2. Send a print job to this product.

3. Select EPSON MonitorIV from the Application menu at the 
right end of the menu bar. The EPSON MonitorIV dialog box 
appears.

Note:
You can also open EPSON MonitorIV by double-clicking the EPSON 
MonitorIV icon in the Extensions folder.

Managing print jobs using EPSON MonitorIV

Using EPSON MonitorIV, you can manage print jobs as described 
below:
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❏ Use the buttons below to hold, resume, and delete print jobs. 
Select the print job that you want to manage, and then click 
the appropriate button.

❏ Click Stop Print Queue to stop printing. Click Start Print 
Queue to resume printing.

❏ Use the buttons below to start the printer utilities.

❏ Double-click a file in the list to preview it. (this function is 
disabled when you are printing the ESC/P command file.)

❏ Double-click Copies to change the number of copies of the 
selected print job that will be printed.

Hold Pauses printing and keeps the current 
print job at the top of the print queue.

Resume Resumes printing.

Delete Stops printing and deletes the print job 
from the print queue.

Print head 
cleaning

Starts the Print Head Cleaning utility.

StatusMonitor Starts EPSON StatusMonitor, which 
displays the amount of ink remaining.
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❏ Click the Show details arrow to open an extension (similar to 
the one below) at the bottom of the EPSON MonitorIV dialog 
box. The extension displays detailed information on the 
selected document’s printer software settings.

Changing the priority of print jobs

To change the priority of print jobs in a print queue, follow the 
steps in this section.

Note:
You can also change the priority of print jobs whose print times were 
previously set in the printer software’s Background Printing dialog box.

1. In the Document Name column, select the print job for which 
you want to change the priority.
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2. Click the Show details arrow to open an extension (similar to 
the one below) at the bottom of the EPSON MonitorIV dialog 
box.

3. From the Priority list, select Urgent, Normal, Hold, or Print 
Time.

Note:
If you select Print Time, a dialog box appears, allowing you to 
specify the date and time when the document will be printed.Make 
sure that this product and computer are turned on at the specified 
time.

Checking the Print Head Nozzles

If you find that the printout is unexpectedly faint or that dots are 
missing, you may be able to identify the problem by checking the 
print head nozzles.

You can check the print head nozzles from your computer using 
the Nozzle Check utility in the printer software or from the printer 
itself by using the printer’s control panel buttons.
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Note:
If the H ink error light is flashing, you cannot clean the print head. 
Replace the appropriate ink cartridge first.

Using the Nozzle Check utility

Refer to the appropriate section below to use the Nozzle Check 
utility.

For Windows

Follow the steps below to use the Nozzle Check utility.

1. Make sure that A4 or Letter size paper is loaded in the sheet 
feeder.

Note:
Make sure that paper is not loaded into the front manual feed slot 
and the front printer cover is closed before using the Nozzle Check 
utility.

2. Access the printer software.

“Accessing the printer software for Windows” on page 366

3. Click the Maintenance tab, then click the Nozzle Check 
button.

4. Follow the on-screen instructions.

For Mac OS X

Follow the steps below to use the Nozzle Check utility.

1. Make sure that A4 or Letter size paper is loaded in the sheet 
feeder.
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Note:
Make sure that paper is not loaded into the front manual feed slot 
and the front printer cover is closed before using the Nozzle Check 
utility.

2. Access the EPSON Printer Utility dialog box.

“Accessing the printer software for Mac OS X” on page 367

3. Select your printer, then click OK in the Printer List window. 

4. Click the Nozzle Check button in the Utility dialog box.

5. Follow the on-screen instructions.

For Mac OS 9

Follow the steps below to use the Nozzle Check utility.

1. Make sure that A4 or Letter size paper is loaded in the sheet 
feeder.

Note:
Make sure that paper is not loaded into the front manual feed slot 
and the front printer cover is closed before using the Nozzle Check 
utility.

2. Access the Print or Page Setup dialog box.

“Accessing the printer software for Mac OS 9” on page 368

3. Click the Utility icon button, then click the Nozzle Check 
button in the Utility dialog box.

4. Follow the on-screen instructions.
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Using the control panel buttons

Follow the steps below to check the print head nozzles using the 
control panel buttons.

1. Turn off your printer.

2. Make sure that A4 or Letter size paper is loaded in the sheet 
feeder.

Note:
Make sure that paper is not loaded into the front manual feed slot 
and the front printer cover is closed before using the Nozzle Check 
utility.

3. Hold down the ) paper (➀ in the illustration below) button 
and the P power button (➁ in the illustration below) to turn 
on the printer.

4. Release only the P power button when the printer turns on. 
When the nozzle check starts, release the ) paper button 
also.
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Below are two sample nozzle check patterns.

Good sample

Print head needs to be cleaned

The above sample is in black and white, but the actual test prints in color 
(CMYK).

If the nozzle check page does not print satisfactorily, there is a 
problem with the printer. This could be a clogged ink nozzle or a 
misaligned print head.

Cleaning the Print Head

If you find that the printout is unexpectedly faint or that dots are 
missing, you may be able to solve these problems by cleaning the 
print head, which ensures that the nozzles are delivering ink 
properly.

You can clean the print head from your computer using the Head 
Cleaning utility in the printer software or from the printer itself 
by using the printer’s control panel buttons.
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Note:
❏ Print head cleaning consumes some ink. To avoid wasting ink, clean 

the print head only if print quality declines; for example, if the 
printout is blurry or the color is incorrect or missing.

❏ Use the Nozzle Check utility first to confirm that the print head 
needs to be cleaned. This saves ink.

❏ When the H ink error light is flashing or on, you cannot clean the 
print head. Replace the appropriate ink cartridge first.

Using the Auto Nozzle Check and Cleaning utility

Epson recommends using the Auto Nozzle Check and Cleaning 
utility which cleans the nozzles automatically.

Refer to the appropriate section below to use the Head Cleaning 
utility.

For Windows

Follow the steps below to clean the print head using the Auto 
Head Cleaning utility.

1. Make sure that the printer is turned on and the H ink error 
light is off.

2. Make sure that A4 or Letter size plain paper is loaded into the 
sheet feeder.

Note:
Make sure that paper is not loaded into the front manual feed slot 
and the front printer cover is closed before using the Auto Nozzle 
Check and Cleaning utility.

3. Access the printer software.

“Accessing the printer software for Windows” on page 366
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4. Click the Maintenance tab, then click the Auto Nozzle 
Check and Cleaning button.

5. Follow the on-screen instructions. The P power light flashes 
while the printer performs the cleaning cycle.

c
Caution:
Never turn off the printer while the P power light is flashing. 
Doing so may damage the printer.

Below is a sample nozzle check pattern:

The above sample is in black and white, but the actual check pattern prints 
in color.

Note:
❏ If print quality has not improved, turn the printer off and leave it 

alone overnight. Then, do the nozzle check again, and repeat the head 
cleaning if necessary.

❏ If the print quality still has not improved, at least one of your ink 
cartridges may be old or damaged and may need to be replaced.
& See “Replacing an Ink Cartridge” on page 216

❏ If print quality remains a problem after replacing the ink cartridges, 
contact your dealer.

❏ To maintain print quality, we recommend printing a few pages at 
least once every month.
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For Mac OS X 

Follow the steps below to clean the print head using the Auto 
Head Cleaning utility.

1. Make sure that the printer is turned on and the H ink error 
light is off.

2. Make sure that A4 or Letter size plain paper is loaded into the 
sheet feeder.

Note:
Make sure that paper is not loaded into the front manual feed slot 
and the front printer cover is closed before using the Auto Nozzle 
Check and Cleaning utility.

3. Access the EPSON Printer Utility dialog box.

“Accessing the printer software for Mac OS X” on page 367

4. Select your printer, then click OK in the Printer List window.

5. Click the Auto Nozzle Check and Cleaning button in the 
Utility dialog box.

6. Follow the on-screen instructions. The P power light flashes 
while the printer performs the cleaning cycle.

c
Caution:
Never turn off the printer while the P power light is flashing. 
Doing so may damage the printer.
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Below is a sample nozzle check pattern:

The above sample is in black and white, but the actual check pattern prints 
in color.

Note:
❏ If print quality has not improved, turn the printer off and leave it 

alone overnight. Then, do the nozzle check again, and repeat the head 
cleaning if necessary.

❏ If the print quality still has not improved, at least one of your ink 
cartridges may be old or damaged and may need to be replaced.
& See “Replacing an Ink Cartridge” on page 216

❏ If print quality remains a problem after replacing the ink cartridges, 
contact your dealer.

❏ To maintain print quality, we recommend printing a few pages at 
least once every month.

For Mac OS 9

Follow the steps below to clean the print head using the Auto 
Nozzle Check and Cleaning utility.

1. Make sure that the printer is turned on and the H ink error 
light is off.

2. Make sure that A4 or Letter size plain paper is loaded into the 
sheet feeder.
256 Improving Print Quality



6

6

6

6

6

6

6

6

6

6

6

6

Note:
Make sure that paper is not loaded into the front manual feed slot 
and the front printer cover is closed before using the Auto Nozzle 
Check and Cleaning utility.

3. Access the Print or Page Setup dialog box.

“Accessing the printer software for Mac OS 9” on page 368

4. Click the  Utility icon button, then click the Auto Nozzle 
Check and Cleaning button.

5. Follow the on-screen instructions. The P power light flashes 
while the printer performs the cleaning cycle.

c
Caution:
Never turn off the printer while the P power light is flashing. 
Doing so may damage the printer.

Below is a sample nozzle check pattern.

The above sample is in black and white, but the actual check pattern prints 
in color.

Note:
❏ If print quality has not improved, turn the printer off and leave it 

alone overnight. Then, do the nozzle check again, and repeat the head 
cleaning if necessary.

❏ If the print quality still has not improved, at least one of your ink 
cartridges may be old or damaged and may need to be replaced.
& See “Replacing an Ink Cartridge” on page 216
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❏ If print quality remains a problem after replacing the ink cartridges, 
contact your dealer.

❏ To maintain print quality, we recommend printing a few pages at 
least once every month.

Using the Head Cleaning utility

Refer to the appropriate section below to use the Head Cleaning 
utility.

For Windows

Follow the steps below to clean the print head using the Head 
Cleaning utility.

1. Make sure that the printer is turned on and the H ink error 
light is off.

2. Access the printer software.

“Accessing the printer software for Windows” on page 366

3. Click the Maintenance tab, then click the Head Cleaning 
button.

4. Follow the on-screen instructions.

The P power light flashes while the printer performs the 
cleaning cycle.

c
Caution:
Never turn off the printer while the P power light is flashing. 
Doing so may damage the printer.

5. When the P power light stops flashing, load a few sheets of 
paper and click Print Nozzle Check Pattern in the Head 
Cleaning dialog box to confirm that the print head is clean.
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Note:
Make sure that paper is not loaded into the front manual feed slot 
and the front printer cover is closed before using the Head Cleaning 
utility.

Below are two sample nozzle check patterns:

Good sample

Print head needs to be cleaned

The above sample is in black and white, but the actual check pattern prints 
in color.

If the nozzle check page does not print satisfactorily, you may 
need to repeat the head cleaning and print the nozzle check 
pattern again.
& See “Cleaning the Print Head” on page 252

Note:
❏ If print quality has not improved after repeating this procedure four 

or five times, turn the printer off and leave it alone overnight. Then, 
do the nozzle check again, and repeat the head cleaning if necessary.

❏ If the print quality still has not improved, at least one of your ink 
cartridges may be old or damaged and may need to be replaced.
& See “Replacing an Ink Cartridge” on page 216
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❏ If print quality remains a problem after replacing the ink cartridges, 
contact your dealer.

❏ To maintain print quality, we recommend printing a few pages at 
least once every month.

For Mac OS X

Follow the steps below to clean the print head using the Head 
Cleaning utility.

1. Make sure that the printer is turned on and the H ink error 
light is off.

2. Access the EPSON Printer Utility dialog box.

“Accessing the printer software for Mac OS X” on page 367

3. Select your printer, then click OK in the Printer List window.

4. Click the Head Cleaning button in the Utility dialog box.

5. Follow the on-screen instructions.

The P power light flashes while the printer performs the 
cleaning cycle.

c
Caution:
Never turn off the printer while the P power light is flashing. 
Doing so may damage the printer.

6. When the P power light stops flashing, click the 
Confirmation button in the Head Cleaning dialog box to 
print a nozzle check pattern. Use the check pattern to confirm 
that the print head is clean.
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Note:
Make sure that paper is not loaded into the front manual feed slot 
and the front printer cover is closed before using the Head Cleaning 
utility.

Below are two sample nozzle check patterns.

Good sample

Print head needs to be cleaned

The above sample is in black and white, but the actual check pattern prints 
in color.

If the nozzle check page does not print satisfactorily, you may 
need to repeat the head cleaning and print the nozzle check 
pattern again.
& See “Cleaning the Print Head” on page 252

Note:
❏ If print quality has not improved after repeating this procedure four 

or five times, turn the printer off and leave it alone overnight. Then, 
do the nozzle check again, and repeat the head cleaning if necessary.

❏ If the print quality still has not improved, at least one of your ink 
cartridges may be old or damaged and may need to be replaced.
& See “Replacing an Ink Cartridge” on page 216
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❏ If print quality remains a problem after replacing the ink cartridges, 
contact your dealer.

❏ To maintain print quality, we recommend printing a few pages at 
least once every month.

For Mac OS 9

Follow the steps below to clean the print head using the Head 
Cleaning utility.

1. Make sure that the printer is turned on and the H ink error 
light is off.

2. Access the Print or Page Setup dialog box.

“Accessing the printer software for Mac OS 9” on page 368

3. Click the Utility icon button, then click the Head 
Cleaning button.

4. Follow the on-screen instructions.

The P power light flashes while the printer performs the 
cleaning cycle.

c
Caution:
Never turn off the printer while the P power light is flashing. 
Doing so may damage the printer.

5. When the P power light stops flashing, click the 
Confirmation button in the Head Cleaning dialog box to 
print a nozzle check pattern. Use the check pattern to confirm 
that the print head is clean.

Note:
Make sure that paper is not loaded into the front manual feed slot 
and the front printer cover is closed before using the Head Cleaning 
utility.
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Below are two sample nozzle check patterns.

Good sample

Print head needs to be cleaned

The above sample is in black and white, but the actual check pattern prints 
in color.

If the nozzle check page does not print satisfactorily, you may 
need to repeat the head cleaning and print the nozzle check 
pattern again.
& See “Cleaning the Print Head” on page 252

Note:
❏ If print quality has not improved after repeating this procedure four 

or five times, turn the printer off and leave it alone overnight. Then, 
do the nozzle check again, and repeat the head cleaning if necessary.

❏ If the print quality still has not improved, at least one of your ink 
cartridges may be old or damaged and may need to be replaced.
& See “Replacing an Ink Cartridge” on page 216

❏ If print quality remains a problem after replacing the ink cartridges, 
contact your dealer.

❏ To maintain print quality, we recommend printing a few pages at 
least once every month.
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Using the control panel buttons

Follow the steps below to clean the print head using the control 
panel buttons.

1. Make sure that the P power light is on and the H ink error 
light is off. Then, hold down the H ink button for three 
seconds.

The printer starts cleaning the print head and the P power 
light begins flashing.

Note:
Make sure that paper is not loaded into the front manual feed slot 
and the front printer cover is closed before using the Head Cleaning 
utility.

c
Caution:
Never turn off the printer while the P power light is flashing. 
Doing so may damage the printer.

2. When the P power light stops flashing, print a nozzle check 
pattern to confirm that the head is clean.
& See “Checking the Print Head Nozzles” on page 248
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Note:
❏ If print quality has not improved after repeating this procedure four 

or five times, turn the printer off and leave it alone overnight. Then, 
do the nozzle check again, and repeat the head cleaning if necessary.

❏ If the print quality still has not improved, at least one of your ink 
cartridges may be old or damaged and may need to be replaced.
& See “Replacing an Ink Cartridge” on page 216

❏ If print quality remains a problem after replacing the ink cartridges, 
contact your dealer.

❏ To maintain print quality, we recommend printing a few pages at 
least once every month.

Aligning the Print Head

If you notice a misalignment of vertical lines or horizontal 
banding, you may be able to solve this problem from your 
computer using the Print Head Alignment utility in your printer 
software. Epson recommends aligning the print head 
automatically. To align the print head automatically, select 
Automatic in the on-screen instruction.

Refer to the appropriate section below.

Note:
Do not press the ) paper button to cancel printing while printing a test 
pattern with the Print Head Alignment utility.
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For Windows

Follow the steps below to align the print head using the Print 
Head Alignment utility.

1. Make sure that three sheets of A4 size EPSON Photo Quality 
Ink Jet Paper are loaded into the sheet feeder.

Note:
Make sure that paper is not loaded into the front manual feed slot 
and the front printer cover is closed before using the Print Head 
Alignment utility.

2. Access the printer software.

“Accessing the printer software for Windows” on page 366

3. Click the Maintenance tab, then click the Print Head 
Alignment button.

4. Follow the on-screen instructions to align the print head.

For Mac OS X

Follow the steps below to align the print head using the Print 
Head Alignment utility.

1. Make sure that three sheets of A4 size EPSON Photo Quality 
Ink Jet Paper are loaded into the sheet feeder.

Note:
Make sure that paper is not loaded into the front manual feed slot 
and the front printer cover is closed before using the Print Head 
Alignment utility.

2. Access the EPSON Printer Utility dialog box.

“Accessing the printer software for Mac OS X” on page 367
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3. Select your printer, then click OK in the Printer List window.

4. Click the Print Head Alignment button in the Utility dialog 
box.

5. Follow the on-screen instructions to align the print head.

For Mac OS 9

Follow the steps below to align the print head using the Print 
Head Alignment utility.

1. Make sure that three sheets of A4 size EPSON Photo Quality 
Ink Jet Paper are loaded into the sheet feeder.

Note:
Make sure that paper is not loaded into the front manual feed slot 
and the front printer cover is closed before using the Print Head 
Alignment utility.

2. Access the Print or Page Setup dialog box.

“Accessing the printer software for Mac OS 9” on page 368

3. Click the Utility icon button, then click the Print Head 
Alignment button.

4. Follow the on-screen instructions to align the print head.
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Chapter 7

Troubleshooting

Diagnosing the Problem

Troubleshooting printer problems is best handled in two steps: 
first diagnose the problem, then apply likely solutions until the 
problem is fixed.

The information that you need to diagnose and solve most 
common problems is provided by online problem solving, the 
printer’s control panel, the EPSON Status Monitor utility, or by 
running a printer operation check. Refer to the appropriate 
section below.

If you have a specific problem relating to print quality, a printout 
problem not related to print quality, or a paper feeding problem, 
or if the printer does not print at all, refer to the appropriate 
section in this chapter.

To solve a problem, you may need to cancel printing. 
& See “Canceling Printing” on page 296
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Error indicators

You can identify many common printer problems using the lights 
on your printer’s control panel. If your printer stops working and 
the lights are on or flashing, use the following table of panel light 
patterns to diagnose the problem, then follow the recommended 
corrective measures. If the status of the power light is not shown, 
it is on or flashing.

Lights Problem and solution

O ) Paper out

No paper is loaded in 
the printer.

Load paper in the sheet feeder, 
and then press the ) paper 
button. The printer resumes 
printing and the light goes out.

F ) Paper jam

Paper has jammed in 
the printer.

& See “The paper jams” on page 
283

F ) Paper mismatch error

The print path specified 
by the printer driver and 
the path in which the 
paper is loaded are 
different.

Load paper to the path specified 
by the printer driver.

Wrong positioning of the output tray

The position of the 
output tray is wrong.

Change the position of the output 
tray.
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O H

o H

Ink out

An ink cartridge is empty 
or not installed.

Replace the light light black 
(T0599), light magenta (T0596), 
light cyan (T0595), light black 
(T0597), photo black (T0591), 
matte black (T0598), cyan (T0592), 
magenta (T0593), or yellow 
(T0594) ink cartridge with a new 
one. If the ink end error occurs 
after the print head has moved to 
the home position, the ink 
cartridge may not be installed 
properly. Reinstall the ink cartridge 
so that it clicks into place.
& See “Replacing an Empty Ink 
Cartridge” on page 209

Wrong cartridge

The currently installed ink 
cartridge cannot be 
used with this printer.

Replace the incompatible 
cartridge using the appropriate 
light light black (T0599), light 
magenta (T0596), light cyan 
(T0595), light black (T0597), photo 
black (T0591), matte black 
(T0598), cyan (T0592), magenta 
(T0593), or yellow (T0594) ink 
cartridge.
& See “Replacing an Ink 
Cartridge” on page 216

Incorrectly installed ink cartridge

An ink cartridge is not 
installed correctly.

If the print head is at the home 
position, press the H ink button to 
move the print head to the ink 
cartridge replacement position. 
Remove and reinsert the ink 
cartridge. Then, continue with the 
ink cartridge installation. 

If the print head is at the ink 
cartridge replacement position, 
remove and reinsert the ink 
cartridge. Then, continue with ink 
cartridge installation.
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O o = on, N n = off, F f = flashing

The photo black or 
matte black cartridges 
were exchanged during 
printing.

Return the ink cartridges to their 
original combination before the 
error occurred.

F H

f H

Ink low

The ink cartridge is 
nearly empty.

Obtain a replacement light light 
black (T0599), light magenta 
(T0596), light cyan (T0595), light 
black (T0597), photo black 
(T0591), matte black (T0598), cyan 
(T0592), magenta (T0593), or 
yellow (T0594) ink cartridge. To 
determine which cartridge is 
nearly empty, check the ink levels 
using EPSON Status Monitor 3 
(Windows) or EPSON Status 
Monitor (Macintosh).

F )

F H

Carriage error

The print head carriage 
is obstructed by 
jammed paper or other 
foreign material and 
cannot return to the 
home position.

Turn off the printer. Open the 
printer cover and remove any 
paper or other obstructions from 
the paper path by hand. Then, 
turn the printer back on.

If the error does not clear, contact 
your dealer.

N P

F )

F H

Front Printer cover open

Paper is loaded in the 
sheet feeder and the 
Front Printer cover is 
open.

Close the front printer cover.

N P

F )

F H

Unknown printer error

An unknown printer error 
has occurred.

Turn off the printer and contact 
your dealer.
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EPSON Status Monitor

If a problem occurs while printing, an error message will appear 
in the Progress Meter window.

When the ink is out, click the How To button in the EPSON Status 
Monitor or Progress Meter window, and EPSON Status Monitor 
will lead you step-by-step through the cartridge replacement 
procedure.

If an error message indicating that parts inside your printer are 
near the end of their service life appears, contact your dealer for 
replacement.

Running a printer operation check

If you are unable to determine the source of the problem, 
performing a printer operation check can help you determine 
whether the problem comes from the printer or the computer.

To print a printer operation check page, follow these steps.

1. Make sure both the printer and computer are turned off.

2. Disconnect the cable from the printer’s interface connector.

3. Make sure the output tray is ejected, and the output extension 
tray is slid out.

4. Make sure that A4 or Letter size paper is loaded in the sheet 
feeder.
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5. Hold down the ) paper button and press the P power 
button to turn on the printer. Release only the P power 
button. After the printer starts the operation check, release the 
) paper button.

Compare the quality of the printed check page with the sample 
shown below. If there are no print quality problems, such as gaps 
or missing segments in the test lines, the printer itself is fine and 
the problem probably lies with the printer software settings, the 
application settings, the interface cable (be sure to use a shielded 
cable), or the computer itself.

The above sample may be shown in black and white, but the actual check 
page prints in color (CMYK).
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If the check page does not print satisfactorily as shown below, 
there is a problem with the printer. For example, if any segment 
of the printed lines is missing, this could mean a clogged ink 
nozzle or a misaligned print head.

The above sample may be show in black and white, but the actual check 
pattern prints in color.

Print Quality Problems

If you are having print quality problems, try the solutions offered 
in this section.

Horizontal banding

❏ Make sure that the printable side of the paper is face up in the 
sheet feeder.

❏ Run the Head Cleaning utility to clear any clogged ink 
nozzles.
& See “Cleaning the Print Head” on page 252

❏ Run the Print Head Alignment utility.
& See “Aligning the Print Head” on page 265

❏ Use up ink cartridges within six months after opening their 
packages.

❏ Use the genuine Epson ink cartridges.
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❏ Clear all customized settings, and select Text settings as the 
Quality Option setting on your printer’s software (Windows). 
Clear all customized settings, and select Automatic as the 
Mode setting on your printer’s software (Macintosh).
& See “Making settings on the Main menu” on page 125 (for 
Windows)
& See “Print Dialog Box” on page 176 (Mac OS 9)
& See “Print Dialog Box” on page 159 (Mac OS X)

❏ Check the H ink error light. If the light is flashing, replace the 
appropriate ink cartridge.
& See “Replacing an Empty Ink Cartridge” on page 209

❏ Make sure that the Media Type selected in the printer 
software is appropriate for the type of media loaded in the 
printer.

“Media type settings” on page 369

Vertical misalignment or banding

❏ Make sure that the printable side of the paper is face up in the 
sheet feeder.

❏ Run the Head Cleaning utility to clear any clogged ink 
nozzles.
& See “Cleaning the Print Head” on page 252

❏ Run the Print Head Alignment utility.
& See “Aligning the Print Head” on page 265

❏ Clear the High Speed check box in your printer software’s 
Advanced dialog box.
& See “Making the Advanced settings” on page 132 
(Windows)
& See “Advanced settings” on page 178 (Mac OS 9)
& See “Advanced mode” on page 163 (Mac OS X)
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❏ Make sure that the Media Type selected in the printer 
softwareis appropriate for the type of media loaded in the 
printer.

“Media type settings” on page 369

Incorrect or missing colors

❏ Clear the Grayscale setting in your printer software (for 
Windows). Change the Ink setting in your printer software to 
Color (For Macintosh).
& See “Making the Advanced settings” on page 132 
(Windows)
& See “Color” on page 177 (Mac OS 9)
& See “Color” on page 162 (Mac OS X)

❏ Adjust the color settings in your application or in your printer 
software’s Advanced dialog box.
& See “Making the Advanced settings” on page 132 
(Windows)
& See “Advanced settings” on page 178 (Mac OS 9)
& See “Color Management” on page 166 (Mac OS X)

❏ Run the Head Cleaning utility.
& See “Cleaning the Print Head” on page 252

If colors are still incorrect or missing, replace the color ink 
cartridge. If the problem persists, replace the black ink 
cartridge.
& See “Replacing an Ink Cartridge” on page 216

❏ If you have just replaced an ink cartridge, make sure the date 
on the box has not expired. Also, if you have not used the 
printer for a long time, replace with new ink cartridges.
& See “Replacing an Ink Cartridge” on page 216
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Blurry or smeared printout

❏ Make sure that you are using the appropriate printer driver 
for your printer.

❏ Use only paper recommended by Epson.
& See “Paper” on page 333

❏ Use genuine Epson ink cartridges.

❏ Make sure that the printer is on a flat, stable surface that 
extends beyond the printer base in all directions. The printer 
will not operate properly if it is tilted.

❏ Make sure that your paper is not damaged, dirty, or too old. 

❏ Make sure that your paper is dry and that the printable side 
is facing up.

❏ Clear all customized settings, and select Text settings as the 
Quality Option setting on your printer’s software (Windows). 
Clear all customized settings, and select Automatic as the 
Mode setting on your printer’s software (Macintosh).
& See “Making settings on the Main menu” on page 125 (for 
Windows)
& See “Print Dialog Box” on page 176 (Mac OS 9)
& See “Print Dialog Box” on page 159 (Mac OS X)

❏ If the paper is curled toward the printable side, flatten it or 
curl it slightly in the opposite direction. 

❏ Make sure that the Media Type setting in your printer’s 
software is correct.

❏ Remove each sheet from the output tray as it is printed, 
especially if you are using transparencies.
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❏ If you are printing on glossy media or transparencies, place a 
support sheet (or a sheet of plain paper) beneath the stack, or 
load only one sheet at a time.

❏ Do not touch or allow any thing to come into contact with the 
printed side of transparencies or paper with a shiny finish. 
After printing documents on transparencies or glossy media, 
allow the ink to set for a few hours before handling them.

❏ Run the Head Cleaning utility.
& See “Cleaning the Print Head” on page 252

❏ Run the Print Head Alignment utility.
& See “Aligning the Print Head” on page 265

Printout Problems Not Related to Print Quality

Incorrect or garbled characters

❏ Make sure that your printer and printer driver are 
appropriately selected.

❏ Select your printer as the default printer (Windows).

❏ Clear any stalled print jobs from the Spool Manager 
(Windows Me/98).
& See “Using EPSON Spool Manager” on page 298

❏ Turn off the printer and computer. Make sure that the 
printer’s interface cable is securely plugged in.
278 Troubleshooting



7

7

7

7

7

7

7

7

7

7

7

7

Incorrect margins

❏ Check the margin settings in your application. Make sure that 
the margins are within the printable area of the page.
& See “Paper” on page 333

❏ Check the settings on the Main menu (Windows) or in the 
Page Setup dialog box (Macintosh). Make sure the settings are 
appropriate for the paper size you are using.
& See “Making settings on the Main menu” on page 125 
(Windows)
& See “Page Setup Dialog Box” on page 173 (Mac OS 9)
& See “Page Setup Dialog Box” on page 157 (Mac OS X)

❏ If you try to print using the Borderless feature and the 
printout includes margins, check your original photo data. In 
addition, the digital camera (data transmission equipment) 
may automatically add margins in order for the aspect ratio 
of the image to be adjusted.

Inverted image

Clear the Mirror Image check box in the printer software, or turn 
off the “Mirror Image” setting in your application. For 
instructions, see online help for the printer software or for your 
application.
& See “Making settings on the Page Layout menu” on page 144 
(Windows)
& See “Advanced settings” on page 178 (Mac OS 9)
& See “Advanced mode” on page 163 (Mac OS X)

Blank pages print

❏ Make sure that your printer and printer driver are 
appropriately selected.

❏ Select your printer as the default printer (Windows).
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❏ Check the settings on the Main menu (Windows) or in the 
Page Setup dialog box (Macintosh). Make sure the settings are 
appropriate for the paper size you are using.
& See “Making settings on the Main menu” on page 125 
(Windows)
& See “Page Setup Dialog Box” on page 173 (Mac OS 9)
& See “Page Setup Dialog Box” on page 157 (Mac OS X)

❏ Run the Head Cleaning utility to clear any clogged nozzles.
& See “Cleaning the Print Head” on page 252

After trying one or more of these solutions, run a printer operation 
check to check your results.
& See “Running a printer operation check” on page 272

Printout has smears

❏ If the paper is curled toward the printable side, flatten it or 
curl it slightly in the opposite direction.

❏ Clear the High Speed check box in your printer software’s 
Advanced dialog box.
& See “Making the Advanced settings” on page 132 
(Windows)
& See “Advanced settings” on page 178 (Mac OS 9)
& See “Advanced mode” on page 163 (Mac OS X)

❏ Load and eject dry paper several times. If the problem 
persists, ink may have leaked inside the printer. In this case, 
wipe the inside of the printer with a soft, clean cloth.
& See “Cleaning the Printer” on page 322
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❏ Select Thick paper in Printer and Option Information dialog 
(Windows), in Advanced dialog (Mac OS 9), or in Extension 
Setting dialog (Mac OS X).
& See “Printer and option information” on page 149 
(Windows) 
& See “Advanced settings” on page 178 (Mac OS 9) 
& See “Extension Setting” on page 168 (Mac OS X)

Printing is too slow

❏ Make sure that the Media Type settingin your printer 
software is correct.

“Media type settings” on page 369

❏ Select Text as the Print Quality setting on your printer’s 
software (Windows).
Select Automatic as the Mode setting in the Print dialog box, 
then move the slider to Speed (Macintosh).
& See “Quality Option” on page 126 (Windows)
& See “Automatic mode” on page 177 (Mac OS 9)
& See “Automatic mode” on page 163 (Mac OS X)

❏ Close any unnecessary applications.

❏ If you upgraded from Windows 95 to Windows 98, uninstall 
the printer software using Add/Remove Programs on the 
Control Panel, then install the software again.

If you try all of the methods above and cannot solve the problem, 
see the following:
& See “Increasing the Print Speed” on page 313
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Paper Does Not Feed Correctly

Paper does not feed

Remove the stack of paper and make sure of the following:

❏ The paper is not curled or creased.

❏ The paper is not too old. See the instructions that came with 
the paper for more information.

❏ The paper is not loaded higher than the arrow mark on the 
left edge guide.

❏ The number of sheets in the paper stack does not exceed the 
limit specified for the media.

“Loading capacities for Epson special media” on page 356

❏ Paper is not jammed inside the printer. If it is, remove the 
jammed paper.
& See “The paper jams” on page 283

❏ The ink cartridges are not empty. If one is, replace the 
appropriate cartridge.
& See “Replacing an Empty Ink Cartridge” on page 209

❏ Special loading instructions that came with your paper have 
been followed. Load the paper again.

“Loading single sheets of paper” on page 346
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Multiple pages feed

❏ Make sure that the paper stack is flush with or lower than the 
triangular load-limit mark on the edge guide.

❏ Make sure that the left edge guide is snug to the left edge of 
the paper.

❏ Make sure that the paper is not curled or folded. If so, flatten 
it or curl it slightly toward the opposite side before loading.

❏ Remove the stack of paper and make sure that the paper is 
not too thin.
& See “Paper” on page 333

❏ Fan the edges of the stack to separate the sheets, then reload 
the paper.

❏ If too many copies of a document are being printed, check the 
Copies setting on the printer software’s Page Layout menu 
(Windows) or in the Print dialog box (Macintosh) and in your 
application.
& See “Copies” on page 145 (Windows)
& See “Copies” on page 176 (Macintosh)
& See “Copies & Pages” on page 160 (Mac OS X)

The paper jams

If the paper jams when you are printing from the sheet feeder, 
press the ) paper button to eject the jammed paper. If the error 
does not clear, follow the steps below.

1. Turn off the printer.

2. If the output tray is closed, open the output tray extension and 
slide out the output tray.
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3. Remove the jammed paper from the output path.

If the jammed paper cannot be removed in this step, proceed 
to the next step.

4. Open the top printer cover, and remove the jammed paper 
gently.

c
Caution:
Do not pull the paper forcibly. Doing so may damage your 
printer.

If the jammed paper cannot be removed in this step, proceed 
to the next step.

5. Gently remove the jammed paper from the sheet feeder.

c
Caution: 
Do not pull the paper forcibly. Doing so may damage your 
printer.

6. After removing the jammed paper, slide the output tray back 
in.

Note:
If you cannot remove a foreign object easily by yourself, do not use force 
and do not disassemble the printer. Call your dealer for assistance.

If your paper jams frequently, make sure of the following:

❏ The paper is smooth, not curled or wrinkled.

❏ The paper is of high quality.

❏ The printable side of the paper is face up in the sheet feeder.

❏ The paper stack was fanned before loading.

❏ The paper is not loaded above the arrow on the left edge 
guide.
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❏ The number of sheets in the paper stack does not exceed the 
limit specified for that media.

“Loading capacities for Epson special media” on page 356

❏ The left edge guide is adjusted to fit your paper.

❏ The printer is on a flat, stable surface that extends beyond the 
printer base in all directions. The printer will not operate 
properly if it is tilted.

Paper improperly loaded

If you have loaded the paper too far into the printer, the printer 
cannot feed the paper correctly. Turn the printer off and gently 
remove the paper. Then turn the printer on and reload the paper 
properly.

Paper is not ejected fully or is wrinkled

❏ If the paper does not eject fully, press the ) paper button, 
then open the top printer cover and remove the paper. Also, 
check the Paper Size setting in your application or printer 
software.
& See “Making settings on the Main menu” on page 125 
(Windows)
& See “Page Setup Dialog Box” on page 173 (Mac OS 9)
& See “Page Setup Dialog Box” on page 157 (Mac OS X)

❏ If the paper is wrinkled when it comes out, it may be damp 
or too thin. Load a new stack.

Note:
Store any unused paper in its original packaging in a dry area.
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Thick Paper is ejected when sending a thick 
paper print job

If the thick paper is ejected when you send a thick paper print job 
to the printer, it means that the printer is not ready. When a 
message stating that the printer is ready appears on the screen, 
reload the thick paper, and then press the ) paper button.

Thick Paper does not eject properly after a thick 
paper print job is finished

Follow the instructions below.

1. Gently remove the thick paper. 

2. Press the ) paper button.

Printer Does Not Print

All lights are off

❏ Press the P power button to make sure that the printer is on.

❏ Turn off the printer and make sure that the power cord is 
securely plugged in.

❏ Make sure that your outlet works and is not controlled by a 
wall switch or timer.
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Lights came on and then went out

The printer’s voltage may not match the outlet rating. Turn off the 
printer and unplug it immediately. Then, check the printer labels.

c
Caution:
If the voltage does not match, DO NOT PLUG YOUR PRINTER 
BACK IN. Contact your dealer.

Only the power light is on

❏ Turn off the printer and computer. Make sure that the 
printer’s interface cable is securely plugged in.

❏ Make sure that there is no packing material in the printer.

❏ Turn off the printer and the computer, disconnect the printer’s 
interface cable, then print an operation check page.
& See “Running a printer operation check” on page 272

If the check page prints correctly, make sure that the printer 
software and your application are installed correctly.

❏ If you are trying to print a large image, your computer may 
not have enough memory to print. Try printing a smaller 
image.

❏ Clear any stalled print jobs from the Spool Manager 
(Windows Me/98). Users of Windows Me and 98 can clear 
any stalled print jobs from the spool manager.
& See “Using EPSON Spool Manager” on page 298

❏ If the printer sounds like it is trying to print, but is unable to, 
run the Head Cleaning utility.
& See “Cleaning the Print Head” on page 252

If this does not work, replace the ink cartridges.
& See “Replacing an Ink Cartridge” on page 216
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The error light is flashing or on

Check EPSON Status Monitor 3 (Windows) or 
EPSON StatusMonitor (Macintosh) to find the cause of the error, 
then try one or more of these solutions:

❏ If the ) paper out light is on and there is no paper in the 
printer, load paper into the sheet feeder.

❏ If the H ink error light is flashing, the ink supply is low. Obtain 
a replacement cartridge of the appropriate type.
& See “Replacing an Ink Cartridge” on page 216

❏ If the H ink error light is on, the ink cartridge is empty. Replace 
the appropriate ink cartridge.
& See “Replacing an Empty Ink Cartridge” on page 209

Error light is on and power light is flashing

Follow the steps below.

1. Press the ) paper button, then remove any paper in the 
printer.

2. Turn the printer off. Check for and remove any foreign objects 
or pieces of paper from inside the printer. Also make sure that 
there is sufficient space around the vent on the back of the 
printer to allow proper ventilation. Remove any objects 
blocking the vent. Then, turn the printer back on.

Note:
If you cannot remove a foreign object easily by yourself, do not use 
force and do not disassemble the printer. Call your dealer for 
assistance.

3. If the error does not clear, contact your dealer.
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Print Head Carriage Problem

If the carriage cover does not close or the print head carriage does 
not move to its home position, open the carriage cover and push 
the ink cartridges down until they click into place.

Correcting USB Problems

USB connections

USB cables or connections can sometimes be the source of USB 
problems.

For best results, you should connect the printer directly to the 
computer’s USB port. If you must use multiple USB hubs, we 
recommend that you connect the printer to the first-tier hub.
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Windows operating systems

Your computer must be a model pre-installed with Windows Me, 
98, XP, or 2000, a model that was pre-installed with Windows 98 
and upgraded to Windows Me, or a model that was pre-installed 
with Windows Me, 98, or 2000 and upgraded to Windows XP. 
You may not be able to install or run the USB printer driver on a 
computer that does not meet these specifications or that is not 
equipped with a built-in USB port.

For details about your computer, contact your dealer.

Printer software installation

Incorrect or incomplete software installation can lead to USB 
problems. Take note of the following and perform the 
recommended checks to ensure proper installation.

Checking printer software installation for Windows XP and 
2000

When using Windows XP or 2000, you must follow the steps in 
the Start Here sheet packed with the printer to install the printer 
software. Otherwise, Microsoft’s Universal driver may be 
installed instead. To check if the Universal driver has been 
installed follow the steps below.

1. Open the Printers folder and right-click the icon for your 
printer.

2. Click Printing Preference on the shortcut menu that appears, 
and then right-click anywhere in the driver.
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If About is displayed in the shortcut menu that appears, click 
it. If a message box with the words “Unidrv Printer Driver” 
appears, you must reinstall the printer software as described 
in the Start Here sheet. If About is not displayed, the printer 
software has been installed correctly.

Note:
If the Digital Signature Not found dialog box (Windows 2000) or 
Software Installation dialog box (Windows XP) appears during the 
installation process, click Yes (Windows 2000) or Continue Anyway 
(Windows XP). If you click No (Windows 2000) or STOP Installation 
(Windows XP), you will have to install the printer software again.

Checking printer software in Windows Me and 98

If you canceled the plug-and-play driver installation in 
Windows Me or 98 before the procedure was complete, the USB 
printer device driver or the printer software may be incorrectly 
installed. Follow the directions below to ensure that the driver 
and printer software are installed correctly.

Note:
The screen captures shown in this section are taken from Windows 98. 
Windows Me screens may differ slightly.

1. Click the Start button, point to Settings, and then click 
Printers. Make sure that the icon for your printer appears in 
the Printers window.
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Select the icon for your printer, and then click Properties on 
the File menu.

2. Click the Details tab.
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If EPUSBX: (EPSON Stylus Photo R2400) is displayed in the 
Print to the following port list, then the USB printer device 
driver and printer software are installed correctly. If the 
correct port is not displayed, proceed to the next step.

3. Right-click the My Computer icon on your desktop, and then 
click Properties.

4. Click the Device Manager tab.

If your drivers are correctly installed, EPSON USB Printer 
Devices should appear on the Device Manager menu.

If EPSON USB Printer Devices does not appear on the Device 
Manager menu, click the plus (+) sign beside Other devices 
to view the installed devices. 
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If USB Printer or EPSON Stylus Photo R2400 appears under 
Other devices, the printer software is not installed correctly. 
Proceed to step 5.

If neither USB Printer nor EPSON Stylus Photo R2400 appears 
under Other devices, click Refresh or unplug the USB cable 
from the printer, then plug it into the printer again. Once 
you’ve confirmed that these items appear, proceed to step 5.

5. Under Other devices, select USB Printer or EPSON Stylus 
Photo R2400 and click Remove. Then, click OK.

When the following dialog box appears, click OK, and then 
click OK to close the System Properties dialog box.

6. Uninstall the printer software.
& See “Uninstalling the printer software” on page 318
294 Troubleshooting



7

7

7

7

7

7

7

7

7

7

7

7

7. Turn off the printer, restart your computer, and reinstall the 
printer software as explained in the Start Here sheet packed 
with your printer.

Communication Error

The power light does not turn on

The power light is on but nothing prints

Cause What to do

The power cord may not be 
properly plugged into the 
electrical outlet.

Turn off the printer and check the power 
cord connections between the printer and 
the electrical outlet. Then turn the printer 
back on.

The electrical outlet may 
be controlled by an outside 
switch or an automatic 
timer.

Make sure that the switch is turned on or 
plug another electrical device into the outlet 
to check whether the outlet is operating 
properly.

Cause What to do

Your computer may not be 
properly connected to the 
printer.

Perform the setup procedure described in 
the Start Here sheet.

The interface cable may 
not be plugged in securely.

Check both ends of the interface cable 
between the printer and the computer. 
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Canceling Printing

If you encounter problems while printing, you may need to cancel 
printing. To cancel printing, follow the instructions in the 
appropriate section below.

Using the control panel buttons

Press the ) paper button while printing to cancel the printing of 
a print job.

You may not be using the 
correct interface cable.

If you are using the USB interface, use a 
Revision 1.1 or 2.0 cable.

Some error may have 
occurred.

Check the lights on the Control Panel to see 
if lights other than power light are flashing 
or on in red.
& See “Error indicators” on page 269

Your printer may have 
broken.

Print the nozzle check pattern to see if the 
printer is broken.
& See “Running a printer operation check” 
on page 272

If the printer does not print, it may broken. 
Contact your dealer.

Your application software 
is not properly set up for 
your printer.

Make sure that the printer is selected in your 
application software.

Your computer system’s 
memory is too small to 
handle the volume of data 
in your document.

Try reducing the image resolution of your 
document in the application software, or 
install more memory in your computer if 
you can.
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For Windows XP and 2000

When you send a print job to the printer, the Progress Meter will 
appear on your computer screen.

Click the Stop button to cancel printing.

For Windows Me and 98

It is possible to cancel printing using either the Progress Meter or 
EPSON Spool Manager. Refer to the appropriate section below.
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Using the Progress Meter

When you send a print job to the printer, the Progress Meter 
appears on your computer screen.

Click the Stop button to cancel printing.

Using EPSON Spool Manager

EPSON Spool Manager is similar to Windows Print Manager. If 
it receives two or more print jobs at one time, it holds them in the 
order that they were received (with printers on a network this 
may be called a print queue). When a print job reaches the top of 
the queue, the EPSON Spool Manager sends the job to the printer. 
You can cancel print jobs from the Spool Manager. You can also 
view print status information about the print jobs which have 
been sent to your printer, as well as pause and resume or restart 
selected print jobs.
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After you send a print job, an EPSON Stylus Photo R2400 button 
will appear in the icon tray. Click this button to open the EPSON 
Spool Manager.

To cancel a print job, select the job in the list, and then click 
Cancel.

For Macintosh

The procedure for canceling printing for Macintosh varies, 
depending on whether background printing is on or off. Refer to 
the appropriate section below.

For Mac OS X

Follow the steps below to cancel a print job.

1. Click the Print Center or Printer Setup Utility icon in Dock.

2. Press the P power button to turn off the printer.
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3. In the Printer List, double-click Stylus Photo R2400.

4. In the Document Name list, select the document which is 
printing, then click the Delete button to cancel the print job.

For Mac OS 9

When background printing is on

Follow the steps below to cancel a print job.

1. Select EPSON MonitorIV from the application menu.

2. Press the P power button to turn off the printer.
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3. In the Document Name list, select the document which is 
printing, then click the Stop icon button to cancel the print 
job.

When background printing is off

Follow the steps below to cancel a print job.

1. Press the P power button to turn off the printer.

2. Hold down the J command key on your keyboard and press 
the period (.) key to cancel the print job.
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Chapter 8

Other Information

Setting Up Your Printer on a Network

For Windows XP and 2000

This section tells you how to set up your printer so that other 
computers on the network can use it.

Note:
❏ This section is written for small network users only. If you are on a 

large network and would like to share your printer, consult your 
network administrator.

❏ To install software programs in Windows XP, it is necessary to log 
on with a Computer Administrator account. You cannot install 
software programs if you log on as a Limited account user.
After you install Windows XP, the user account is set as a Computer 
Administrator account.

❏ To install software programs in Windows 2000, it is necessary to 
log on as a user with administrative privileges (a user who belongs 
to the Administrators group.)

❏ The figures that are provided in the following section pertain to 
Windows 2000.

First, set up the printer as a shared printer on the computer 
connected directly to the printer. Then, add the printer to each 
computer that will access it through the network.
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Setting up your printer as a shared printer

To share a printer with other computers on a network, follow the 
steps below to configure the computer connected directly to the 
printer.

Note:
The figures provided in the following section pertain to Windows XP.

1. For Windows XP, click Start, Control Panel, then 
double-click Printers and Faxes. (If the Control Panel is in 
Category View, click Printers and Other Hardware, then 
click Printers and Faxes.)
For Windows 2000, click Start, point to Settings, then click 
Printers.

2. Right-click the icon for your printer, then click Sharing.

3. Select Shared as, then type a name for the shared printer.

Note:
Do not use spaces or hyphens in the printer name.
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If you want Windows XP or 2000 to automatically download 
printer drivers for computers that are running different 
versions of Windows, click Additional Drivers and select the 
environment and the operating systems for the other 
computers. Click OK, then insert the printer software CD into 
the CD-ROM drive.

4. Click OK, or click Close if you installed additional drivers.

Accessing the printer through a network

To use your printer from other computers on a network, you must 
first add the printer to each computer that will access it. Follow 
the steps below.

Note:
Your printer must be set up as a shared resource on the computer to 
which it is directly connected before you can access it from another 
computer.
& See “Setting up your printer as a shared printer” on page 303

1. For Windows XP, click Start, Control Panel, then 
double-click Printers and Faxes. (If the Control Panel is in 
Category View, click Printers and Other Hardware, then 
click Printers and Faxes.)
For Windows 2000, Click Start, point to Settings, then click 
Printers.

2. Double-click the Add Printer icon. The Add Printer Wizard 
appears.

3. Click Next.
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4. Select Network printer, then click Next.

5. On the next screen, click Next.

6. Double-click the icon of the computer that is directly 
connected to the printer. Then, click the icon for the 
appropriate printer.
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7. Click Next and follow the on-screen instructions.

Note:
Depending on the operating system and the configuration of the 
computer to which the printer is connected, the Add Printer Wizard may 
prompt you to install the printer driver from the printer software 
CD-ROM. In this case, click the Have Disk button and follow the 
on-screen instructions.

For Windows Me and 98

This section tells you how to set up your printer so that other 
computers on a network can use it.

First, set up the printer as a shared printer on the computer 
connected directly to the printer. Then, install the printer software 
on each computer that will access the printer through the 
network.

Note:
This section describes how to use your printer as a shared printer on a 
network. To connect your printer directly to a network without setting 
it up as a shared printer, consult your network administrator.

Setting up your printer as a shared printer

To share a printer with other computers on a network, follow the 
steps below to configure the computer connected directly to the 
printer.

1. Click Start, point to Settings, then click Control Panel.

2. Double-click the Network icon.

3. Click File and Print Sharing.
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4. Select the I want to be able to allow others to print to my 
printer(s) check box and click OK.

5. In the Network dialog box, click OK.

6. In the Control Panel, double-click the Printers icon.

Note:
❏ If a dialog box appears requesting that you insert the 

Windows Me and 98 CD-ROM, insert the CD into the 
CD-ROM drive, then follow the on-screen instructions.

❏ If a dialog box appears requesting that you restart your 
computer, do so, open the Printers folder, then continue with 
step 7.

7. Select the icon for your printer in the Printers folder, then click 
Sharing on the File menu.
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8. Select Shared As, type the printer information as required, 
then click OK.

Accessing the printer through a network

To use your printer from other computers on a network, first add 
the printer to each computer that will access it. Follow the steps 
below.

Note:
Your printer must be set up as a shared resource on the computer to 
which it is directly connected before you can access it from another 
computer.
& See “Setting up your printer as a shared printer” on page 306

1. Click Start, point to Settings, then click Printers.

2. Double-click the Add Printer icon. The Add Printer Wizard 
appears.

3. Click Next.
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4. Select Network printer, then click Next.

5. On the next screen, click Browse.

6. Double-click the icon of the computer that is directly 
connected to the printer. Then, click the icon for the 
appropriate printer.

7. Click OK and follow the on-screen instructions.

For Mac OS X

Use the Printer Sharing setting, which is a standard feature for 
Mac OS X 10.2 or later. This feature is not available with Mac OS 
X 10.1. See your operating system’s documentation for details.
Other Information 309



For Mac OS 9

This section tells you how to set up the printer so that you can use 
it on an AppleTalk network. By setting up your printer as a shared 
printer, your local printer is connected to the network and can be 
used by other computers.

First, set up the printer as a shared printer on the computer 
connected directly to the printer. Next, specify the network path 
to the printer from each computer that will use it, and install the 
printer software on those computers.

Setting up your printer as a shared printer

To share a printer with other computers on an AppleTalk 
network, follow the steps below to configure the computer 
connected directly to the printer.

1. Turn on the printer.

2. Choose Chooser from the Apple menu, click the icon for your 
printer, then select the port the printer is connected to.
310 Other Information



8

8

8

8

8

8

8

8

8

8

8

8

3. Click the Setup button. The Printer Sharing Setup dialog box 
opens.

4. Select the Share this Printer check box, then type the printer 
name and password information as necessary.

5. Click OK. The name of the shared printer will appear in the 
port list in the Chooser.

6. Close the Chooser.

Accessing the printer through a network

To access your printer from other computers on a network, follow 
the steps in this section for each computer that will access the 
printer.

1. Turn on your printer.

2. Install the printer software from the printer software 
CD-ROM.

3. Choose Chooser from the Apple menu. Click the appropriate 
printer icon and select the printer port that you want to use 
from the Select a printer port list.
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Note:
Only printers that are connected to your current AppleTalk zone 
are available.

If the following dialog box appears, enter the password for 
the printer, then click OK.

4. Select the appropriate Background Printing radio button to 
turn background printing on or off.

5. Close the Chooser.
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Increasing the Print Speed

Follow the instructions in this section to increase the print speed 
of your printer.

General tips

Just as printing at a high resolution requires more processing time 
than printing at a low resolution, printing in color takes longer 
than printing in black-and-white because the volume of data in a 
color document is much greater. For this reason, it is important 
to be selective in your use of color printing if you also require a 
fast print speed.

However, even if your document requires the highest resolution 
and extensive use of color—for example, when you are printing 
a camera-ready composite that includes color photographs—it 
may still be possible to optimize the print speed by adjusting other 
printing conditions. For example, we recommend using a USB 2.0 
cable with an IEEE 1394 port to gain the highest rates of data 
transfer. Keep in mind that changing some conditions to increase 
the print speed may also lower print quality.

The following table shows the factors that inversely affect print 
speed and print quality (increasing one will decrease the other).

Print quality
Print speed

Lower
Faster

Higher
Slower

Printer 
software 
menu

Printer 
software 
settings

Paper & 
Quality Options
(Windows),
Print Quality
(Macintosh)

Economy, 
Normal

Photo Advanced 
dialog box

High Speed On Off

Data 
characteristics

Image size Small Large -

Resolution Low High
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The table below shows the factors related to print speed only.

* Varies depending on the printer software and application being used.

** Varies depending on the media type printed on.

Print speed Faster Slower Printer software 
menu

Printer 
software 
settings

Orientation Portrait Land-
scape

Main menu 
(Windows), 
Page Setup 
dialog box 
(Macintosh)

Grayscale On Off Advanced 
dialog box, Main 
menu (Windows)

Color** Gray-
scale

Color Print dialog box 
(Macintosh)

Mirror Image* Off On Advanced 
dialog box

Edge 
smoothing*

Off On Advanced 
dialog box

Photo 
Enhance

Off On Advanced 
dialog box, Main 
menu 
(Windows), Print 
dialog box 
(Macintosh)

Collate* Off On Page Layout 
menu 
(Windows), 
Layout dialog 
box (Macintosh)

Reverse 
Order*

Off On

Hardware 
resources

System speed Faster Slower -

Free hard disk 
space

Large Small

Available 
memory

Large Small

Software 
status

Running 
applications

One Many -
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Using the Speed & Progress dialog box (Windows 
only)

You can make certain print speed settings in the Speed & Progress 
dialog box. Click the Speed & Progress button on your printer 
software’s Maintenance menu. The following dialog box appears.

The available settings that are related to print speed are as follows:

High Speed Copies

To print multiple copies of your document faster, select High 
Speed Copies. This speeds up printing by using your hard disk 
space as a cache when printing multiple copies of your document.

Show Progress Meter

To display the Progress Meter every time you print, select Show 
Progress Meter.
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Disable EPSON Status Monitor 3

Select this checkbox to disable printer status monitoring with 
EPSON Status Monitor 3.

Always spool RAW datatype (Windows XP and 2000)

Select the Always spool RAW datatype checkbox to have 
Windows NT-based clients spool documents using the RAW 
format instead of the EMF (metafile) format (Windows NT-based 
applications use the EMF format by default). 

You can also use this option if documents spooled in EMF format 
do not print correctly or if you have insufficient memory or disk 
space problems.

Note:
When spooling RAW datatype, print progress displayed by the Progress 
Meter may differ from the actual print progress.

Page Rendering Mode (Windows XP and 2000)

Select this checkbox when the print speed is extremely slow or 
when the print head stops for a few minutes while printing.

Note:
When using this function, the following problems may occur:

❏ Print progress displayed in the Progress Meter window may differ 
from the actual print progress.

❏ Printing may take a longer time to start.

Print as Bitmap (Windows XP and 2000)

Select this checkbox when the print speed is extremely slow or 
when the print head stops for a few minutes while printing. Try 
this option if Always spool RAW datatype and Page 
Rendering Mode do not solve the problem.
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Monitoring Preferences

You can change settings for EPSON Status Monitor 3 in the 
Monitoring Preferences window. Right-click the shortcut icon on 
the taskbar, then select Monitoring Preferences.

You can select the settings listed in the table below:

Select Notification Displays the current error notification 
settings.

Select the checkboxes for the error 
types for which you want to receive 
notification.

Click the Default button to revert all 
Select Notification settings to their 
defaults.

Select Shortcut Icon To have a shortcut icon placed on your 
Windows taskbar, select the Shortcut 
Icon checkbox and choose an icon. 
You can click the shortcut icon to open 
EPSON Status Monitor 3, or right-click 
the icon to access some of the printer 
utilities.

Allow monitoring of shared 
printers

Select this checkbox to allow 
monitoring of a shared printer by other 
computers.
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Updating and Uninstalling Software

Follow the directions in this section if you have updated your 
computer’s operating system, if you want to update your printer 
software from a previous version, or if you need to uninstall the 
printer software.

Updating the printer software in Windows Me, XP, 
or 2000

When you update the printer software in Windows Me, XP, and 
2000, be sure to uninstall the previous printer software before you 
install the new software. Installing over the existing printer 
software results in a failure to update.
& See “Uninstalling the printer software” on page 318

Uninstalling the printer software

For Windows

Note:
❏ To uninstall applications in Windows 2000, it is necessary to log 

on as a user with administrative privileges (a user who belongs to 
the Administrators group).

❏ To uninstall applications in Windows XP, it is necessary to log on 
with a Computer Administrator account. You cannot uninstall 
applications if you log on as a Limited account user.

1. Turn off the printer and disconnect the cable from the printer.

2. For Windows Me, 98, and 2000, click the Start button, point 
to Settings, then select Control Panel.
For Windows XP, click the Start button, then select Control 
Panel.
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3. Double-click the Add/Remove Programs icon and select 
EPSON Printer Software from the list. Then, click 
Add/Remove (or Change/Remove in Windows XP and 
2000).

4. Select the EPSON Stylus Photo R2400 icon, then click OK.

5. Click OK.

Note:
❏ If you are using the USB port to connect the printer in Windows 

Me or 98, you need to uninstall an additional USB component. 
Select EPSON USB Printer Devices from the list in the 
Add/Remove Programs utility, click Add/Remove, then click OK 
when a message prompts you to restart the computer. If EPSON 
USB Printer Devices does not appear in the Add/Remove 
Programs list, double-click EPUSBUN.EXE on the printer software 
CD-ROM, then follow the on-screen instructions.

❏ If you are using the IEEE 1394 port to connect the printer in 
Windows XP, Me, or 2000, you need to uninstall an additional 
IEEE component. Select EPSON 1394.3 Printer Devices from 
the list in the Add/Remove Programs utility, then click the 
Add/Remove button and click OK when a message prompts you 
to restart the computer. If EPSON 1394.3 Printer Devices does 
not appear in the Add/Remove Programs list, double-click 
EPPPDTUN.EXE on the printer software CD-ROM, then follow the 
on-screen instructions.

For Mac OS X 

1. Quit all applications.

2. Insert the EPSON printer software CD-ROM into your 
Macintosh.

3. Double-click the Mac OS X folder

4. Double-click the Printer Driver folder.
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5. Double-click the icon.

Note:
If the Authorization dialog box appears, enter the Password or 
phrase, then click OK.

6. When the software license agreement screen appears, read the 
statement and then click Accept.

7. Select Uninstall from the menu at the upper left, and click 
Uninstall.

8. Follow the on-screen instructions.

Note:
If the printer name remains in the Print Center or Print Setup Utility 
after uninstalling the printer software, delete your printer name from 
the Print Center or Print Setup Utility. Open the Print Center or Print 
Setup Utility, select the printer name from Printer List, and then click 
Delete.

For Mac OS 9

1. Quit all applications.

2. Insert the EPSON printer software CD-ROM into your 
Macintosh.

3. Double-click the English folder, then double-click Disk 1 
folder inside the Printer Driver folder.

4. Double-click the Installer icon.
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5. Click Continue. When the software license agreement screen 
appears, read the statement and then click Accept.

6. Select Uninstall from the menu at the upper left, and click 
Uninstall.

7. Follow the on-screen instructions.

Uninstalling the User's Guide

For Windows

Note:
❏ To uninstall applications in Windows XP or 2000, it is necessary 

to log on as a user with administrator privileges: that is, a user with 
a Computer Administrator account in Windows XP or a user who 
belongs to the Administrators group in Windows 2000.

❏ In Windows XP, you cannot uninstall applications if you log on as 
a Limited-account user.

1. Turn off the printer and disconnect the cable between the 
printer and the computer.

2. In Windows XP, click the Start button, then select Control 
Panel. In Windows Me, 98, or 2000, click the Start button, 
point to Settings, then select Control Panel.

3. Double-click the Add or Remove Programs icon, then select 
ESPR2400 User's Guide from the list. Click 
Change/Remove in Windows XP or 2000, or 
Add/Remove in Windows Me or 98.

4. Click OK.
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Note:
If you are using a USB port to connect the printer in a Windows Me or 
98 environment, you also need to uninstall a USB component. Select 
EPSON USB Printer Devices from the list in the Add or Remove 
Programs utility, click Change/Remove or Add/Remove, then 
click OK when a message prompts you to restart the computer. If EPSON 
USB Printer Devices does not appear in the Add or Remove Programs 
list, double-click EPUSBUN.EXE on the printer software CD-ROM, then 
follow the on-screen instructions.

For Macintosh

Drag the User's Guide folder, located in the EPSON Stylus Photo 
R2400 folder, from the hard disk to the Trash. Then, drag the 
ESPR2400 User's Guide icon from the desktop to the Trash.

Cleaning the Printer

To keep your printer operating at its best, clean it thoroughly 
several times a year as follows.

1. Unplug the printer’s power cord.

2. Remove any paper from the sheet feeder.

3. Use a soft brush to carefully clean away all dust and dirt from 
the sheet feeder.

4. If the outer case or the inside of the sheet feeder is dirty, wipe 
it with a soft, clean cloth dampened with mild detergent. Keep 
the printer cover closed to prevent water from getting inside.

5. If the inside of the printer accidentally gets soiled with ink, 
wipe it off with a damp cloth.
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6. If ink has leaked inside the printer, wipe the inside of the 
printer with a soft, clean cloth.

w
Warning:
Be careful not to touch the gears or rollers inside the printer.

c
Caution:
❏ Do not apply grease to the metal parts under the print head 

carriage.

❏ Never use alcohol or thinner to clean the printer, as these 
chemicals can damage the components as well as the case.

❏ Be careful not to get water on the printer mechanism or 
electronic components.

❏ Do not use a hard or abrasive brush.

❏ Do not spray the inside of the printer with lubricants. 
Unsuitable oils can damage the mechanism. Contact your 
dealer or a qualified service person if lubrication is needed.

Wipe here
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Transporting the Printer

If you need to transport your printer, carefully prepare and repack 
it as described below using the original box (or a similar box that 
the printer fits snugly into) and packing materials. Follow the 
steps below.

c
Caution:
❏ When storing or transporting the printer, do not tilt it, stand 

it up vertically, or turn it upside down. Otherwise, ink may 
leak from the cartridge.

❏ Leave the ink cartridges installed. Removing the cartridges 
can dehydrate the printer head and may prevent the printer 
from printing.

1. Plug in the printer, then turn on the printer. Wait until the 
print head returns to the home position, then close the top 
printer cover. Turn off the printer, and then unplug the 
printer.

2. Disconnect the interface cable from the printer.

3. Remove the paper from the sheet feeder.
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4. Open the top printer cover again. Secure the ink cartridge 
holder to the printer with tape as shown below, then close the 
top printer cover.

5. Insert the output tray, close the paper support.

6. Attach the protective materials to both sides of the printer.

7. Repack the printer and power cord in the original box.

8. Keep the printer level during transport.

9. Be sure to remove the protective materials and tape from the 
printer before using it again.
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Options and Consumable Products

Consumable products

The following ink cartridges and Epson special media are 
available for your printer.

Ink cartridges

You can use the following cartridges with your printer.

Note:
The product numbers of ink cartridges may vary by location.

Media Types

Epson offers specially designed media for ink jet printers to meet 
most high-quality printing needs.
& See “Media type settings” on page 369

Type of ink Product numbers of ink

Light Light Black T0599

Light Magenta T0596

Light Cyan T0595

Light Black T0597

Photo Black T0591

Matte Black T0598

Cyan T0592

Magenta T0593

Yellow T0594
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Note:
❏ The availability of special media varies by location.

❏ For the latest information on media available in your area, contact 
Epson customer support web site.
& See “Contacting Customer Support” on page 379
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Exif Print and PRINT Image Matching

Exif Version 2.2 (also called Exif Print, an international standard 
for digital cameras) and PRINT Image Matching allow you to 
print fine-quality photographs using, in combination, a digital 
camera and printer that support these features.

Note:
We recommend using EPSON Easy Photo Print when using the Exif 
Print function or PRINT Image Matching function.

Effectiveness

Exif Print

When taking photographs using an Exif Print compatible digital 
camera, information about camera settings and scene conditions 
when the photograph was taken is embedded in the photo data. 
Such information includes exposure mode, white balance, gain 
control, contrast, saturation, and sharpness, among other 
attributes. The printer then corrects and enhances the photo data 
using this information and prints an image that reflects the 
original scene captured by the digital camera.
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Printout without Exif Print

Printout with Exif Print

When Exif Print data is embedded in the photo data, the printer 
interprets how to adjust and print the image.

Note:
The images above are samples. Print results depend on the printer. 
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PRINT Image Matching

PRINT Image Matching gives control of the printing process to 
the digital camera, allowing printed images to reflect the camera’s 
distinctive qualities. When taking photographs using a PRINT 
Image Matching compatible digital camera, print command 
information from the camera is embedded in the photo data. The 
print command then instructs the printer how to correct color and 
details based on information stored at the moment the photo was 
taken. Digital camera settings that create the print command 
include the gamma, color space, color balance, shadow point, 
contrast, and brightness settings, among other attributes. A 
printer equipped with PRINT Image Matching is able to interpret 
these commands and faithfully reproduce the characteristics of 
the image captured by the digital camera.

Printout without PRINT Image Matching
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Printout with PRINT Image Matching

When PRINT Image Matching data is embedded in the photo 
data, it tells the printer how to adjust and print the image.

Note:
❏ The images above are samples. Print results depend on the digital 

camera.

❏ See the relevant device instruction manual for details concerning 
the use of devices loaded with the PRINT Image Matching function.

❏ Please check with the input device manufacturer to determine 
whether it is loaded with the PRINT Image Matching function.

❏ EPSON Easy Photo Print and EPSON Darkroom Print let the user 
decide whether or not the PRINT Image Matching function is to be 
used.

❏ If EPSON Easy Photo Print or EPSON Darkroom Print is not used, 
and printing is performed from general retouch software that does 
not support PRINT Image Matching, the PRINT Image Matching 
function cannot be used.
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How to use

Take pictures using Exif Print and/or PRINT Image Matching 
compatible digital cameras, then use EPSON Easy Photo Print or 
EPSON Darkroom Print to print them. EPSON Easy Photo Print 
and EPSON Darkroom Print are is included on the software 
CD-ROM.
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Printer Specifications

Printing

Paper

Note:
Since the quality of any particular brand or type of paper may be changed 
by the manufacturer at any time, Epson cannot attest to the quality of 
any non-Epson brand or type of paper. Always test samples of paper 
stock before purchasing large quantities or printing large jobs.

Printing method On-demand ink jet

Nozzle configuration 1440 nozzles (180 × 8)
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Paper specifications

Single sheets:

Note:
❏ Poor quality paper may reduce print quality and cause paper jams 

or other problems. If you encounter problems, switch to a higher 
grade of paper.

Size A3+ (329 × 483 mm)

A3 (297 × 420 mm)

A4 (210 × 297 mm)

A5 (148 × 210 mm)

A6 (105 × 148 mm)

B4 (257 × 364 mm)

B5 (182 × 257 mm)

30 × 30 cm (12 × 12 in)

20 × 25 cm (8 × 10 in)

13 × 20 cm (5 × 8 in)

13 × 18 cm (5 × 7 in)

10 × 15 cm (4 × 6 in)

9 × 13 cm (3.5 × 5 in)

Letter 8 1/2 × 11 in

Legal 8 1/2 × 14 in

Paper types Plain bond paper.

Thickness
(for plain 
bond paper)

0.08 to 0.11 mm (0.003 to 0.004 inch)

Weight
(for plain 
bond paper)

64 g/m² (17 lb) to 90 g/m² (24 lb)
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❏ Do not load curled or folded paper.

❏ Use paper under normal conditions:
Temperature 15 to 25° C (59 to 77° F)
Humidity 40 to 60% RH

Printable area

Normal Borderless

Diagonal lines show printable area.

Single sheets and index cards

A: The minimum top margin is 3.0 mm (0.12”).

B-L: The minimum left margin is 3.0 mm (0.12”).

B-R: The minimum right margin is 3.0 mm (0.12”).

C: The minimum bottom margin is 3.0 mm (0.12”).

Thick paper

A: The minimum top margin is 20 mm (0.79”).

B-L: The minimum left margin is 3.0 mm (0.12”).

A

C

B-L B-R
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Note:
❏ Depending on the type of media being used, print quality may 

decline in the top and bottom areas of the printout, or the area 
may be smeared.

❏ Borderless printing is not available when Manual - Front is 
selected.

Roll paper

B-R: The minimum right margin is 3.0 mm (0.12”).

C: The minimum bottom margin is 20 mm (0.79”).

Standard margins

Pressing the z roll paper button after printing prints the 
cutting guideline.

If you press the z roll paper button again and send 
print data, the margin between the printouts is about 
65 mm.

If you send a print job that has multiple pages, or send 
print jobs continuously, there will be no margin 
between the printouts.
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Ink Cartridges

Light Light Black (T0599)
Light Magenta (T0596)
Light Cyan (T0595)
Light Black (T0597)
Photo Black (T0591)
Matte Black (T0598)
Cyan (T0592)
Magenta (T0593)
Yellow (T0594)

Borderless

Pressing the z roll paper button after printing prints the 
cutting guideline.

If you press the z roll paper button again and send 
print data, the margin between the printouts is about 
65 mm.

If you send a print job that has multiple pages, or send 
print jobs continuously, there will be no margin 
between the printouts.
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* Ink thaws and is usable after approximately 3 hours at 25°C (77°F).

c
Caution:
❏ Epson recommends the use of original Epson ink cartridges 

only. Products not manufactured by Epson may cause 
damage to your printer and will not be covered by Epson's 
warranties.

❏ Do not use an ink cartridge if the date on the package has 
expired.

❏ Do not refill the ink cartridge. The printer calculates the 
amount of ink remaining using an IC chip on the ink 
cartridge, so even if the cartridge is refilled, the IC chip will 
report that it is empty.

Note:
The ink cartridges packaged with your printer are partly used during 
initial setup. In order to produce high quality printouts, the print head 
in your printer will be fully charged with ink. This one-off process 
consumes a quantity of ink and subsequent cartridge sets will last for 
their full rated life.

Color Light Light Black, Light Magenta, Light Cyan, Light Black, 
Photo Black, Matte Black, Cyan, Magenta, Yellow

Cartridge life Within 6 months of opening the package, at 25°C (77°F)

Temperature Storage:
-20 to 40°C (-4 to 104°F) 

1 month at 40°C (104°F)

Freezing:*
-16°C (3.2°F)

Dimensions 12.7 mm (W) × 73.5 mm (D) × 55.3 mm (H)
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Mechanical

Paper path Auto sheet feeder, front manual feed slot, and rear 
manual feed slot entry

Dimensions Storage

Width: 615 mm (24.2 inches)

Depth: 314 mm (12.4 inches)

Height: 223 mm (8.8 inches)

Printing

Width: 615 mm (24.2 inches)

Depth: 737 mm (29.0 inches)

Height: 457 mm (18.0 inches)

Weight 11.7 kg (25.8 lb), printer body only

Paper path Capacity

Auto sheet 
feeder

About 120 sheets at 90 g/m2 (24 lb) paper

Front manual 
feed slot

One sheet at a time

Thickness: 1.3 mm only

Size: A4 (210 × 297 mm) to A3+ (329 × 483 mm)

Rear manual 
feed slot

One sheet at a time

Thickness: 0.29 to 0.48 mm

Size: A4 (210 × 297 mm) to A3+ (329 × 483 mm)
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Electrical

Note:
Check the label on the back of the printer for the voltage of your printer.

Environmental

* Without condensation

120 V Model 220-240 V Model

Input voltage range 99 to 132 V 198 to 264 V

Rated frequency range 50 to 60 Hz

Input frequency range 49.5 to 60.5 Hz

Rated current 0.5 A (Max. 0.8 A) 0.25 A (Max. 0.4 A)

Power consumption Approx. 18 W 
(ISO10561 Letter 
Pattern)
Approx. 1 W in Sleep 
mode

Approx. 18 W 
(ISO10561 Letter 
Pattern)
Approx. 1.3 W in 
Sleep mode

Temperature Operation: 
10 to 35°C (50 to 95°F)

Storage: 
-20 to 40°C (-4 to 104°F)

1 month at 40°C (104°F)

Humidity Operation:* 
20 to 80% RH

Storage:* 
5 to 85% RH
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Standards and Approvals

U.S. model:

European model:

Australian model:

Safety UL 60950
CSA C22.2 No.60950

EMC FCC Part 15 Subpart B Class B
CSA C108.8 Class B

Low Voltage Directive 73/23/EEC EN 60950

EMC Directive 89/336/EEC EN 55022 Class B
EN 55024
EN 61000-3-2
EN 61000-3-3

EMC AS/NZS CISPR 22 Class B
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System Requirements

Refer to the appropriate section below for the minimum and 
recommended computer system requirements necessary to use 
this printer.

For Windows

To use your printer, you need to have Microsoft® Windows® XP, 
Me, 98, or 2000 installed.

USB connection:
To connect your printer via a standard, shielded USB 1.1 cable, 
you need a Windows XP, 98, or 2000 pre-installed PC equipped 
with a USB port. For Windows Me users, your PC must be a 
Windows Me pre-installed model or upgraded from a 
Windows 98 pre-installed model. To use the USB 2.0 cable, you 
need a Windows XP or 2000 Pre-installed PC equipped with a USB 
2.0 port.

If you want to connect your printer to a IEEE 1394 port, you need 
a Windows XP, Me, or 2000 pre-installed PC equipped with a IEEE 
1394 port and the printer must be connected via a shielded IEEE 
1394 cable.
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Your computer should also meet the following system 
requirements.

Your computer dealer can help you update your system if it does 
not meet these requirements.

Minimum System Requirements Recommended System

Pentium 150 MHz processor for 
Windows Me

Pentium processor for Windows 98

Pentium 300 MHz processor for 
Windows XP

Pentium 133 MHz processor for 
Windows 2000

Pentium 2.0 GHz or higher

64 MB RAM for Windows Me and 98

128 MB RAM for Windows XP and 
2000

256 MB RAM or more

50 MB hard disk space for 
Windows Me and 98

200 MB hard disk space for 
Windows XP

100 MB hard disk space for 
Windows 2000

500 MB hard disk space or more for 
Windows Me and 98

1 GB hard disk space or more for 
Windows XP and 2000

USB and IEEE 1394 for Windows Me, 
XP, and 2000

USB for Windows 98

USB 2.0 and IEEE 1394

SVGA monitor SVGA monitor
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For Macintosh

To connect this printer to Apple® Macintosh® computers, you 
must use a USB cable.

Your Macintosh must also meet the following system 
requirements.

Note:
❏ For Mac OS X, to see how much memory is available, choose About 

This Mac from the Apple menu.

Minimum System Requirements Recommended System

Mac OS 9.1 or later

Mac OS X, 10.2, or later

Mac OS 9.1 or later

Mac OS X, 10.2, or later

PowerPC G3 233 MHz for Mac OS 
9.1 or later

PowerPC G3 233 MHz for Mac OS X, 
10.2, or later

PowerPC G4 for Mac OS 9.1 or later

PowerPC G4 for Mac OS X, 10.2, or 
later

128 MB RAM for Mac OS 9.1 or later

192 MB RAM for Mac OS X, 10.2, or 
later

256 MB RAM or more for Mac OS 9.1 
or later

256 MB RAM or more for Mac OS X, 
10.2, or later

50 MB hard disc space for Mac OS 
9.1 or later

50 MB hard disc space for Mac OS 
X, 10.2, or later

1 GB hard disc space or more for 
Mac OS 9.1 or later

1 GB hard disc space or more for 
Mac OS X, 10.2, or later

USB and IEEE 1394 for Mac OS 9.1 or 
later

USB and IEEE 1394 for Mac OS X, 
10.2, or later

USB 2.0 and IEEE 1394 for Mac OS 9.1 
or later

USB 2.0 and IEEE 1394 for Mac OS X, 
10.2, or later

SVGA monitor for Mac OS 9.1 or 
later

SVGA monitor for Mac OS X, 10.2, or 
later

SVGA monitor for Mac OS 9.1 or 
later

SVGA monitor for Mac OS X, 10.2, or 
later
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❏ For Mac OS 9, the memory requirements above are for printing on 
Letter size paper. These requirements may vary depending on the 
size of the paper, the type of application you are using, and the 
complexity of the document that you want to print.

In addition to these system and memory requirements, you need 
20 MB of free hard disk space to install your printer software. To 
print, you also need extra hard disk space amounting to about 
twice the size of the file that you want to print.

Using the User's Guide

Refer to the appropriate section below for the minimum browser 
requirements necessary to use the User's Guide.

For Windows

Browser Microsoft Internet Explorer 4.0 or later 
(recommended)

For Macintosh

Browser Microsoft Internet Explorer 4.0 or later 
(recommended)
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Paper Handling

Loading single sheets of paper

Follow the steps below to load paper into the printer.

1. Open the paper support, then slide out the paper support 
extension.

2. Make sure the output tray is ejected, and the output tray 
extension is slid out.

3. Position the left edge guide so that the distance between the 
two edge guides is slightly wider than the width of your 
paper.

4. Fan a stack of paper, then tap it on a flat surface to even the 
edges.

5. Load the paper with the printable side up so it is against the 
right edge guide, and slide it into the sheet feeder. Then slide 
the left edge guide against the left edge of the paper.
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During printing the left edge guide automatically moves 3 
mm to the left. Do not move it back manually

Note:
❏ Leave enough space in front of the printer for the paper to be 

fully ejected.

❏ Always load paper into the sheet feeder short edge first.

❏ Make sure that the paper stack is flush with or lower than the 
triangular load-limit mark on the edge guide.

❏ Make sure you use the “Multi-Sheet Matte Support” when 
loading more than two sheets of thick paper larger than A4 size. 
For instructions on how to attach the “Multi-Sheet Matte 
Support”. See the following section.
& See “Attaching the Multi - Sheet Matte Support” on page 
357.

Loading Thick Paper

Follow the steps below to load thick paper into the front manual 
feed slot. You can use A4 to A3+ size thick paper with a thickness 
of 1.3 mm.

c
Caution:
❏ If you load the thick paper incorrectly you may damage the 

printer.

❏ Be sure to insert the thick paper following the steps described 
below. If you insert the thick paper in a different way (for 
example, if you insert the thick paper into the printer and 
then turn the power off and then back on), the printer may be 
damaged.

❏ Be sure to remove the roll paper holder when printing on thick 
paper. Otherwise, the paper is ejected and a paper jam error 
occurs.
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1. Make sure that the printer is on and the power light is not 
flashing.

c
Caution:
Be sure to insert the thick paper while the power is on. 
Otherwise, automatic print position adjustment may not take 
place after inserting the thick paper.

2. Open the top printer cover. Then open the front printer cover 
completely.

3. Close the top printer cover.

4. Load the thick paper with the printable side facing up.

Note:
Only print one sheet of thick paper at a time.
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5. Slide the thick paper into the printer until the back edge is 
level with the alignment arrows on the front manual feed slot.

6. Slide the left edge guide against the left edge of the thick 
paper.

7. Press the ) paper button. The thick paper is set 
automatically. When the P power light stops flashing, the 
operation is complete.

Note:
Since the paper feeds through the printer from the front to the rear, 
make sure there is enough space at the rear of the printer for the thick 
paper to eject completely.

Loading Single Sheets of Paper into the Rear 
Manual Feed Slot

Follow the steps below to load paper into the rear manual feed 
slot. You can use A4 to A3+ size paper with a thickness of 0.29 to 
0.48 mm.

1. Turn on the printer.
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2. Slide out the output tray and the output tray extension.

3. Remove the roll paper holder if it is attached.

4. Make sure the rear edge guide for the rear manual feed slot is 
flush with the left side of the printer.
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5. Attach the rear sheet guide.

6. Slide the edge guide on the rear sheet guide to make enough 
space for the paper you are loading.

7. Using the rear sheet guide, insert the paper into the rear 
manual feed slot, flush with the right edge guide.
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8. Slide the edge guide on the rear sheet guide until it is flush 
with the paper.

9. Insert the paper into the rear manual feed slot until the paper 
meets resistance. Maintain a constant pressure against the 
paper until you feel the printer pull the paper in slightly. Let 
go of the paper to allow the printer to adjust the paper 
position.

10. The procedure is finished when the P power light stops 
flashing and remains lit.
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11. Open the top printer cover and make sure the paper is loaded 
correctly.

Note:
❏ You can only load one sheet at a time.

❏ You can leave the rear sheet guide attached to the printer, except 
when printing on roll paper.

❏ Before loading the paper, first make sure that it is flush with the 
edge guide. If the media is not fed straight into the printer, a 
paper jam error occurs and the ) paper light starts flashing.

If a paper error occurs, hold down the z roll paper button for 
three seconds. The printer feeds in reverse and the paper is 
ejected from the rear. Press the ) paper button to clear the 
error and reload the paper. The error also appears in the status 
monitor. If you press EJECT, the paper is ejected from the front 
or the rear of the printer.
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12. Make sure that Manual - Roll is selected in the printer driver. 
For Windows, select Manual - Roll as the Source setting on 
the Main tab. For Mac OS X, select Manual - Roll for the paper 
size you are using (for example A4 Manual - Roll) as the Paper 
Size from the Page Setup dialog box. For Mac OS 9, select 
Manual - Roll as the Paper Source from the Page Setup dialog 
box.

Using special media

You can achieve good results with most types of plain bond paper. 
However, coated paper and glossy film provide superior 
printouts because they absorb less ink.

Epson provides special media that are formulated for the ink used 
in Epson ink jet printers. Epson recommends using media 
distributed by Epson to ensure high-quality results.
& See “Media Types” on page 326 for a complete list of these 
products.

When loading special media distributed by Epson, read the 
instruction sheets packed with the media first and keep the 
following points in mind.

c
Caution:
❏ Cleaning sheets packaged with Epson special media should 

not be used with this printer. The cleaning function 
performed by these sheets is not necessary with this type of 
printer, and the sheets could jam in the printer.

❏ A paper jam occurs if two or more sheets of thick paper larger 
than A4 size are loaded without the multi-sheet matte 
support. For information on attaching the multi-sheet matte 
support, see the following section.
& See “Attaching the Multi - Sheet Matte Support” on page 
357.
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Note:
❏ Load the media into the sheet feeder printable side up. See the 

instruction sheets packed with the media to determine which side is 
the printable side. Some types of media have cut corners to help 
identify the correct loading direction, as shown in the illustration.

❏ Make sure you choose the appropriate feeder method and the 
appropriate driver setting for the media you are using.

❏ Depending on the media type, you can also load single sheets of paper 
into the rear manual feed slot. For instructions on how to load single 
sheets into the rear manual feed slot, see the following.
& See “Loading Single Sheets of Paper into the Rear Manual Feed 
Slot” on page 349

❏ If the paper is curled, flatten it or curl it slightly in the opposite 
direction before loading. Printing on curled paper may cause ink to 
smear on your printout.

cut corner
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Loading capacities for Epson special media

Refer to the chart below to find the loading capacities for Epson 
special media.

Media Type Loading Capacity

Bright White Ink Jet Paper Up to 80 sheets

Photo Quality Ink Jet Paper Up to 50 sheets for A3+ and A3

Up to 100 sheets for A4

Matte Paper - Heavyweight A3+, A3: Up to 10 sheets when the 
multi-sheet matte support is 
attached**

A3+, A3: One sheet at a time when the 
multi-sheet matte support is not 
attached

A4: Up to 20 sheets

Archival Matte Paper A3+, A3: Up to 10 sheets when the 
multi-sheet matte support is 
attached**

A3+, A3: One sheet at a time when the 
multi-sheet matte support is not 
attached

A4: Up to 20 sheets

Double-Sided Matte Paper One sheet at a time

Premium Glossy Photo Paper A3+, A3: Up to 10 sheets

A4, 10 × 15 cm (4 ×  6 in): Up to 20 
sheets

Premium Luster Photo Paper A3+, A3: Up to 10 sheets

Premium Semigloss Photo Paper A3+, A3: Up to 10 sheets

A4: Up to 20 sheets

Watercolor Paper-Radiant 
White*

One sheet at a time

UltraSmooth Fine Art Paper* One sheet at a time

Velvet Fine Art Paper* One sheet at a time
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* This paper type is rear manual feed slot paper. 
For instructions on how to load paper into the rear manual feed slot, see 
“Loading Single Sheets of Paper into the Rear Manual Feed Slot” on page 
349.

** When loading two or more sheets of thick paper, you must attach the 
multi-sheet matte support. For instructions on how to attach the multi-sheet 
matte support, see “Attaching the Multi - Sheet Matte Support” on page 357.

Attaching the Multi - Sheet Matte Support

1. Open the paper support and slide out the extensions.

Proofing Paper Semimatte One sheet at a time

Photo Quality Self Adhesive 
Sheet

One sheet at a time
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2. Attach the multi-sheet matte support. Hook the two large 
hooks over the centre of the paper support extension.

c
Caution:
Only use the multi-sheet matte support when you are loading 2 
or more (10 maximum) sheets of thick paper larger than A4 size. 
Remove it when printing using other media.

Storing Epson Photo Paper

Return unused paper to the original package as soon as you finish 
printing. Epson recommends storing your printouts in a 
resealable plastic bag. Keep them away from high temperature, 
humidity, and direct sunlight.
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Loading and removing roll paper

Loading the roll paper

With the roll paper holder attached to the printer, you can print 
on roll paper, which is convenient for banner printing. When you 
are printing on roll paper, keep the following in mind:

❏ Load the paper printable side up.

❏ Use flat, undamaged paper. If the paper is curled, flatten it 
before loading to avoid paper feed problems.

❏ Always handle the paper by the edges.

❏ Provide ample space in front of the printer for the paper to 
eject fully.

❏ Make sure the front printer cover is open and the output tray 
is stored in the printer.

❏ Check that the end of the paper is cut cleanly, perpendicularly 
to the length of the paper. If the paper is cut diagonally or 
uncleanly, it may not feed smoothly or the printer may print 
beyond the edge of the paper.

❏ Use Epson media to ensure high-quality results.

❏ Always check the ink levels before printing on roll paper, as 
replacing ink cartridges while the roll paper is loaded can 
smear the paper.

❏ We recommend replacing the roll paper with a new roll when 
there is 20 cm remaining. Otherwise, print quality may be 
compromised on the remaining portion.

Follow the procedure described below to install the roll paper 
holders and load the roll paper.
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1. Attach the roll paper holders to the roll paper.

Note:
Remove the protective sheet after putting together the roll paper and 
the holders.

2. Using a triangle, check that the end of the roll is cut 
perpendicularly to the edges, as shown.

c
Caution:
Always use a triangle or other tool to ensure that the end of 
the roll is cut perpendicularly. A diagonal cut may cause 
paper feed problems.

3. Turn on the printer.
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4. Make sure that the output tray extension is extended and the 
output tray is stored in the printer.

5. Gently swing out the roll paper support.
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6. Insert the roll paper holders into the slots at the rear of the 
printer.

7. Insert the paper into the rear manual feed slot as far as it will 
go, flush with the right edge guide. Slide the left edge guide 
against the left edge of the paper.
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c
Caution:
Do not load the roll paper into the sheet feeder for cut sheets.

8. Hold the paper in place with your hand for about three 
seconds in order to load the paper correctly. The paper will 
feed into the printer automatically.

Note:
If the roll paper is not feeding easily, flatten it. To flatten the roll 
paper, place it printable side up between the pages of the instruction 
booklet packaged with the roll paper, to protect it. Then, roll the 
booklet in the opposite direction to the paper’s curl.

9. Open the top printer cover and make sure that the paper is 
feeding correctly. If it is not straight, eject and reload the 
paper.
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“Removing the roll paper” on page 365

Note:
Turn the roll paper knobs to take in the slack of the roll paper.

Cutting the roll paper

1. Press the z roll paper button to feed the paper. A cutting 
guideline is printed on the roll paper.

c
Caution:
Do not press the z roll paper button for more than three 
seconds. Otherwise the roll paper will feed backward and your 
print out may be damaged.

2. Cut the paper along the printed line. Never pull the paper as 
you cut it, otherwise the printout may be damaged. When 
cutting the paper, do not cross the line towards the printer, as 
this may cause paper feed problems.

Note:
Epson recommends that you use a triangle or other tool to ensure 
that the end of the roll is cut perpendicularly. A diagonal cut may 
cause paper feed problems.
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3. To print the next document, press the z roll paper button to 
feed the paper back to the printing position.

4. Turn the roll paper knobs to take in the slack of the roll paper.

Removing the roll paper

1. After cutting the paper, hold down the z roll paper button 
for about 3 seconds. The paper feeds in reverse to a position 
where it can be easily removed from the rear manual feed slot 
at the back of the printer. The ) paper out light flashes. If it 
does not feed to this position, repeat this step.

2. Turn back the roll paper knob and roll up the roll paper. 
Gently remove the paper.

3. Press the m paper button to clear the ) paper out light.
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Storing Epson roll paper

Return unused paper to the original package as soon as you finish 
printing. Store your printouts in a resealable plastic bag. Keep 
them away from high temperature, humidity, and direct sunlight.

Driver Settings

Accessing the printer software for Windows

You can access the printer software from most Windows 
applications, from the Windows Start menu, or the taskbar.

When you access the printer software from a Windows 
application, the settings that you make apply only to the 
application you are using.

When you access the printer software from the Start menu or the 
taskbar, the settings that you make apply to all of your Windows 
applications.

Refer to the appropriate section below.

From Windows applications

Follow the steps below to access the printer software.

1. Click Print or Print Setup on the File menu.

2. In the dialog box that appears, click Printer, Setup, Options, 
Preferences, or Properties. (Depending on your application, 
you may need to click any one or a combination of these 
buttons.) The printer software starts.
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From the Start menu

Follow the steps below to access the printer software.

1. For Windows XP, click Start, Control Panel, then click 
Printers and Faxes. (If the Control Panel is in Category View, 
click Printers and Other Hardware, then click Printers and 
Faxes.)

For Windows Me, 98, and 2000, click Start, point to Settings, 
then click Printers.

2. For Windows XP and 2000, select your printer, then click 
Printing Preferences on the File menu.

For Windows Me and 98, select your printer, then click 
Properties on the File menu.

The printer software opens.

From the taskbar

Right-click the printer icon on the taskbar, then select Printer 
Settings.

Accessing the printer software for Mac OS X

These dialog boxes can be accessed as described below.

Dialog Box How to Access

Page Setup Click Page Setup on the File menu of your application.

Print Click Print on the File menu of your application.
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Accessing the printer software for Mac OS 9

These dialog boxes can be accessed as described below.

In addition, the dialog boxes below are accessed from the Print 
dialog box.

EPSON Printer 
Utility

Double-click the EPSON Printer Utility icon in the 
Applications folder in Macintosh HD. Select your 
printer from the Printer List, then click OK.

Open the Applications folder on your hard drive, then 
open the Utilities folder and double-click the Print 
Center or Printer Setup Utility icon. Select any one of 
the appropriate printers from the list, then click the 
Configure or Utility button.

Dialog Box How to Access It

Print Click Print on the File menu of your application or click 
Options in the Page Setup dialog box.

Page Setup Click Page Setup on the File menu of your application.

Layout Click the  Layout icon button in the Print dialog box.

Utility Click the  Utility icon button in the Print or Page Setup 
dialog box.

Dialog Box How to Access It

Background 
Printing

Click the  Background Printing icon button in the Print 
dialog box.

Preview Click the  Preview icon button in the Print dialog box 
and then click Preview.

Save File Click the  Preview icon button in the Print dialog box 
until the Print button changes into the Save File button, 
then click the Save File button.
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Media type settings

The Media Type setting determines what other settings are 
available, so you should always make this setting first.

Refer to the corresponding media type under which it is grouped 
(shown in larger type). For some media, there are several Media 
Type settings from which to choose.

Plain Paper

Photo Quality Ink Jet Paper

Archival Matte Paper

Double-Sided Matte Paper

Plain paper

EPSON Bright White Ink Jet Paper (A4) S041442

EPSON Photo Quality Ink Jet Paper (A3+) S041069

EPSON Photo Quality Ink Jet Paper (A3) S041068

EPSON Photo Quality Ink Jet Paper (A4) S041061

EPSON Photo Quality Self Adhesive Sheet (A4) S041106

EPSON Archival Matte Paper (A3+) S041340

EPSON Archival Matte Paper (A3) S041344

EPSON Archival Matte Paper (A4) S041342

EPSON Double-Sided Matte Paper (A4) S041569
S041570
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Matte Paper-Heavyweight

Premium Glossy Photo Paper

EPSON Matte Paper-Heavyweight (A3+) S041263
S041264
S041265

EPSON Matte Paper-Heavyweight (A3) S041260
S041261
S041262

EPSON Matte Paper-Heavyweight (A4) S041256
S041258
S041259

EPSON Premium Glossy Photo Paper (A3+) S041289
S041316

EPSON Premium Glossy Photo Paper (A3) S041288
S041315

EPSON Premium Glossy Photo Paper (A4) S041285
S041287
S041297
S041624

EPSON Premium Glossy Photo Paper
(10 × 15 cm (4 × 6 in))

S041692
S041706
S041729
S041730
S041750
S041758
S041761
S041822
S041826

ESPON Premium Glossy Photo Paper 
(329 mm × 10 m)

S041378
S041379

EPSON Premium Glossy Photo Paper 
(210 mm × 10 m)

S041376
S041377
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Premium Luster Photo Paper

Premium Semigloss Photo Paper

Velvet Fine Art Paper

Watercolor Paper-Radiant White

EPSON Premium Luster Photo Paper (A3+) S041407

EPSON Premium Luster Photo Paper (A3) S041406

EPSON Premium Luster Photo Paper 
(329 mm × 10 m)

S041409

EPSON Premium Luster Photo Paper 
(210 mm × 10 m)

S041408

EPSON Premium Semigloss Photo Paper (A3+) S041328

EPSON Premium Semigloss Photo Paper (A3) S041334

EPSON Premium Semigloss Photo Paper (A4) S041332

EPSON Premium Semigloss Photo Paper 
(329 mm × 10 m)

S041338

EPSON Premium Semigloss Photo Paper 
(210 mm × 10 m)

S041336

EPSON Premium Semigloss Photo Paper 
(100 mm × 8 m)

S041330

EPSON Velvet Fine Art Paper (A3+) S041637

EPSON Watercolor Paper-Radiant White (A3+) S041352
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Proofing Paper Semimatte

UltraSmooth Fine Art Paper

Note:
The availability of special media varies by location. For the latest 
information on media available in your area, contact Epson customer 
support web site.
& See “Contacting Customer Support” on page 379

Making User Defined paper sizes for Windows

Defining a custom paper size

You can define a custom paper size and add it to the list.

1. Select User Defined as the Size setting. The User Defined 
Paper Size dialog appears.

EPSON Proofing Paper Semimatte (A3+) S041744

EPSON Proofing Paper Semimatte 
(329 mm × 10 m)

S041668

EPSON UltraSmooth Fine Art Paper (A3+) S041896
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2. Type a name for your paper size in the Paper Size Name box.

3. Choose either cm or inch as the Unit setting.

4. Specify the width and height for your paper size. The range 
of available size is shown under each text box.

Note:
Although you can define a large range of paper sizes, the size of paper 
you can feed into the printer is limited by the size of the sheet feeder 
on your printer. Therefore, if necessary, it is recommended that you 
reduce or enlarge documents to fit paper within the range of your 
printer's capabilities.

5. Click Save, then click OK to return to the Main menu.Your 
new user-defined paper size name appears as the Size setting.

To delete a custom paper size from the list, open the User Defined 
Paper Size dialog and select the user-defined paper size name you 
want to delete. Then, click Delete.
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Making User defined paper sizes for Mac OS X

Defining a custom paper size

You can define a custom paper size. You can either create a new 
paper size, or base your custom paper size on a pre-existing paper 
size. Refer to the appropriate section below.

Creating a new paper size

If the appropriate paper size is not included on the Paper Size list 
in the Page Setup dialog box, follow the steps below to define a 
new paper size.

1. In the Page Setup dialog box, select Stylus Photo R2400 as the 
Format for setting. Then, select Custom Paper Size as the 
Settings setting. The following dialog box appears.

2. To define a new paper size, click New. The dialog box now 
allows you to enter a name for the new size.

3. Type a unique name for the paper size.

4. Specify the Paper Size and Printer Margins by typing in the 
appropriate text boxes.
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Note:
❏ Although you can define a large range of paper sizes, the size of 

paper you can feed into the printer is limited by the size of the 
sheet feeder on your printer. Therefore, if necessary, it is 
recommended that you reduce or enlarge documents to fit paper 
within the range of your printer’s capabilities.

❏ When printing on thick paper, set the top and bottom margins 
to 0.79 inches, and set the left and right margins to 0.12 inches.

5. Click Save and then click OK to close the Custom Paper Size 
dialog box. The paper size name you created is now available 
on the Paper Size list in the Page Setup dialog box.

To delete a custom paper size, select Custom Paper Size from 
the Settings pop-up menu, select the paper size from the list, 
and then click Delete.

Copying a pre-existing paper size to use as a template

Follow the steps below to copy an existing paper size to use as a 
template.

1. Select the existing paper size to be copied and click 
Duplicate.
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2. Specify the Paper Size and Printer Margins by typing in the 
appropriate text boxes.

3. Click Save and then click OK to close the Custom Paper Size 
dialog box. The paper size is now available on the Paper Size 
list in the Page Setup dialog box.

Making User Defined paper sizes for Mac OS 9

Defining a custom paper size

You can define a custom paper size. To do so, you can either create 
a new paper size, or base your custom paper size on a pre-existing 
paper size. Refer to the appropriate section below.

Creating a new paper size

If the appropriate paper size is not included in the Paper Size list 
in the Page Setup dialog box, follow the steps below to define a 
new custom paper size.

1. In the Page Setup dialog box, click Customize. The following 
dialog box appears.
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2. To define a new paper size, click New. The dialog box now 
allows you to enter a name for the new size.

3. Type a unique name for the paper size in the Paper Size list.

4. Choose either cm or inch as the Unit setting.

5. Enter the width and the height of your paper by typing the 
values in the appropriate text boxes.

Note:
Although you can define a large range of paper sizes, the size of paper 
you can feed into the printer is limited by the size of the sheet feeder 
on your printer. Therefore, if necessary, it is recommended that you 
reduce or enlarge documents to fit paper within the range of your 
printer's capabilities.

6. Specify the margins by typing in the Margin text boxes or by 
manipulating the margins in the preview image.

Note:
When printing on thick paper, set the top and bottom margins to 20 
mm, and the left and right margins to 3 mm.

7. Click OK to return to the Page Setup dialog box.
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You can define up to 100 paper sizes. The paper size names you 
create will appear in the Paper Size list.

To delete a custom paper size, click Customize, select the paper 
size from the list in the Custom Paper dialog box, then click 
Delete.

Copying a pre-existing paper size to use as a template

Follow the steps below to copy an existing paper size to use as a 
template.

1. Select the existing paper size to be copied and click Copy.

2. Choose either cm or inch as the Unit setting.

3. Specify the margins by typing in the Margin text boxes or by 
manipulating the margins in the preview image.

4. Click OK.
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Appendix A

Customer Support

Contacting Customer Support

If your Epson product is not operating properly and you cannot 
solve the problem using the troubleshooting information in your 
product documentation, contact customer support services for 
assistance. Check your Pan-European Warranty Document for 
information on how to contact EPSON Customer support. They 
will be able to help you much more quickly if you give them the 
following information:

❏ Product serial number
(The serial number label is usually on the back of the product.)

❏ Product model

❏ Product software version
(Click About, Version Info, or similar button in the product 
software.)

❏ Brand and model of your computer

❏ Your computer operating system name and version

❏ Names and versions of the software applications you 
normally use with your product
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Technical Support Web Site

Go to http://www.epson.com and select the Support section of 
your local EPSON web site for the latest drivers, FAQs, manuals 
and other downloadables.

Epson's Technical Support Web Site provides help with problems 
that cannot be solved using the troubleshooting information in 
your printer documentation.
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Glossary

The following definitions apply specifically to printers.

automatic roll paper cutter
The built-in paper cutter, which automatically cuts images printed continuously 
on roll paper.

Background Printing
When background printing is on, the computer can be used for other operations 
while printing a document. When it is off, the computer will suspend all other 
operations while printing a document, but print data will be sent to the printer 
more quickly.

banding
The horizontal lines that sometimes appear when printing graphics. See also 
MicroWeave.

Bluetooth
A wireless technology that enables different devices to communicate without the 
need for cable connections.

Borderless printing
A printing mode that allows you to print without margins on all four sides of the 
paper.

brightness
The lightness or darkness of an image.

CMYK
Cyan (blue-green), magenta, yellow, and black. These colored inks are used to 
create the printed colors in the subtractive system.

Collate
A setting that has the printer print copies of multiple-page documents in 
complete sets rather than print copies of the document page by page.

color matching
Generic term for methods of processing color data so that colors displayed on a 
computer screen closely match colors in printouts. A variety of color-matching 
software or systems are used for different occasions. See also ColorSync and ICM 
(Image Color Matching).
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ColorSync
Macintosh software that is designed to help you achieve the color matching. See 
also color matching.

Contrast
A setting that maximizes or minimizes the difference between the bright and dark 
parts of an image.

default
A value or setting that takes effect when the equipment is turned on, reset, or 
initialized.

DMA
Direct Memory Access. A data transfer feature that bypasses a computer’s CPU 
and allows direct communication between a computer and peripheral devices 
(like printers), and between one peripheral device and another.

Double-Sided Printing
A printing mode that allows you to print on both sides of the paper.

dpi
Dots per inch. The dpi measures the resolution. See also resolution.

drive
A memory device, such as a hard disk, CD-ROM, or floppy disk drive. In 
Windows, a letter is assigned to each drive for easy management.

driver
Software that sends instructions to a computer peripheral to tell it what to do. 
For example, your printer driver accepts print data from your word processor 
application and sends instructions to the printer on how to print this data. 
Together, the printer driver and printer utilities are referred to as “printer 
software”. See also printer software.

economy printing
Printing in which images are printed with fewer dots to save ink.

Edge Smoothing
Improves the print quality of low-resolution images by smoothing jagged edges 
and lines. This setting has no effect on high-resolution images or on text.

EPSON MonitorIV
A utility for Macintosh that allows you to manage print jobs that are in a print 
queue. This utility also shows the status of the job currently being printed. (See 
print queue)
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EPSON StatusMonitor
A utility for Macintosh that monitors the printer status. If the StatusMonitor 
detects a printer error, it will inform you with an error message.

EPSON Status Monitor 3
A utility for Windows that provides printer status information, such as the 
amount of ink remaining, and checks for printer errors.

Finest Detail
This printer software setting automatically makes your printouts sharper and 
clearer, especially for text. Be aware that this may increase the time required for 
printing.

Fit to Page printing
A printing mode that automatically enlarges or reduces the size of your 
document to fit the paper size selected in the printer software.

font
A set of type characters of one style and size.

Gamma
A setting that controls image contrast by modifying the mid-tones and mid-level 
grays.

grayscale
A scale of shades of gray from black to white. Grayscale is used to represent colors 
when printing with black ink only.

Head Cleaning utility
A utility that cleans the print head, allowing the print head nozzles to deliver ink 
properly.

high speed printing
Printing in which the print head prints images in both directions as it moves back 
and forth. This provides faster printing.

ICM (Image Color Matching)
The color matching method used by Windows. See also color matching

ink cartridge
Contains the ink that your printer uses to print.

ink jet
A method of printing in which each letter or symbol is formed by precisely 
spraying ink onto paper.
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Ink Levels
A graphic display of the amount of ink remaining in each cartridge.

interface
The connection between the computer and the printer. See also parallel interface 
and USB interface.

interface cable
The cable that connects the computer to the printer.

local printer
The printer connected to the computer’s port directly by an interface cable.

margins
The space around the edge of the paper outside of the printable area. See also 
printable area

media
Materials upon which data is printed, such as plain paper, special paper, and 
transparency film.

MicroWeave
Printing in which images are printed in finer increments to reduce the possibility 
of banding. See also banding.

Mirror Image
This printer software setting flips your printout, left to right. 

monochrome
Printing which uses only one color of ink, usually black.

Nozzle Check utility
A utility that checks the print head nozzles to see if they are clogged and need to 
be cleaned.

nozzles
Fine tubes in the print head through which ink is sprayed onto the page. Print 
quality may decline if the print head nozzles are clogged.

operation check
A method for checking the operation of the printer. When you perform a printer 
operation check, the printer prints some information codes followed by a nozzle 
check pattern.
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Orientation
Settings that determine the orientation of your printout. Select between Portrait 
(tall) or Landscape (wide).

Pages Per Sheet printing
A printing mode that allows you to print two or four pages on a single sheet of 
paper.

parallel interface
An interface that is used for one-to-one connection between a computer and a 
printer. See also interface.

PhotoEnhance
A printing mode that provides a variety of image correction settings that you can 
apply to your photos before printing.

port
An interface channel through which data is transmitted between devices.

Poster Printing
A printing mode that allows you to enlarge a single document page to cover 4, 
9, or 16 printed sheets of paper and put them together to make a poster.

printable area
The area of a page on which the printer can print. It is smaller than the physical 
size of the page due to margins.

printer driver
See driver.

printer software
The printer software which comes with your printer includes a printer driver and 
printer utilities. The printer driver lets you choose from a wide variety of settings 
to get the best results from your printer. The printer utilities help you check the 
printer and keep it in top operating condition. See also driver and utilities.

printer utilities
See utilities.

Print Head Alignment utility
A utility that aligns the print head so images will print clearly. Used when printed 
images are blurry, or when misaligned vertical lines or horizontal bands appear 
in the printout.
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PRINT Image Matching
This system enables stunning printing to be achieved easily through the 
combination of a digital camera loaded with the PRINT Image Matching function 
and a printer that supports such matching. Print commands are attached to photo 
data during digital camera photography and the printer adheres to these 
commands to print photos with the color match that optimally fulfills the 
objectives of the digitally composed shots.

Print Preview
A setting that allows you to see how your document will look before actually 
printing it.

print queue
A waiting line in which print jobs that are sent to the printer via network are 
stored until they can be printed.

Profiles
Standards that allow different devices to operate with one another using 
Bluetooth wireless technology. Profiles are defined by the uses and features they 
allow devices to perform, such as printing or scanning from a computer. To share 
this information, the devices must be compatible with the same profile.

Quality Option settings
A number of print quality settings that are available in the printer software.

Reduce/Enlarge Document
A printing mode that adjusts the printed size of your document.

reset
To return a printer to its defaults by turning the printer off and then quickly back 
on.

resolution
The number of dots used to represent an image, expressed as (horizontal dots) ×  
(vertical dots).

Reverse Order
A setting that allows you to print your documents in reverse order, starting with 
the last page.

RGB
Red, green, and blue. These colors, in phosphors irradiated by a cathode ray tube 
(CRT) monitor's electron gun, creates the screen colors with additive mixture.

Rotate 180°
A setting that rotates the page to be printed 180 degrees.
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Saturation
A setting that modifies the vividness of color. The lower the saturation, the duller 
the colors. The higher the saturation, the more vivid the colors.

spool
The first step in printing, in which the printer software converts the print data 
into codes that your printer understands. This data is then sent directly to the 
printer or to the print server.

spool manager
The software that converts print data into codes that your printer understands. 
See also spool.

sRGB
The color management method used to maintain color consistency between 
devices which adhere to the sRGB standard.

Status Monitor
The software that allows you to check the printer’s status.

USB interface
Universal Serial Bus interface. Enables the user to connect up to 127 peripheral 
devices (such as keyboards, pointing devices, and printers) to the computer 
through a single, general-purpose port. USB hubs allow you to add additional 
ports. See also interface.

utilities
Software that allows you to monitor and maintain your printer. Together, utilities 
and the printer driver are referred to as “printer software”. See also printer 
software.

Watermark printing
A printing mode that allows you to print text or an image as a watermark on your 
printout.
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Cartridge cover, 12
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Custom Settings dialog box
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Double-Sided printing, 75
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Edge guides, 10
EPSON Creativity Suite

Introduction, 198
EPSON Easy Photo Print

Introduction, 198
EPSON File Manager

Introduction, 198
EPSON Monitor 3, 245 to 248
EPSON Monitor3, 245
EPSON Spool Manager, 238
EPSON StatusMonitor (Macintosh), 194
EPSON Status Monitor 3 (Windows), 148
EPSON Web-To-Page

Introduction, 197
Error Indicators, 269
Error notification

Macintosh, 243
Windows, 153

Exif Print, 328

F

Fit to page printing, 91
Front edge guide, 12
Front manual feed slot, 12
Front printer cover, 10

G

Gamma
Macintosh, 181
Windows, 135

Glossary, 381

H

Head Cleaning, 252

I

IEEE 1394 interface cable connector, 11
Ink cartridges, 326

Replacing, 209
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Ink out light, 12

L

Layout dialog box (Macintosh), 192
Lights, 13

M

Main menu (Windows), 125
Maintenance Menu (Windows), 147
Media

Media type settings, 369
Using special media, 354

Monitoring preferences, 153
Multi-page printing

Macintosh, 193
Windows, 145

N

Network printing
Mac OS 9, 310
Mac OS X, 309
Windows Me and 98, 306
Windows XP and 2000, 302

Nozzle checking, 248

O

Online help
Macintosh, 195
Windows, 154

Output tray, 10
Output tray extension, 10

P

Page Layout Menu (Windows), 144
Page Setup dialog box (Macintosh), 173
Page Setup dialog box (Mac OS X), 157
Pages per sheet printing, 96
Paper, 346

Specifications, 333
Paper support, 10
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Paper support extension, 10
PhotoEnhance settings

Macintosh, 182
Windows, 136

PIF DESIGNER
Introduction, 197, 198

Poster printing, 105
Preview feature

Macintosh, 189
Windows, 127

Printable area specifications, 335
Print dialog box (Mac OS X), 159
Printer

cleaning, 322
transporting, 324

Printer driver
Introduction, 196

Printer parts, 10
Print head, 12

alignment, 265
cleaning, 252
nozzle checking, 248

Print Head Alignment utility, 265
PRINT Image Matching, 330
Printing tips, 231, 236, 237
Print speed, increasing, 313
Print time setting, 187
Progress meter, 236

R

Reduce/Enlarge setting
Macintosh, 174
Windows, 145

Reference Guide
Introduction, 196

Roll paper edge guides, 11
Roll paper feeder, 11
Roll paper holder, 11
Roll paper knob, 11
Roll paper support, 10
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Safety information, 14, 19
Saving settings

Macintosh, 186
Windows, 142

Specifications, 333
electrical, 340
mechanical, 339
paper, 333
printing, 333
standards and approvals, 341

Speed & Progress settings
Windows, 315

Spool Manager, 238
Status Monitor

Windows, 238
System Requirements, 342, 344, 345

T

Technical support, 379
Top printer cover, 10

U

Uninstalling the driver, 318
Updating the driver, 318
USB interface cable connector, 11
Utilities

Macintosh, 170, 193
Windows, 147

W

Watermark printing, 114
392 Index


	Contents
	Printer Parts and Control Panel Functions
	Printer Parts
	Control Panel
	Buttons
	Lights


	Safety Instructions
	Important Safety Instructions
	When setting up your printer
	When choosing a place for the printer
	When using the printer
	When handling the ink cartridges

	Warnings, Cautions, and Notes

	How to Print
	Introduction
	Printing Photos
	Handling single sheets of paper
	Driver settings for Windows
	Driver settings for Mac OS X
	Driver settings for Mac OS 9

	Printing on Roll Paper
	Handling roll paper
	Driver settings for Windows
	Driver settings for Mac OS X
	Driver settings for Mac OS 9

	Printing on Thick Paper
	Driver settings for Windows
	Driver settings for Mac OS X
	Driver settings for Mac OS 9

	Printing Text
	Handling single sheets of paper
	Driver settings for Windows
	Driver settings for Mac OS X
	Driver settings for Mac OS 9

	Printing Web Pages
	Handling single sheets of paper
	Using EPSON Web-To-Page for Windows
	Using the Printer Driver for Mac OS X
	Using the Printer Driver for Mac OS 9


	Various Printing Options
	Introduction to Various Printing Options
	B&W Photo Printing
	Compatible media
	Driver settings for Windows
	Driver settings for Mac OS X
	Driver Settings for Mac OS 9

	Borderless Printing
	Compatible media
	Preparing the print data
	Printing from EPSON Easy Photo Print
	Printing from the printer driver

	Double-Sided Printing
	Standard double-sided printing for Windows
	Standard double-sided printing for Mac OS 9
	Folded Booklet double-sided printing for Windows
	Folded Booklet double-sided printing for Mac OS 9

	Fit to Page Printing
	Driver settings for Windows
	Driver settings for Mac OS 9

	Pages Per Sheet Printing
	Driver settings for Windows
	Driver settings for Mac OS X
	Driver settings for Mac OS 9

	Poster Printing
	Driver settings for Windows
	Driver settings for Mac OS 9
	How to make a poster from your printouts

	Watermark Printing
	Printing the watermark for Windows
	Printing the watermark for Mac OS 9
	Creating your own watermark for Windows
	Creating your own watermark for Mac OS 9


	Printer Software Settings
	For Windows
	Printer software introduction
	Making settings on the Main menu
	Making settings on the Page Layout menu
	Making settings on the Maintenance menu
	Getting information through online help

	For Mac OS X
	Printer software introduction

	Page Setup Dialog Box
	Page Setup dialog box settings

	Print Dialog Box
	Print dialog box settings

	EPSON Printer Utility
	Epson printer utility functions

	For Mac OS 9
	Printer Software Introduction
	Page Setup Dialog Box

	Print Dialog Box
	Print Dialog Box
	Layout dialog box
	Printer utilities
	Getting information through online help


	Using Your Software
	Software Information
	Overview of EPSON Creativity Suite
	EPSON File Manager
	Starting EPSON File Manager

	Printing Photos the Easy Way
	Starting EPSON Easy Photo Print

	Creating Professional Looking Photos
	Starting EPSON Darkroom Print

	Printing RAW format file images
	Starting EPSON RAW Print

	Attaching Images to E-mail
	Starting EPSON Attach to E-mail

	Printing Web Pages to Fit to Your Paper Size
	Accessing EPSON Web-To-Page

	EPSON Easy Print Module
	Uninstalling Creativity Suite Applications
	For Windows
	For Mac OS X


	Replacing Ink Cartridges
	Replacing an Empty Ink Cartridge
	Using the printer's control panel buttons
	Using the EPSON Status Monitor

	Replacing an Ink Cartridge
	Using the printer’s control panel buttons

	Changing the Black Ink Cartridges to Suit the Paper Type
	Replacing an ink cartridge
	Setting the ink cartridge information

	Checking the Ink Supply
	For Windows
	For Macintosh


	Improving Print Quality
	Checking the Printer Status
	For Windows
	For Mac OS X
	For Mac OS 9

	Checking the Print Head Nozzles
	Using the Nozzle Check utility
	Using the control panel buttons

	Cleaning the Print Head
	Using the Auto Nozzle Check and Cleaning utility
	Using the Head Cleaning utility
	Using the control panel buttons

	Aligning the Print Head
	For Windows
	For Mac OS X
	For Mac OS 9


	Troubleshooting
	Diagnosing the Problem
	Error indicators
	EPSON Status Monitor
	Running a printer operation check

	Print Quality Problems
	Horizontal banding
	Vertical misalignment or banding
	Incorrect or missing colors
	Blurry or smeared printout

	Printout Problems Not Related to Print Quality
	Incorrect or garbled characters
	Incorrect margins
	Inverted image
	Blank pages print
	Printout has smears
	Printing is too slow

	Paper Does Not Feed Correctly
	Paper does not feed
	Multiple pages feed
	The paper jams
	Paper improperly loaded
	Paper is not ejected fully or is wrinkled
	Thick Paper is ejected when sending a thick paper print job
	Thick Paper does not eject properly after a thick paper print job is finished

	Printer Does Not Print
	All lights are off
	Lights came on and then went out
	Only the power light is on
	The error light is flashing or on
	Error light is on and power light is flashing

	Print Head Carriage Problem
	Correcting USB Problems
	USB connections
	Windows operating systems
	Printer software installation

	Communication Error
	The power light does not turn on
	The power light is on but nothing prints

	Canceling Printing
	Using the control panel buttons
	For Windows XP and 2000
	For Windows Me and 98
	For Macintosh


	Other Information
	Setting Up Your Printer on a Network
	For Windows XP and 2000
	For Windows Me and 98
	For Mac OS X
	For Mac OS 9

	Increasing the Print Speed
	General tips
	Using the Speed & Progress dialog box (Windows only)

	Updating and Uninstalling Software
	Updating the printer software in Windows Me, XP, or 2000
	Uninstalling the printer software
	Uninstalling the User's Guide
	Cleaning the Printer

	Transporting the Printer
	Options and Consumable Products
	Consumable products

	Exif Print and PRINT Image Matching
	Effectiveness
	How to use

	Printer Specifications
	Printing
	Paper
	Ink Cartridges
	Mechanical
	Electrical
	Environmental
	Standards and Approvals

	System Requirements
	For Windows
	For Macintosh
	Using the User's Guide

	Paper Handling
	Loading single sheets of paper
	Loading Thick Paper

	Loading Single Sheets of Paper into the Rear Manual Feed Slot
	Using special media
	Loading capacities for Epson special media
	Attaching the Multi - Sheet Matte Support
	Loading and removing roll paper

	Driver Settings
	Accessing the printer software for Windows
	Accessing the printer software for Mac OS X
	Accessing the printer software for Mac OS 9
	Media type settings
	Making User Defined paper sizes for Windows
	Making User defined paper sizes for Mac OS X
	Making User Defined paper sizes for Mac OS 9


	Customer Support
	Contacting Customer Support
	Technical Support Web Site

	Glossary
	Index

